
 

 
 

 

Cytation 5 
Imaging Multi-Mode Microplate Reader 
 

User Manual 
 

 

 
 

 

 

 

 

ERRATA NOTICE: This document contains references to BioTek. 
Please note that BioTek is now Agilent. For more information,  
go to www.agilent.com/lifesciences/biotek. 
 

 



Cytation 5

Imaging Multi-Mode Microplate Reader

User Manual

ERRATA NOTICE: This document contains
references to BioTek.
Please note that BioTek is now Agilent.
For more information, go to
www.agilent.com/lifesciences/biotek.

Document part number 1321000N
Revision A

BioTek Instruments, Inc.
December 2021



ii | Preface

Contents

Contents ii
Notices vii

All Rights Reserved vii
Restrictions and Liabilities vii

Contact Information viii
Worldwide Sales and Support viii
Technical Support and Service viii
UK Responsible Person (UKRP) viii

Intended Use Statement ix
Quality Control ix
Warranty and Product Registration ix

Safety Notices x
Warnings and Precautions xi

Electrical Hazards xi
Chemical/Environmental xi
Components xii
Intended Product Use xiii

Symbols xiv
Conformance to Standards xx
EMC Information and Technical Description xxi
Ingress Protection Code xxi
Disposal xxi
Introduction 1
Product Description 2
Package Contents 4
Optional Accessories 5
Technical Support 9

Installation 11
Important Information 12
Unpack and Inspect the Instrument 13
Unpack and Inspect the Dispenser 13
Unpack and Inspect the Gas Controller 13
Select an Appropriate Location 14
Installing the Isolation Table 14

Remove the Shipping Hardware 17
Install the Power Supply 18
Install the Gas Controller (if applicable) 19
Install the Peltier Cooling Module (if applicable) 19
Install the Joystick (if applicable) 20

Cytation 5 User Manual



| iii

Install the Dispenser (Optional) 21
Install the Supplied Controller (Host Computer) 24
Install Gen5 and Connect the Cytation 5 24
Essential Information 24
Installation Procedure 25

Turn on the Instrument 26
Establish Communications 26
Communication Errors 27

Install the Imaging Module 28
Set Up Gen5 for Imaging 28
Install the Objectives 29
Install the LED Cubes and Filter Cubes 31
Install the Laser Autofocus Cube (optional) 32
Run Auto Calibration 32
Troubleshooting Auto Calibration 33

Run a System Test 33
Set Dispenser Calibration Values 34
Test the Dispenser 34
Operational/Performance Qualification 35
Packing and Shipping Instructions 37
Prepare the Instrument for Shipment 37
Reinstalling the Shipping Hardware 38
Pack the Shipping Box 40

Preparing the Dispenser for Shipment 45
Repacking the Peltier Cooling Module 48

Getting Started 49
Modular Design 50
External Components 52
Internal Components 53
Filter Cube 54
Configuring the System for Luminescence Measurements 55

Injector System 56
Dispense Module 56
Priming the Injector System 58
Dispense Module Control 58
Prime 59
Purge 59

Plate Shaking Options 60
Plate Shaking Specifications 60

Peltier Cooling Module Described 61
Gen5 Software 63
Protocols and Experiments 63

Imaging System 65
Using the Slide Holder and Other Labware 66
Manual Mode 66
Experiment Mode 66

BioTek Instruments, Inc.



iv | Preface

Recommendations for Optimum Performance 68
General 68
Read Direction 69
Luminescence Measurements 69
Monochromator-Based Fluorescence Systems 69
Models with Dispenser (Injectors) 69
Using 384-Well Microplates 69
Incubation and Partial Plates 70
Imaging 70

Fluorescence Filter Cubes, and Imaging Cubes & Objectives 71
Filters and Mirrors Overview 72
Fluorescence Filter Cubes 72
Filter Cubes Available from BioTek 72
Installing or Removing a Filter Cube 74
Defining Fluorescence Filter Cubes in Gen5 74

Changing the Filters and Mirrors in a Filter Cube 76
To remove a filter, plug, or mirror 76
To replace a filter, plug, or mirror 78

Fluorescence Filter Cube Library 79
Adding a Filter Cube to the Optics Library 79

Imaging LED Cubes and Filter Cubes 81
Changing LED Cubes and Imaging Filter Cubes 81
Installing the LED Cubes and Filter Cubes 83
LED Cube and Imaging Filter Cube Library 83
Import LED Cube and Filter Cube Definitions 84

Imaging Objectives 85
Import Objective Definitions 85
Changing an Objective 86
Adjust the Correction Collar 87
40X, 60X, and 100X Objectives: Limitation 89
Define your vessel’s Bottom Elevation 91

Periodic Maintenance 93
Periodic Maintenance Overview 94
Daily Cleaning for the Dispense Module 94

Recommended Maintenance Schedule 95
Warnings and Precautions 96
PM-1: Clean Exposed Surfaces 97
PM-2: Inspect/Clean Excitation and Emission Filters 98
PM-3: Inspect/Clean Mirrors 98
PM-4: Flush/Purge the Fluid Path 99
PM-5: Run a Dispense Protocol (Optional) 101
PM-6: Clean the Tip Priming Trough 102
PM-7: Clean the Priming Plate 102
PM-8: Clean the Dispense Tubes and Injectors 102
PM-9: Clean the Objectives 104
PM-10: Clean Peltier Cooling Module Filter 106

As-Needed Maintenance 107

Cytation 5 User Manual



| v

Decontamination 108
Procedure for all instruments: Decon External Surfaces 109
Procedure for Models with a Dispenser 110
Alternative Decon Procedure for Dispenser Modules 112

Dispenser Syringe Replacement 113
Instrument Qualification 115
Instrument Qualification Overview 116
Recommended Qualification Schedule 118
System Test 119
Imaging Test Procedures 120
Carrier Level Test 121
Gen5 Imaging Protocol 122
Capture an Image Test 126
Joystick Performance Verification 127

Absorbance Plate Test 128
Define Absorbance Test Plate Parameters 128
Run the Absorbance Plate Test 129
Results and Troubleshooting Tips 129

Absorbance Liquid Tests 132
Absorbance Liquid Test 1 132
Analyze the Results 133
Absorbance Liquid Test 2 134
Absorbance Liquid Test 3 136
Read the Plate 137

Fluorescence Testing Overview 139
BioTek Fluorescence Plate Tests 140
Fluorescence Liquid Tests 141
Gen5 Fluorescence Liquid Test Protocols 143
Corners-Sensitivity-Linearity Tests Materials 152
Fluorescence Polarization (FP) Test Materials 152
Time-Resolved Fluorescence (TRF) Test Materials 153
Prepare the Fluorescence Test Solutions 153
Fluorescence Test Procedure 155
Pipette Maps 156
Results Analysis 158
Troubleshooting Fluorescence Liquid Tests 161
Fluorescence Test Procedure (Methylumbelliferone) 162

Luminescence Test 170
Harta Plate Test 170
Results Analysis 172
Gen5 Luminescence Test Protocol Parameters 173
Luminescence Troubleshooting 177

Alpha Detection Test 178
Required Materials 178
Test Solutions 178
Pipette Map 180
Procedure 180
Results Analysis 180

BioTek Instruments, Inc.



vi | Preface

Troubleshooting Alpha Tests 181
Gen5 Protocol Reading Parameters 181

Dispense Module Qualification Tests 183
Using BioTek’s Blue and Yellow Concentrate Dye Solutions: 184
Using FD&C Blue and Yellow Dye Powder: 184
Procedure for Models with Absorbance Capabilities 185
Results Analysis 186
Procedure for Models without Absorbance Capabilities 186
Gen5 Test Protocols for Models with Absorbance Capabilities 189
Gen5 Test Protocols for Models without Absorbance Capabilities 192

Dispense Test Worksheets 196
Specifications 199
General Specifications 200
Dispense/Read Specifications 202
Absorbance Specifications 203
Fluorescence Specifications (Mono-Based) 205
Fluorescence Specifications (Filter-Based) 206
Luminescence Specifications 206
Imaging Specifications 208

Error Codes 209
Overview 210
Error Codes 211

Safety Information 217
Safety Notices 218
Warnings and Precautions 220
Electrical Hazards 220
Chemical/Environmental 223
Components 228
Intended Product Use 233

In This Book 240

Cytation 5 User Manual



| vii

Notices

All Rights Reserved

© 2021, BioTek Instruments, Incorporated. No part of this publication may be reproduced,
transcribed, or transmitted in any form, or by any means electronic or mechanical,
including photocopying and recording, for any purpose other than the purchaser’s use
without written permission of BioTek Instruments, Inc.

Restrictions and Liabilities

Information in this document is subject to change and does not represent a commitment by
BioTek Instruments, Inc. Changes made to the information in this document will be
incorporated in new editions of the publication. No responsibility is assumed by BioTek for
the use or reliability of software or equipment that is not supplied by BioTek or its affiliated
dealers.
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Contact Information
Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA  95051

Worldwide Sales and Support

www.agilent.com/en/contact-us/page

Technical Support and Service

www.agilent.com/en/support

bio.tac@agilent.com

Instrument service and repair is available worldwide at one of our international service
centers and in the field at your location.

UK Responsible Person (UKRP)

Agilent LD UK Ltd

5500 Lakeside

Cheadle Royal Business Park

Cheadle, Cheshire SK8 3GR
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Intended Use Statement

The Cytation 5 is an imaging multi-mode microplate reader and intended to be used for the
examination of specimens to analyze their characteristics and impact on a variety of
analytes.

Quality Control

It is considered good laboratory practice to run laboratory samples according to instructions
and specific recommendations included in the assay package insert for the test to be
conducted. Failure to conduct Quality Control checks could result in erroneous test data.

Warranty and Product Registration

Review the warranty information that shipped with your product. Register your product to
ensure you receive important information updates about the products you have purchased.

BioTek Instruments, Inc.
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Safety Notices
Raadpleeg Bijlage C voor informatie in andere talen.

Reportez-vous à l'annexe C pour obtenir des informations dans d'autres langues.

Informationen in anderen Sprachen finden Sie in Anhang C.

Fare riferimento all'Appendice C per informazioni in altre lingue.

Consulte el Apéndice C para obtener información en otros idiomas.

Pay special attention to the following safety notices in all product documentation.

A WARNING notice denotes a hazard. It calls attention to an
operating procedure, practice, or the like that, if not
correctly performed or adhered to, could result in personal
injury or death. Do not proceed beyond a WARNING notice
until the indicated conditions are fully understood and met.

A CAUTION notice denotes a hazard. It calls attention to an
operating procedure, practice, or the like that, if not
correctly performed or adhered to, could result in damage to
the product or loss of important data. Do not proceed
beyond a CAUTION notice until the indicated conditions are
fully understood and met.
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Warnings and Precautions

Electrical Hazards

Internal Voltage. Always turn off the power switch and unplug
the power supply before cleaning the outer surface of the
instrument.
Power Rating. The instrument’s power supply or power cord must
be connected to a power receptacle that provides voltage and
current within the specified rating for the system. Use of an
incompatible power receptacle may produce electrical shock and
fire hazards.
Electrical Grounding. Never use a plug adapter to connect
primary power to the external power supply. Use of an adapter
disconnects the utility ground, creating a severe shock hazard.
Always connect the power cord directly to an appropriate receptacle
with a functional ground.
Service. Only qualified technical personnel should perform service
procedures on internal components.
Power Supply. Use only the power supply shipped with the
instrument, and operate it within the range of line voltages listed on
it.

Chemical/Environmental

Potential Biohazards. Some assays or specimens may pose a
biohazard. Adequate safety precautions should be taken as outlined
in the assay’s package insert. Always wear safety glasses and
appropriate protective equipment, such as chemical-resistant
rubber gloves and apron.
Liquids. Avoid spilling liquids on the instrument; fluid seepage into
internal components creates a potential for shock hazard or
instrument damage. If a spill occurs while a program is running,
stop the program and turn off the instrument. Wipe up all spills
immediately. Do not operate the instrument if internal components
have been exposed to fluid.
Liquids. Do not immerse the instrument, spray it with liquid, or
use a dripping-wet cloth on it. Do not allow water or other cleaning
solution to run into the interior of the instrument. If this happens,
contact Technical Support.
Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, temperature near the
instrument should remain within the range in the Specifications
section of this document. Performance may be adversely affected if
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temperatures fluctuate above or below this range.
Sodium Hypochlorite. Do not expose any part of the instrument
to the recommended diluted sodium hypochlorite solution for more
than 20 minutes. Prolonged contact may damage the instrument
surfaces. Be certain to rinse and thoroughly wipe all surfaces.
DMSO Concentration. Dimethyl sulfoxide (DMSO) vapor can coat
optical surfaces, which can trigger instrument self-test errors.
Using DMSO assay concentrations of 2% or below is recommended.
Limit long exposure in kinetic assays or incubated assays when
possible.
Lubricants. Do not apply lubricants to moving parts. Lubricant on
components in the carrier compartment will attract dust and other
particles, which may cause the instrument to produce an error.

Components

Class 1 Laser Product. “A” models. “V” and “W”models
when the optional Laser Autofocus Cube is installed.

Pinch Hazard. Some areas of the instrument and the
dispense module can present pinch hazards when the
instrument is operating. The objective turret and dispense
module are marked with the symbol shown here. Keep
hands/fingers clear of these areas when the instrument is
operating.
Two person lift. The instrument should be lifted by two
people. The instrument weighs up to 36.3 kg (45.3 kg with the
Peltier Cooling Module installed).

Accessories. Only accessories that meet the manufacturer's
specifications shall be used with the instrument.
Shipping Hardware. All shipping hardware must be
removed before operating the instrument and reinstalled
before repackaging the instrument for shipment.
Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and
accessories may result in a loss of warranty and potentially
impair instrument performance or cause damage to the
instrument.
Service. Only qualified technical personnel should perform
service procedures on internal components.
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Instrument Configuration.When you install or change
objectives, LED cubes, imaging filter cubes, or fluorescence
filter cubes you must update the instrument configuration
values in Gen5 and download the information to the
instrument.
LED cubes and filter cubes.Wear gloves when changing
components to avoid contaminating them.
Objectives. Do not use these cleaning solvents: Methyl ethyl
ketone (MEK), Dimethyl ketone (acetone).

Intended Product Use

Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software
parameters and establishing reading methods. It is considered
good laboratory practice to run laboratory samples according to
instructions and specific recommendations included in the assay
package insert for the test to be conducted. Failure to conduct
quality control checks could result in erroneous test data.
Data Reduction. No limits are applied to the raw measurement
data. Data exported via computer control must be analyzed by the
operator. The performance characteristics of the data reduction
software have not been established with any laboratory diagnostic
assay. Users must evaluate this instrument and PC-based software
in conjunction with their specific assay(s). This evaluation must
include the confirmation that performance characteristics for the
specific assay(s) are met.
Unspecified Use. Failure to operate equipment according to the
guidelines and safeguards specified in the product user
documentation could result in a hazardous condition.
Use of labware other than described in this document can result in
positioning errors during program execution.
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Symbols
Caution, consult the instructions for use for important cautionary
information such as warnings and precautions.

Voorzichtig, raadpleeg de gebruiksaanwijzing voor belangrijke
voorzorgsinformatie zoals waarschuwingen en
voorzorgsmaatregelen.

Attention, pour des informations de mise en garde importantes
telles que des avertissements et des précautions, consultez le
mode d'emploi.

Achtung, lesen Sie die Gebrauchsanweisung für wichtige
Vorsichtshinweise wie Warnungen und Sicherheitsvorkehrungen

Attenzione, consultare le istruzioni per l'uso per importanti
informazioni cautelative come avvertenze e precauzioni.

Precaución, consulte las instrucciones de uso para obtener
información importante, como advertencias y precauciones.
Warning; Biological hazard

Waarschuwing; biologisch gevaar

Avertissement : Risque biologique

Warnung; biologische Gefahr

Avvertenza, rischio biologico

Advertencia: peligro biológico
Warning; Pinch hazard

Waarschuwing; beknellingsgevaar

Avertissement : risque de pincement

Warnung; Quetschgefahr

Avvertenza, rischio di pizzicamento

Advertencia: peligro de atrapamiento
Warning; Class 1 Laser Product. “A” models. “V” and “W” models
when the optional Laser Autofocus Cube is installed.

Waarschuwing; Klasse 1 laserproduct. “A” modellen. "V"- en "W"-
modellen wanneer de optionele Laser Autofocus Cube is
geïnstalleerd.

Avertissement; Produit laser de classe 1. Modelles « A». Modèles
« V » et « W » lorsque le cube laser autofocus en option est
installé.

Warnung; Laserprodukt der Klasse 1. „A“-Modelle. „V“- und „W“-
Modelle, wenn der optionale Laser Autofokus Cube installiert ist.

Avvertimento; Prodotto laser di classe 1. Modelli“A”. Modelli “V” e
“W” quando è installato il Laser Autofocus Cube opzionale.

Advertencia; Producto láser de clase 1. Modelos “A”. Modelos “V”
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y “W” cuando está instalado el cubo de enfoque automático láser
opcional.
Complies with FDA performance standards for laser products
except for conformance with IEC 60825-1 Ed.3., as described in
Laser Notice No.56, dated May 8, 2019.

Voldoet aan de FDA-prestatienormen voor laserproducten,
behalve conformiteit met IEC 60825-1 Ed.3., zoals beschreven in
Laser Notice No.56, gedateerd 8 mei 2019.

Conforme aux normes de performance de la FDA pour les produits
laser, à l'exception de la conformité à la norme IEC 60825-1
Ed.3., comme décrit dans l'avis laser n°56, daté du 8 mai 2019.

Entspricht den FDA-Leistungsstandards für Laserprodukte mit
Ausnahme der Konformität mit IEC 60825-1 Ed.3., wie in Laser
Notice No.56 vom 8. Mai 2019 beschrieben.

Conforme agli standard di prestazione FDA per i prodotti laser,
fatta eccezione per la conformità a IEC 60825-1 Ed.3., come
descritto nell'avviso laser n.56, datato 8 maggio 2019.

Cumple con los estándares de rendimiento de la FDA para
productos láser, excepto por la conformidad con IEC 60825-1
Ed.3., Como se describe en el Aviso sobre láser n.o 56, con fecha
del 8 de mayo de 2019.
Warning: two-person lift.

Waarschuwing; Tweepersoonslift.

Avertissement; Ascenseur pour deux personnes.

Warnung; Zwei-Personen-Lift.

Avvertimento; Ascensore per due persone.

Advertencia; Elevador de dos personas.
Disposal Notice: Dispose of the instrument according to Directive
2012/19/EU, “on waste electrical and electronic equipment
(WEEE)” or local ordinances

Kennisgeving van verwijdering: Verwijder het instrument volgens
Richtlijn 2012/19/EU betreffende afgedankte elektrische en
elektronische apparatuur (AEEA) of lokale verordeningen

Avis concernant la mise au rebut : mettez l'instrument au rebut
conformément à la directive 2012/19/EU portant sur les déchets
d'équipement électrique et électronique (DEEE) ou aux
dispositions locales.

Entsorgungshinweis: Entsorgen Sie das Gerät gemäß der
Richtlinie 2012/19/EU „für Elektro- und Elektronik-Altgeräte
(WEEE)“ bzw. den Landesvorschriften.

Avviso per lo smaltimento: smaltire lo strumento in base alla
Direttiva 2012/19/EU, sui "rifiuti di apparecchiature elettriche ed
elettroniche (WEEE)" o le ordinanze locali

BioTek Instruments, Inc.
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Aviso de eliminación: elimine el instrumento de conformidad con
la Directiva 2012/19/UE sobre residuos de aparatos eléctricos y
electrónicos (RAEE) o las ordenanzas locales
CE Marking — Indicates compliance with the requirements of the
Directive 2014/30/EU on Electromagnetic Compatibility and the
Directive 2014/35/EU on Low Voltage

CE-markering – Geeft aan dat wordt voldaan aan de vereisten van
Richtlijn 2014/30/EU inzake elektromagnetische compatibiliteit
en Richtlijn 2014/35/EU inzake laagspanning

Marquage CE – Indique la conformité aux exigences de la directive
2014/30/UE sur la compatibilité électromagnétique et de la
directive 2014/35/UE sur la basse tension

CE-Kennzeichnung – Zeigt die Einhaltung der Anforderungen der
Richtlinie 2014/30/EU über elektromagnetische Verträglichkeit
und der Richtlinie 2014/35/EU über Niederspannung

Marcatura CE – Indica la conformità ai requisiti della Direttiva
2014/30/UE sulla Compatibilità Elettromagnetica e della Direttiva
2014/35/UE sulla Bassa Tensione

Marcado CE: indica el cumplimiento de los requisitos de la
Directiva 2014/30 / UE sobre compatibilidad electromagnética y la
Directiva 2014/35 / UE sobre baja tensión.
Date of manufacture

Productiedatum

Date de fabrication

Herstellungsdatum

Data di produzione

Fecha de fabricación
TÜV SÜD Certification Mark – Type tested; production monitored

TÜV SÜD certificeringsmerk - type getest; productie bewaakt

TÜV SÜD Marque de certification – Type testé ; production
contrôlée

TÜV SÜD-Prüfzeichen – Typ geprüft; Produktion überwacht

Marchio di certificazione TÜV SÜD: tipo testato, produzione
monitorata

Marca de certificación TÜV SÜD: tipo probado, producción
controlada
This product complies with environmental protection use period
as defined in People’s Republic of China Electronic Industry
Standard SJ/T11364-2006. Toxic or hazardous substances will
not leak or mutate under normal operating conditions for 40
years.

Dit product voldoet aan de milieubeschermingsgebruiksperiode
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zoals gedefinieerd in de Electronic Industry Standard SJ/T11364-
2006 van de Volksrepubliek China. Giftige of gevaarlijke stoffen
zullen onder normale bedrijfsomstandigheden gedurende 40 jaar
niet lekken of muteren.

Ce produit est conforme à la période d'utilisation dans le cadre de
la protection de l'environnement telle que définie par la norme de
l'industrie électronique de la République populaire de Chine
SJ/T11364-2006. Les substances toxiques ou dangereuses ne
fuiront pas ou ne subiront pas de mutation dans des conditions de
fonctionnement normales pendant 40 ans.

Dieses Produkt entspricht der Umweltschutz-Nutzungsdauer
gemäß der Definition im Electronic Industry Standard SJ/T11364-
2006 der Volksrepublik China. Giftige oder gefährliche Stoffe
werden unter normalen Betriebsbedingungen 40 Jahre lang nicht
austreten oder mutieren.

Questo prodotto è conforme al periodo di utilizzo della protezione
ambientale come definito nello Standard del settore elettronico
della Repubblica Popolare Cinese SJ/T11364-2006. Le sostanze
tossiche o pericolose non fuoriescono o non subiscono mutazioni
in condizioni operative normali per 40 anni.

Este producto cumple con el periodo de uso de protección
ambiental según el estándar SJ/T11364-2006 de la República
Popular China para la industria electrónica. Las sustancias tóxicas
o peligrosas no se filtrarán ni mutarán en condiciones de
funcionamiento normales durante 40 años.
UK Conformity Assessed marking is a certification mark that
indicates conformity with the applicable requirements for
products sold within Great Britain.

De 'UK Conformity Assessed'-markering is een certificeringsmerk
dat aangeeft dat producten die in Groot-Brittannië worden
verkocht, voldoen aan de toepasselijke eisen.

Le marquage UK Conformity Assessed est une marque de
certification qui indique la conformité aux exigences applicables
aux produits vendus en Grande-Bretagne.

Die Kennzeichnung „UK Conformity Assessed“ ist ein
Zertifizierungszeichen, das die Konformität mit den geltenden
Anforderungen für in Großbritannien verkaufte Produkte anzeigt.

Il marchio UKCA (conformità valutata del Regno Unito) è un
marchio di certificazione che indica la conformità ai requisiti
applicabili per i prodotti venduti in Gran Bretagna.

El marcado UKCA (UK Conformity Assessed) es una marca de
certificación que indica la conformidad con los requisitos
aplicables para los productos vendidos en Gran Bretaña.

BioTek Instruments, Inc.
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EAC-MED is a certification mark to indicate products that conform
to all the safety and quality requirements of the Eurasian Customs
Union. It means that the EAC-MED marked products meet all
requirements of the corresponding technical regulations and have
passed all conformity assessment procedures.

EAC-MED is een certificeringsmerk om producten aan te duiden
die voldoen aan alle veiligheids- en kwaliteitseisen van de
Euraziatische douane-unie. Dit betekent dat de producten met
een EAC-MED-markering aan alle eisen van de desbetreffende
technische voorschriften voldoen en alle
conformiteitsbeoordelingsprocedures hebben doorlopen.

EAC-MED est une marque de certification qui indique la
conformité des produits à toutes les exigences de sécurité et de
qualité de l'Union douanière eurasiatique. Cela signifie que les
produits marqués EAC-MED satisfont à toutes les exigences des
réglementations techniques correspondantes et ont passé toutes
les procédures d'évaluation de la conformité.

EAC-MED ist ein Zertifizierungszeichen zur Kennzeichnung von
Produkten, die allen Sicherheits- und Qualitätsanforderungen der
Eurasischen Zollunion entsprechen. Das bedeutet, dass die EAC-
MED-gekennzeichneten Produkte alle Anforderungen der
entsprechenden technischen Bestimmungen erfüllen und alle
Konformitätsbewertungsverfahren bestanden haben.

EAC-MED è un marchio di certificazione che indica prodotti
conformi a tutti i requisiti di sicurezza e qualità dell'Unione
doganale eurasiatica. Ciò significa che i prodotti con marchio EAC-
MED soddisfano tutti i requisiti dei regolamenti tecnici
corrispondenti e hanno superato tutte le procedure di valutazione
della conformità.

EAC-MED es una marca de certificación para indicar productos
que cumplen con todos los requisitos de seguridad y calidad de la
Unión Aduanera Euroasiática. Significa que los productos con la
marca EAC MED cumplen todos los requisitos de los reglamentos
técnicos correspondientes y han superado todos los
procedimientos de evaluación de conformidad.
Product complies with Australian Communications Requirements

EESS – The Regulatory Compliance Mark (RCM)

ACMA Labeling Requirements

Product voldoet aan de Australische communicatie-eisen

EESS – De markering voor naleving van de regelgeving (RCM)

ACMA-etiketteringsvoorschriften

Le produit est conforme aux exigences australiennes en matière
de communication

EESS – Marque réglementaire de conformité (RCM)
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Exigences en matière d’étiquetage ACMA

Das Produkt entspricht den australischen
Kommunikationsanforderungen.

EESS – Kennzeichnung „Regulatory Compliance Mark“ (RCM)

ACMA-Kennzeichnungsanforderungen

Il prodotto è conforme ai requisiti Australian Communications
Requirements

EESS: marchio di conformità alle normative

Requisiti di etichettatura ACMA

El producto cumple con los requisitos de comunicaciones de
Australia.

EESS: marcado RCM (Regulatory Compliance Mark) de
cumplimiento de la normativa.

Requisitos de etiquetado de ACMA
Korea Certification (KC) mark signifies Korea product compliance
mark for safety and EMC/Radio/SAR of electrical and electronic
equipment. The EMC requirements are applied to Agilent
products.

Korea Certification (KC)-merkteken staat voor Korea-
productconformiteitsmerk voor veiligheid en EMC/Radio/SAR van
elektrische en elektronische apparatuur. De EMC-eisen worden
toegepast op Agilent-producten.

La marque de certification coréenne (KC) signifie la marque de
conformité des produits coréens pour la sécurité et
l'EMC/Radio/SAR des équipements électriques et électroniques.
Les exigences CEM s'appliquent aux produits Agilent.

Das Korea-Zertifizierungszeichen (KC) bezeichnet das
koreanische Produktkonformitätszeichen für Sicherheit und
EMV/Funk/SAR von elektrischen und elektronischen Geräten. Die
EMV-Anforderungen gelten für Agilent-Produkte.

Il marchio Korea Certification (KC) indica il marchio di conformità
del prodotto Corea per la sicurezza e EMC/Radio/SAR di
apparecchiature elettriche ed elettroniche. I requisiti EMC
vengono applicati ai prodotti Agilent.

La marca de certificación de Corea (KC) significa la marca de
cumplimiento de productos de Corea para la seguridad y EMC /
Radio / SAR de equipos eléctricos y electrónicos. Los requisitos de
EMC se aplican a los productos Agilent.

BioTek Instruments, Inc.
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Conformance to Standards
The Cytation 5 meets the requirements of the following standards:

2014/35/EU – Low Voltage Directive

2014/30/EU – EMC Directive

2011/65/EU (with exemptions) and (EU) 2015/863 – RoHS Directives

2012/19/EU – WEEE Directive as amended by (EU) 2018/849

2006/42/EC of the European Parliament and of the Council of 17 May 2006 on machinery

Standard Description
IEC QC 080000 IEC Quality Assessment System for Electronic Components

(IECQ System) - Hazardous Substance Process Management
(HSPM) System Requirements

UL 61010-1 UL Standard for Safety Electrical Equipment For Measurement,
Control, and Laboratory Use; Part 1: General Requirements

EN 61010-1 Safety Requirements for Electrical Equipment For Measurement,
Control, and Laboratory Use – Part 1: General Requirements

EN 61010-2-010 Safety Requirements for Electrical Equipment For Measurement,
Control, and Laboratory Use – Part 2-010: Particular
requirements for laboratory equipment for the heating of
materials

EN 60825-1 "Safety of laser products. Part 1: Equipment classification and
requirements."

CAN/CSA C22.2
No. 61010-1

Safety Requirements for Electrical Equipment For Measurement,
Control, and Laboratory Use – Part 1: General Requirements

CAN/CSA C22.2
No. 61010-2-010

Safety Requirements for Electrical Equipment For Measurement,
Control, and Laboratory Use – Part 2-010: Particular
requirements for laboratory equipment for the heating of
materials

Cytation 5 User Manual
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EMC Information and Technical Description
The Cytation 5 conforms to:

Emissions:

EN55011/CISPR 11, Class A

CFR Title 47 FCC Part 15 Subpart B, Class A

ICES-001, Issue 5, Class A  (CAN ICES-001(A)/NMB-001(A))

ACMA AS/NZS CISPR 11, Class A

Immunity:

EN/IEC 61326-1 and 61326-2-6

ELECTRICAL EQUIPMENT FOR MEASUREMENT, CONTROL AND LABORATORY USE

PART 1: GENERAL REQUIREMENTS FOR (NON IVD) LISTED PRODUCTS

Ingress Protection Code
IP 20. Protected against solid foreign objects of 12.5 mm diameter and greater. No
protection against water.

Disposal
Dispose of the instrument according to Directive 2012/19/EU, “on waste electrical and
electronic equipment (WEEE)” or local ordinances.

BioTek Instruments, Inc.
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Product Description

The Cytation 5 is an imaging multi-mode reader. Depending on the model, Cytation 5
detection modes include fluorescence intensity (FI), fluorescence polarization (FP), time-
resolved fluorescence (TRF), luminescence, UV-visible absorbance, alpha, and imaging.

The instrument is modular, and upgrade options are available; contact BioTek for more
information. The reader is computer-controlled using Gen5 software for all operations,
including data reduction and analysis. The Cytation 5 is robot accessible and compatible
with the BioTek’s BioStack 3 and BioStack 4 Microplate Stackers, and BioSpa 8 Automated
Incubator. Gen5 supports OLE automation to facilitate the Cytation 5’s integration into an
automated system.

The Cytation 5 can perform reads using a filter cube or a monochromator.* The filter-based
system can perform top fluorescence and luminescence reads. Filter fluorescence uses a
xenon flash light source, along with interference filters and dichroic mirrors for wavelength
specificity and a photomultiplier tube (PMT) detector. To run a fluorescence polarization
protocol, the filter cube must contain polarizing filters. Luminescence is measured through
an empty filter position in the filter cube; filters can be used if light filtering is necessary.

The monochromator-based system, which has both top and bottom probes, is used for
absorbance, top and bottom fluorescence intensity, and luminescence spectral scans. The
xenon lamp allows for both UV and visible light measurements. The monochromator
provides wavelength selection from 230–999 nm in 1-nm increments. Available read
methods are endpoint, area scan, spectral scanning, and pathlength correction. For
luminescence reads, the Cytation 5 also has a direct-to-PMT channel (no filtering, white
light only).

The alpha detection system can be used for endpoint reads when installed with the top filter
system in non-synchronized plate mode. The imaging system comprises up to four LED
cubes and four imaging filter cubes, up to six objectives, and a digital camera, which
captures images directly through the selected objective and filter cube assembly. Brightfield
imaging is also available.

The Cytation 5 has 4-Zone temperature control from 4°C over ambient to 65°C, controlled
via a software-adjustable gradient. Internal plate shaking, with both linear and orbital
modes, is supported to ensure that reagents are properly mixed prior to reading.

The Cytation 5 supports the reading of 6-, 12-, 24-, 48-, 96-, and 384-well microplates with
128 x 86 mm geometry, 1536-well microplates (for filter-based measurement and imaging
only), the Take3 and Take3 Trio Multi-Volume Plates, and microscope slides, Petri dishes,
and flasks (using the adapters available from BioTek).

Note: Note: Use of microplates other than those listed here can result in positioning
errors during program execution.

Models with injectors support dual-reagent injection to 6-, 12-, 24-, 48-, 96-, and 384-well
microplates. An external dispense module pumps fluid from the supply bottles to the two
injectors located inside the instrument.

Cytation 5 User Manual
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Models used with the gas controller can control the CO2 or O2 concentrations in the reading
chamber for CO2- or O2-sensitive assays.

Note: See Appendix A for performance and technical specifications.

* This dual light path capability is protected by U.S. patent.

BioTek Instruments, Inc.
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Package Contents

Item Part #

Gen5 software Various

Power supply 02285

Power cord set (varies by region):

Europe (Schuko)

USA/International

United Kingdom

Australia/New Zealand

75010

75011

75012

75013

USB (2.0) cable 75108

Phillips screwdriver #2 01188

9/64" hex wrench 01623

Cytation 5 User Manual (delivered on USB flash drive) 1321000N

Models with the imaging module:

USB3 components Various

Controller (host computer) Various

Microplate slide holder 1220548

Microplate slide holder (4 slides) 1650516

Objective calibration plate 1222531; “W” models:
1852501

3/32" hex wrench 48570

Cytation 5 User Manual
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Optional Accessories

Item Part #

Optional Dispense Module (8040036), with the following accessories:

Injector 8040541

Inlet tubes (2) from supply bottles to syringe drives 7082121

250-µL syringes (2) 7083000

Syringe thumbscrews 19511

Priming plate 8042202

Dispense tip priming trough 8042068

Dispense module communication cable 01170

Dispense module front cover 8042197

Supply bottles (2, 30 mL) 7122609

Supply bottle holders (2) 8042193

Dispense-tip-cleaning stylus kit 2872304

Strap reagent racks (6) 7212035

Optional Gas Controller (packed separately), with the following accessories:

Gas controller unit, CO2/O2 control 1210008/
1210013

Gas Controller Unit, CO2 only 1210007/
1210012

BioTek Instruments, Inc.
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Item Part #

Joystick 1320003

Isolation table 1220521

Isolation table for use with BioStack 2010002

Isolation table for cooling module equipped instruments 1700508

Peltier Cooling Module 1700001

Absorbance Test Plate (400-800 nm) for absorbance measurement
testing

7260522

Absorbance Test Plate (340 nm)1 7260551

Cytation 5 Product Qualification (IQ-OQ-PQ) package 1320532N

T25 Flask adapter 1222210

Petri dish holder, 35 mm, max. diam: 38.7 mm 1222240

Petri dish holder, 35 mm, max. diam: 35.5 mm 1222246

Petri dish holder, 100 mm 1222242

Petri dish holder, 60 mm 1222241

Imaging qualification plate 1222520

Objective adapter collar wrench 1222187

Take3 Micro-Volume Plate TAKE3

Take3 Trio Micro-Volume Plate TAKE3TRIO

PCR Tube Adapter Plates 6002072

1The diagnostics feature in Gen5 versions 2.08 and higher is compatible with the 340 nm Absorbance
Test Plate, BTI PN# 7260551. If you are using an earlier Gen5 version, the test plate’s instruction sheet
explains how to manually conduct the tests and analyze results.

Cytation 5 User Manual
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Item Part #

6002076

BioCell Quartz Vessel 7272051

BioCell Adapter Plate 7270512

Harta Luminometer Reference Microplate (includes plate carrier adapter,
PN 1222205)

8030015

Fluorescence Test Plate1 1400501

Laser Autofocus Filter Cube2 1225010

Filters, fluorescence filter cubes, LED cubes, imaging filter cubes, and objectives are
available for purchase. Contact BioTek for part numbers and availability.

The Cytation 5 is compatible with the BioStack Microplate Stacker and the BioSpa
Automated Incubator. Contact BioTek or visit our website to learn more.

Materials for Liquid Tests Part #

Absorbance Liquid Test Solutions:

BioTek Wetting Agent Solution 7773002

BioTek QC Check Solution No. 1 (25 mL) 7120779

BioTek QC Check Solution No. 1 (125 mL) 7120782

Phosphate-Buffered Saline (PBS) tablets (pH 7.2–7.6) Sigma #P4417

β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, reduced
form)

BioTek PN 98233 or

Sigma #N6785-10VL

Fluorescence Liquid Tests

1Requires Gen5 version 2.06 or higher
2Requires Gen5 version 2.08 or higher.

BioTek Instruments, Inc.
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Materials for Liquid Tests Part #

Test Kits

Kit with microplates and test solutions for conducting
Corners/Sensitivity/Linearity (FI) tests using Sodium
Fluorescein, Methylumbelliferone, and Time-Resolved
Fluorescence (TRF) tests using Europium

7160010 (contains
7160012, 7160013,
and 7160011
described below)

Kit for FI tests using Sodium Fluorescein 7160013

Kit for FI tests using Methylumbelliferone 7160012

Kit for TRF tests using Europium 7160011

Kit for Fluorescence Polarization (FP) test 7160014 or

Invitrogen #P3088

Individual Materials

Sodium Fluorescein Powder, 1-mg vial 98155

Methylumbelliferone (MUB), 10-mg vial 98156

Carbonate-Bicarbonate Buffer (CBB) capsules Sigma #3041

Phosphate-Buffered Saline (PBS) tablets, pH 7.2-7.6 Sigma #P4417

Sodium Borate, pH 9.18 Fisher Scientific
#159532, or
equivalent

Injection System Tests:

BioTek Green Test Dye 7773003

Cytation 5 User Manual
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Technical Support

Note: See also Contact Information on page viii.

Please be prepared to provide the following information:

l Your name and company information, daytime phone number and/or e-mail address.

l The product name, model, and serial number.

l The onboard software part number and basecode version (available via Gen5): Select
System > Instrument Configuration, select your instrument, then click
View/Modify > Setup, select the Basecode tab, then click Get Basecode
Information.

l For troubleshooting assistance or instruments needing repair, the specific steps that
produce your problem and any error codes displayed in Gen5.

l A text file of the diagnostic history of the instrument (available via Gen5 by selecting
System > Diagnostics > History, then selecting the appropriate file and clicking
Export).

BioTek Instruments, Inc.
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Important Information

Two person lift. The instrument should be lifted by two people. The
instrument with all available modules weighs up to 36.3 kg (45.3 kg
with the Peltier Cooling Module installed).

Shipping Hardware. All shipping hardware must be removed
before operating the instrument and reinstalled before
repackaging the instrument for shipment.

l This chapter contains installation and setup tasks for the Cytation 5 and accessories.
Perform the tasks in the order presented.

l Save all packaging materials. Be sure to use packaging materials supplied by the
manufacturer when shipping the instrument. Using other forms of commercially
available packaging, or failing to follow the repackaging instructions, may void your
warranty.

l During the unpacking process, inspect the packaging, instrument, and accessories for
shipping damage. If the instrument is damaged, notify the carrier and your BioTek
representative. Keep the shipping boxes and the packaging materials for the carrier's
inspection.

Cytation 5 User Manual



Unpack and Inspect the Instrument | 13

Unpack and Inspect the Instrument

Two person lift. The instrument should be lifted by two people. The
instrument with all available modules weighs up to 36.3 kg (45.3 kg
with the Peltier Cooling Module installed).

1. Open the shipping box, remove the instrument from the box, and place it on a level,
stable surface.

One unpacking option is to carefully cut the tape sealing the bottom seam of the outer
box, and then lift the box off the inner box. The inner box sides fold out.

2. Place the packaging materials back into the shipping box for reuse if the instrument
needs to be shipped again.

3. For instruments with imaging: Open the accessories box, and remove the isolation
table, if purchased.

Note: Accessories ship in their own box. As applicable, compare the objectives,
LED cubes, and filter cubes against the sales order.

Unpack and Inspect the Dispenser

Applies only to instruments with a dispenser.

1. Open the shipping box. Remove the accessories box and foam insert containing the
injector tubing and bottle holders.

2. Lift out the dispenser and place it on a level surface.

3. Open the accessories box and remove its contents.

4. Place all packaging materials into the shipping box for reuse if the dispenser needs to be
shipped.

Unpack and Inspect the Gas Controller

Applies only to instruments with a gas controller.

1. Open the shipping box.

2. Lift out the accessories (power supply, tubing, and manual), and set them aside.

3. Lift out the gas controller, and place it on a level surface.

BioTek Instruments, Inc.
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4. Place all packaging materials into the shipping box for reuse if the gas controller needs
to be shipped.

Select an Appropriate Location

Install the instrument on a level, stable surface in an area where temperatures between
18°C (64°F) and 30°C (86°F) can be maintained.

Leave at least six inches of space between the instrument’s rear panel and any other object.
This space ensures proper air flow in and out of the instrument.

The instrument is sensitive to extreme environmental conditions. Avoid the following:

l Excessive humidity. Condensation directly on the sensitive electronic circuits can cause
the instrument to fail internal self-checks. The humidity must be in the range of 10–85%,
non-condensing.

l Excessive ambient light. Bright light may affect the reader’s optics and readings,
reducing its linear range.

l Dust. Readings may be affected by extraneous particles (such as dust) in the microplate
wells. A clean work area is necessary to ensure accurate readings.

l Vibration. The instrument should be installed in a vibration-free environment. Be sure to
position the instrument away from other devices that could potentially create vibration
during the read process.

Note: If you are installing a BioStack for operation with the Cytation 5, you may wish to
seat the instruments in their alignment plates now. Refer to the BioStack User Manual for
more information.

Installing the Isolation Table

Cytation 5 models with imaging can be used with an isolation table to help eliminate
vibration during image reads.

Note: If you are installing isolation table part number 2010002 for use with the BioStack,
refer to the BioStack User Manual.

Cytation 5 User Manual
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1. Flip the isolation table over and
use a Philips screwdriver to
remove the four corner clips
used to prevent its compression
during shipping.

2. Place the isolation table in the
selected location.

3. Place the instrument on the
table as shown right.

The isolation table contains
material that dampens vibration.
Over time, this material becomes
compressed and can lose
effectiveness. The isolation table
has a color indicator that turns
from green to red to show when
the table should be replaced
because the dampening material
has been compressed.

BioTek Instruments, Inc.
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Note: BioTek offers a specially designed isolation table (PN 1700508) for use with the
Cytation 5 when the Peltier Cooling Module is installed. The special isolation table
accommodates the extra weight of the cooling module.

Cytation 5 User Manual
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Remove the Shipping Hardware

Shipping Hardware. All shipping hardware must be removed before
operating the instrument and reinstalled before repackaging the
instrument for shipment.

1. Locate the shipping hardware, shown in the next two figures. Note: most screws are
"captive."

Note: The figures below depict a Cytation 5 with the filter module and imaging module.

Carrier shipping bracket

Top filter shipping bracket

BioTek Instruments, Inc.
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Bottom and objective brackets
accessed via the side door

2. Open the top door, and remove the reusable zip tie and desiccant packet from the
desiccant anchor.

3. If equipped, use the supplied screwdriver to remove the top filter shipping bracket.

4. Open the front door, and using the supplied screwdriver, remove the carrier shipping
bracket.

5. Imaging models: use the 9/64" hex wrench to remove the bottom filter slide ship
bracket

6. Push the filter slide back, and remove the two-piece objective shipping brackets.

7. Store the shipping hardware in a safe location, in case the instrument needs to be
shipped again.

Install the Power Supply

Power Rating. The instrument’s power supply or power
cord must be connected to a power receptacle that provides
voltage and current within the specified rating for the
system. Use of an incompatible power receptacle may
produce electrical shock and fire hazards.
Electrical Grounding. Never use a plug adapter to connect
primary power to the external power supply. Use of an
adapter disconnects the utility ground, creating a severe
shock hazard. Always connect the power cord directly to an
appropriate receptacle with a functional ground.
Power Supply. Use only the power supply shipped with the
instrument and operate it within the range of line voltages
listed on it.

Cytation 5 User Manual
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1. Locate the power inlet on the back of the reader.

2. Examine the power supply's plug. It has a small groove that lines up with a tab inside
the power inlet.

3. Insert the plug into the power inlet and plug the power supply's cord into an appropriate
power receptacle.

Important: Do not plug the power supply into a power receptacle until after the power
supply is connected to the instrument.

Install the Gas Controller (if applicable)

Applies only to an instrument used with a gas controller.

The gas controller is an external module to control CO2 and O2 concentrations inside the
reading chamber. If you purchased the module for operation with the Cytation 5, refer to
the Gas Controller User Guide for installation and setup instructions.

Install the Peltier Cooling Module (if applicable)

The optional Peltier Cooling Module is attached to the back of the reader to:

l accelerate cooling of the reading chamber following an incubation session, and
l limit temperature rise in the reading chamber when running without incubation.

If you purchased the accessory, refer to the Peltier Cooling Module Quick Reference for
installation instructions.

Important: Leave sufficient room around the cooling module to guarantee a fresh supply
of circulating air (to dissipate heat and keep it cool).

Note: BioTek offers a specially designed isolation table (PN 1700508) for use with the
Cytation 5 when the Peltier Cooling Module is installed. The special isolation table
accommodates the extra weight of the cooling module.

BioTek Instruments, Inc.
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Install the Joystick (if applicable)

If applicable, install the joystick:

1. Remove the joystick from its shipping box, and place it on a
level surface.

2. Place all packaging materials into the shipping box for reuse
if the joystick needs to be shipped.

3. Locate the joystick cable. Plug one end into the port on the
top of the joystick. Plug the other end into the joystick port
on the rear of the instrument.

Note: If the joystick is connected after the instrument has been turned on: restart the
instrument and run a system test or "Test Communication" to establish communication
between the joystick and the instrument.

Gen5 recognizes the joystick when it is installed. On the Stage
Movement panel, when the joystick is connected, two checkboxes
are offered, including Joystick enabled. As needed, click the
checkbox to use the joystick rather than the computer controls.
Choose Joystick inverted to reverse the direction settings.

Cytation 5 User Manual
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Install the Dispenser (Optional)

Applies only to instruments with a dispenser.

Note: Place the dispense module on top of
the reader or on top of the gas controller (if
equipped). Do not place the dispenser next
to the reader.

1. Open the plastic bag containing the injector tube and tips. Remove the clear plastic
shrouds from the tubes.

2. Remove the two inlet tubes from their plastic canisters.

BioTek Instruments, Inc.
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3. Identify the two syringe valves on the dispense module. Each is labeled with a left-
pointing arrow.

Note: When installing the inlet and outlet tubes, do not use any tools. Finger-
tighten only!

4. Screw the fitting of one inlet tube into the right side of the Syringe 1 valve.

5. Identify the #1 outlet tube, and screw it into the left side of the Syringe 1 valve.

6. Repeat these steps to attach the inlet and outlet tubing for Syringe 2.

Note: It is critical that the tubing is installed in the correct ports. Otherwise,
injected fluid may miss the intended well.

7. Remove the (round) tubing feed-through cover from the top of the reader (2
screws). Store the cover and screws with the shipping hardware in case the reader
needs to be shipped again.

8. Thread the injector tip holder, with outlet tubing connected to both ports, through the
hole in the top of the reader.

9. Open the reader's top door, and, holding the injector tip holder by the tab, insert the
injector tips into the appropriate holes inside the reader.

The injector tip holder in its socket Injector tip installation

Note: A magnet located between the injector tips helps to guide the tips into place and
secures them in the reader.

10. Place the tubing feed-through cover over the hole in the top of the reader and finger-
tighten the thumbscrews to secure it.

Cytation 5 User Manual



Install the Dispenser (Optional) | 23

11. Remove the two syringes from their protective boxes. They are identical and
interchangeable.

12. Install both syringes.

l Hold the syringe vertically with the threaded end at the top.

l Screw the top of the syringe into the bottom of the syringe valve. Finger-tighten
only.

l Carefully pull down the bottom of the syringe until it rests inside the hole in the
bracket.

l Pass a thumbscrew up through this hole and thread it into the bottom of the
syringe. Hold the syringe to prevent it from rotating while tightening the
thumbscrew. Finger-tighten only.

13. Locate the dispenser cable. Plug one end into the port on the left side of the dispenser.
Plug the other end into the “Dispenser Port” on the rear of the reader.

14. Locate the injector tip-cleaning stylus, packaged in a small cylinder. Attach the cylinder
to the back of the dispenser for storage.

Note: Perform a visual inspection or a Performance Qualification test after reconnecting
the tubes.

BioTek Instruments, Inc.
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Install the Supplied Controller (Host Computer)

Install the controller provided by BioTek, which is the recommended host computer for
imaging applications. Follow installation instructions provided with the controller. If you are
not using a BioTek-supplied controller, refer to the Gen5 Getting Started guide for system
requirements.

Essential Information:

Important: Maintaining Gen5 data file integrity is the user's responsibility. Work
with your IT experts to establish a secure file management system, e.g. daily file
backups via Ethernet to the network.

l The controller supports Ethernet connections to a local network; consult your IT experts
about connecting to your organization's network.

l One controller is provided with each instrument and this is the recommended way to use
them.

l The controller does not require a password.

Install Gen5 and Connect the Cytation 5

Note: The Cytation 5 is controlled by Gen5 software running on the controller or host
computer. A certain sequence of events must be followed to ensure the software and
drivers are properly installed and configured.

Important: Do not connect the instrument to the controller until the USB driver shipped
with Gen5 is installed.

l Gen5 software versions 3.11 and higher require Windows 10.

l You must have administrator privileges to install Gen5. Log in to Windows as
“Administrator” or consult your IT department for assistance.

Install Gen5: Turn on the controller and insert the Gen5 USB flash drive into a port.
Consult the information provided with Gen5 to install the software.

After installing Gen5:

Essential Information

Two software drivers must be installed on the controller:
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l (All models) A USB Driver that is shipped with the Gen5 software on a USB flash drive.
This driver is used for connecting the instrument to the controller.

l (Imaging "V" and "W" models) A USB3 Driver that is copied to the controller when Gen5
is installed. This driver is used to communicate with the camera for use with imaging
applications.

Installation Procedure

1. Find and install the USB driver shipped on the Gen5 USB flash drive in the USB
Driver folder. Open the folder and right-click the CDM<version info>.exe file and
select Run as Administrator.

2. Connect the Cytation 5 to the controller using the USB cable. For non-imaging models,
skip to step 8.

3. Connect the camera cable to a USB3 port on the rear panel of the controller.

4. Navigate to the Gen5 program files on the controller, for example, C:\Program
Files\BioTek\Gen5 3.11.

5. Open the USB3 Drivers folder, and then the Windows_64 folder.

6. Open the driver folder PGRUSBCam.

7. Right-click InstallPGRDriver.bat and select Run as Administrator to install the
driver. When finished, a message displays: "SUCCESS: Installed package <path to
package>". If you do not see this message, contact Technical Support.

8. After installing the drivers, restart the controller.

BioTek Instruments, Inc.
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Turn on the Instrument

If you have not already done so, connect the supplied USB cable
between the USB port on the back of the instrument and an available
USB port on the controller/computer.

The instrument’s power switch is located on the lower-right corner of the
front panel. The instrument performs a system test. When the test is
completed, the instrument extends the microplate carrier.

Note: The carrier button above the power switch ejects and retracts
the microplate carrier.

Establish Communications

1. From the Gen5 main screen, select System > Instrument Configuration and click
Add Reader.

2. Set the Reader Type to Cytation 5, and click OK to continue.

3. Select Plug & Play.

Note: A Cytation 5must be connected via USB to the controller/host computer
and turned on to appear in the Available Plug & Play Readers list.

4. Test that Gen5 can communicate with the instrument: click Test Communications. If
successful, Gen5 displays a success message.

5. Imaging models: Click Camera Information. If communication is successful, Gen5
displays the camera information.
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Imaging models
only:

Check the "Bus
Speed," which
should say 5000
Mbits/sec. If a
significantly lower
bus speed is
reported, review
troubleshooting
information.

Troubleshooting Software Drivers
Here are some suggestions for troubleshooting communication with the camera or if
the Bus Speed is significantly lower than 5000 Mbits/sec.

l Reboot the controller/host computer.

l Disconnect and reconnect the USB3 cable from/to the controller/host computer.
Make sure the USB3 cable is connected to a USB3 port.

l Re-run the camera driver installation, as described above under Install Gen5.

l If BioTek's controller is not in use, make sure the computer meets the
recommended requirements, including an Intel 8 USB Chipset or higher.

If problems persist, ask your IT group for support or contact Technical Support.

Communication Errors

If the communication attempt is not successful, try the following:

l Did you install the USB driver?

l Is the instrument connected to the power supply and turned on?

l Is the communication cable firmly attached to both the instrument and the
controller/computer?

l Is the USB3 camera cable properly connected to the controller/computer?

Note: If you cannot get Gen5 and the instrument to communicate with each other,
contact Technical Support.
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Install the Imaging Module

Applies only to Cytation 5 imaging models.

Several steps are required to install the imaging module.

1. First, if you are not using the BioTek-provided “controller,” the host computer must
support the Cytation 5‘s communication method. Get assistance from your IT group, if
needed, to set up the USB 3 communication components required to connect the
computer to the instrument and camera.

Note: Instruments with s/n 151221xx and lower (equipped with FireWire camera) or host
computers that do not meet the recommended configuration: Contact Technical Support
for alternate instructions.

2. Update Gen5 imaging settings.

3. Install the objectives, LED cubes, and imaging filter cubes, and run Auto Calibration.

Set Up Gen5 for Imaging

Important: Perform this procedure in the specified order to prevent damage to the
LED cubes.

To prevent overpowering the LED cubes, the Cytation 5 needs to know which LED cubes will
be installed. You must enter the configuration information in Gen5 before physically
installing the optical components. Gen5 will update the settings onboard the instrument.
The LED cubes and imaging filter cubes must be installed with the instrument
turned off.

Follow the installation steps in this order:

1. In Gen5, select System > Instrument Configuration >  Cytation 5 >
View/Modify > Setup.

2. On the Imaging Configuration tab, input the objective and LED cube and filter cube
configurations. Click Send Values to send the information to the instrument. Turn off
the instrument.

Note: Laser AutoFocus cubes perform best in position 1: See Install the LED Cubes
and Filter Cubes on page 31.

3. Install the objectives in their defined locations. See "Install the Objectives" below.

4. Install the LED cubes and imaging filter cubes in their defined locations (Install the LED
Cubes and Filter Cubes on page 31) in their defined locations. Close the side access
door.
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Note: Leave Gen5 open to the Reader Setup dialog while performing the next
steps.

5. Turn on the instrument. After the self-test, the instrument will beep and the carrier
button LED will be flashing red, indicating that the objectives must be calibrated.

6. Press the carrier button to stop the beeping.

7. Click Auto Calibration.

Important: Cytation 5 “W” models and “V” models with high-power objectives
(40X - 60X objectives) require an “objective setup plate” during Auto Calibration:
“W” models must use PN 1852501 (which supports FL Illumination Correction);
other models can use any objective setup plate, including PN 1222531, to calibrate
their high-power objectives.

After the calibration procedure is finished, the instrument is ready to use.

Note: The Auto Calibration process can take up to 15 minutes on an instrument with six
objectives installed.

Note: Phase contrast components are calibrated in the factory before shipment. You do
not need to run the Phase Ring Configuration and Calibration routines

Install the Objectives

Note: Before installing a 20X, 40X, or 60X air objective, either phase or standard, set its
correction collar to match your plate type. When installing an objective with a correction
collar, be sure to grasp the objective by the adapter, not by the correction collar, to avoid
changing the correction collar settings.
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After defining the objectives and their locations in Gen5:

1. Open the access door.

2. Screw each objective into its defined position.
Do not overtighten the objectives.

Generally it is best to install your lowest power
objective, beginning with 4X, in position #1, and
higher power objectives in the subsequent
positions. Except objectives with power lower
than 4X should be installed in the last positions.
For example:

l 4X
l 20X
l 40X
l 60X
l 2.5X
l 1.25X

Especially with high-power objectives, pay close
attention during installation to make sure the
objective's adapter threads properly into the
turret. If you feel a stop or misalignment,
remove the objective and start again. Verify
proper installation by making sure there is no
gap between the adapter and turret.

Objective turret, showing positions
6 and 1
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Install the LED Cubes and Filter Cubes

Tools: 3/32 Hex wrench

Important: If used, the Laser AutoFocus cube (PN 1225010) must be in Position 1. See
the next topic.

After defining the LED and Filter cubes and their location in Gen5:

1. Reach in and pull out the filter slide.

2. Place the new LED cube in the defined
position (Position 1, 2, 3, or 4).

3. Use the hex wrench to screw the
LED cube into the filter slide.

4. Plug the LED cube's wire clip into the
socket on the carrier.

5. Place the imaging filter cube on top of
the LED cube and screw it to the
LED cube.
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Install the Laser Autofocus Cube (optional)

Class 1 Laser Product. “A” models. “V” and “W”models
when the optional Laser Autofocus Cube is installed.

Laser Autofocus - Optional Accessory

Install the Laser Autofocus cube (PN 1225010) in
Position 1 on the slide (if you purchased this
accessory).

Use the 3/32 hex wrench to tighten the cube's
captive screws.

Plug the cube's wire clip into the socket.

Run Auto Calibration

After physically installing the LED cubes, imaging filter cubes, and objectives, you must run
Auto Calibration. This process can take up to 15 minutes on an instrument with six
objectives installed.

1. Turn on your instrument, and allow the self-test to run. The instrument will beep,
indicating that the self-test has failed.

2. Press the carrier eject button to stop the beeping.

3. If the Reader Setup dialog is not already visible on your screen, go to System >
Instrument Configuration, select Cytation 5, then click View/Modify > Setup.

4. On the Imaging Configuration tab, click Auto Calibration.

5. For all “W” model Cytation 5s and when a 40X or 60X objective is installed, Gen5
prompts you to place the objective setup plate on the carrier. After you place the jig on
the carrier, click OK.

Important: Cytation 5 “W” models and “V” models with high-power objectives (40X -
60X objectives) require an “objective setup plate” during Auto Calibration: “W” models
must use PN 1852501 (which supports FL Illumination Correction); other models can use
any objective setup plate, including PN 1222531, to calibrate their high-power objectives.
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After the calibration procedure is finished, the instrument is ready to use.

Troubleshooting Auto Calibration

If error messages indicate a problem with the imaging Auto Calibration process, make sure
the objectives are in their assigned locations.

Rerun Auto Calibration:

1. In Gen5, click System > Instrument Configuration > Cytation 5 > View
Modify > Setup.

2. On the Imaging Configuration tab, set the value of all objectives to none, and then click
Send Values.

3. Set the correct values for all objectives, and then click Send Values.

4. Click Auto Calibration.

If problems persist, contact Technical Support.

Run a System Test

Running a system test will confirm that the instrument is set up and running properly, or
will provide an error code if a problem is detected.

1. Turn on the incubator:

l In Gen5, select Incubate from the Instrument Control tab.

l Enter a Requested temperature of at least 37°C and click On.

l Wait until the incubator temperature reaches the set point before continuing.

2. Return to Gen5's main view and select System > Diagnostics > Run System Test. If
prompted to select an instrument, select Cytation 5 and click OK.

3. When the test is completed, a dialog requesting additional information appears. Enter
the information and click OK.

Note: If a message appears that a pending system test is waiting from the initial
power-up self-test, view the pending test results and repeat steps 2 and 3.

4. The results report appears. The text should read “SYSTEM TEST PASS.”

l You may wish to print the report and store it with your records.

l The Gen5 software stores system test information in its database; you can retrieve
it at any time.

l Sign and date the report, and store it with your test documentation.
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Note: If an error code is displayed, look up the code in Appendix B . If the problem
is something you can fix, do so now and rerun the system test. If the problem is
something you cannot fix, or if the test continues to fail, contact Technical Support.

5. Turn off the incubator: select Incubate from the Instrument Control tab and click
Off.

Set Dispenser Calibration Values

Applies only to instruments used with a dispenser.

Before using the dispenser, you must enter its calibration values in Gen5.

The calibration values for both dispensers (#1 and #2) are printed on labels affixed to the
rear of the dispense module. Each label lists six target calibration values (e.g., 200, 80, 40)
with their actual measured values (e.g., 199.3, 79.7, 39.9). Enter the measured
calibration values into Gen5.

1. In Gen5, go to System > Instrument Configuration, select your instrument, and
click View/Modify.

2. Click Setup, and then select the Dispenser 1 tab.

3. On the keyboard, press CTRL+SHIFT+M to enter maintenance mode for the Dispenser
1 window.

4. Enter the syringe calibration values from the label on the rear of the dispenser box.

5. Click Send Volumes, and then click Get Volumes to verify that the entered values
were sent to the instrument.

6. Select the Dispenser 2 tab, and repeat steps 3 through 5 for Dispenser 2.

Test the Dispenser

Applies only to instruments with a dispenser.

1. If necessary, press the carrier eject button to extend the microplate carrier.

2. Place the tip priming trough in the rear pocket of the carrier.

3. Place the priming plate on the carrier.
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4. Fill the two reagent bottles with distilled or deionized water. Place the bottles in their
holders, and place the holders directly in front of the syringes. Insert the inlet tubes into
the bottles.

5. In Gen5, use the Instrument Control tab (or select it from the Systemmenu).

6. Select .

7. Click the Prime tab.

8. With Dispenser set to 1, set the Volume to 5000 µL and click Prime.

The syringe should move down and up repeatedly, drawing fluid from the bottle.
The fluid should pump through the tubing and dispense into the priming plate.
Examine the fittings; no leaks should be detected. If leaks are detected, tighten all
fittings and repeat the prime. If leaks are still detected, contact Technical Support.

9. When the prime finishes, set Volume to 2000 µL and click Purge to clear the fluid lines.

10. Set Dispenser to 2 and repeat steps 8 and 9.

11. When finished, remove and empty the priming plate.

Operational/Performance Qualification

Your Cytation 5 was fully tested at BioTek prior to shipment and should operate properly
following the successful completion of the installation and setup procedures described in
this chapter.

If you suspect that problems occurred during shipment, if you received the reader back
from BioTek following service or repair, or if regulatory requirements dictate that
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Operational/Performance Qualification is necessary, see Instrument Qualification Overview
on page 116.

Note: A Product Qualification & Maintenance (IQ/OQ/PQ) package for the Cytation 5 is
available for purchase (PN 1320532N). Contact your local BioTek dealer for more
information.
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Packing and Shipping Instructions

Two person lift. The instrument should be lifted by two people. The
instrument weighs up to 36.3 kg (45.3 kg with the Peltier Cooling
Module installed).

Shipping Hardware. All shipping hardware must be removed
before operating the instrument and reinstalled before repackaging
the instrument for shipment.

Important! Please read all of the information provided below
before preparing the Cytation 5 for shipment.

l Contact Technical Support before returning equipment for service.

l Decontamination prior to shipment is required by the U.S. Department of Transportation
regulations.

l If the instrument has been exposed to potentially hazardous material, decontaminate it
to minimize the risk to all who come in contact with the instrument during shipping,
handling, and servicing. The Maintenance chapter contains decontamination instructions.

l Ensure the carrier/stage is empty. Spilled fluids can contaminate the optics and damage
the instrument.

l Install the shipping hardware (see next section).

l The instrument’s packaging design is subject to change. If the instructions in this
document do not apply to the packaging materials you are using, contact Technical
Support for guidance. Replace the shipping hardware before repackaging the reader.
Please contact BioTek if you have misplaced any of these items.

l Carrier shipping bracket (PN 1220510)
l Top filter shipping bracket (PN 8042187)
l Bottom Filter Slide shipping bracket (PN 1380501)
l Objective shipping bracket (PN 1380503)

l Be sure to use packaging materials supplied by the manufacturer. Other forms of
commercially available packaging are not recommended and can void the warranty.

Prepare the Instrument for Shipment

1. Contact Technical Support for instructions before returning equipment for service.

2. Decontaminate the reader and, if attached, the dispense module, according to the
instructions provided in the As-Needed Maintenance chapter.
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3. If applicable, disconnect and uninstall the dispense module. See Preparing the
Dispenser for Shipment on page 45.

4. If applicable, disconnect the gas controller and store it.

5. If you have the imaging module, you must uninstall the objectives and move the
objective turret into position to install the objective shipping bracket.
a. From the Gen5 main screen, go to System > Instrument Configuration, select
Cytation 5, and click View/Modify > Setup.

b. In the Objective Configuration area of the Imaging Configuration tab, clickMove
to Access Position.

c. Uninstall and pack the objectives in their accessory case.

The imaging LED-Filter cubes are safe to ship installed. Alternatively, uninstall them
and pack in their accessory case.

Note: If the objective shipping bracket does not fit easily, reset the objective
turret's position: turn off the instrument if it is powered on. Turn on the instrument.
After the carrier is ejected and then retracted, turn it off and install the objective
shipping bracket.

6. If you have not already done so, retract the microplate carrier and then turn off and
unplug the reader.

7. Install all the shipping brackets, i.e. reverse the installation steps: See "Remove the
Shipping Hardware" on page 17 for descriptions of this hardware.

8. Place the accessories in the accessories box, then seal the accessories box with tape.

9. Place the instrument in the large plastic bag, then place it in the interior box,
surrounded by foam boards. Then, place the interior shipping box, surrounded by the
foam corners, into the external shipping box. See drawings below.

Reinstalling the Shipping Hardware

1. Locate the shipping hardware.

2. If equipped, remove the fluorescence filter cube from its chamber, and place it into a
clean plastic bag.

3. If equipped, install the top filter ship bracket.

4. If equipped, place the phase contrast hex wrench in the storage space, and cover it with
tape.
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5. If equipped, remove the LED cubes and imaging filter cubes.

6. If equipped, remove the objectives, place them in their holders, and then insert the
holders into the objective case. Make sure the objective wrench is also in the case.

BioTek Instruments, Inc.



40 | Chapter 2: Installation

7. If equipped, install the objective ship bracket.

Note: If the objective ship bracket does not fit easily into place, turn on the
Cytation 5. After the carrier is ejected and drawn back into the instrument, turn off
the instrument. The objective turret is now positioned correctly to install the
objective ship bracket.

8. If equipped, install the bottom filter slide ship bracket.

9. Install the carrier ship bracket. See figure on page 39.

Pack the Shipping Box

1. Place accessories into compartments, as shown below.

2. Close the accessories box, and tape it shut.
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3. Tape the filter cube access door shut, place the instrument in a large plastic bag, then
place it in the interior shipping box, and tape the box shut.

4. Referring to the figure below, place the foam corners and interior shipping box in the
exterior shipping box, then tape the bottoms of the exterior shipping box to secure
them.
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Preparing the Dispenser for Shipment

Note: Decontaminate the dispenser before shipping if it has been used with hazardous
materials. Follow the instructions in Decontamination on page 108.

Important: Purge any fluid from the tubing before beginning this procedure.

1. Remove the front cover of the dispenser.

2. With the reader on, start Gen5 and perform these steps for each syringe, 1 and 2: select
System > Instrument Control > Cytation 5.

3. On the Prime tab, select the dispenser number (1 or 2), and clickMaintenance. The
syringe bracket lowers.

4. Remove the thumbscrew from underneath the bracket.

5. Carefully unscrew the top of the syringe from the syringe valve. Lift out the syringe and
store it in its original box.

6. Remove the injector tubing from the reader, and replace the light shield.

7. Remove the two inlet tubes from the syringe valves, and store them in their plastic
canisters.

8. Remove the two outlet tubes, attach their plastic shrouds to the fittings, and place them
in a plastic bag.
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9. Put the parts in the foam insert in the bottom of the accessory box.

10. Cover the accessory parts with the top foam insert, and put the serial cable in the recess
of the top insert.

11. Put the dispenser in a bag and then into its foam insert.

12. Add the rest of the accessories, including the box containing the accessories, to the
shipping box.

13. Tape the box closed.
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Note: Remove the tip priming trough and priming plate from the instrument before
packing it.
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Repacking the Peltier Cooling Module

Reuse the original shipping materials to repack and ship the Peltier Cooling Module, when
necessary.
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Modular Design

The Cytation 5 is an imaging multi-mode microplate reader, with a design that allows you to
initially purchase only the detection capabilities you need and then upgrade later as your
requirements expand. Please contact BioTek to learn more about your upgrade options.

Gen5 software is used to control the reader. If the reader is connected and turned on, Gen5
will present you with only those options that apply to your reader model. For example, if
your model is not equipped with the monochromator system, Gen5 will not provide the
option to create this type of read in your assay protocol.

The module letters form the part number for each model, indicated on a label on the reader.

Part
Number 1 2 3 4 5 6 7 8 9 10 11 12 13 14

CYT5FV-SN • • • • • • •

CYT5FW-SN • • • • • • • •

CYT5FAV-SN • • • • • • • •

CYT5FAW-SN • • • • • • • • •

CYT5MV-SN • • • • • • •

CYT5MW-SN • • • • • • • •

CYT5MPV-SN • • • • • • • •

CYT5MPW-SN • • • • • • • • •

CYT5MFV-SN • • • • • • • • • • •

CYT5MFW-SN • • • • • • • • • • • •

CYT5MFAV-SN • • • • • • • • • • • •

CYT5MFAW-
SN • • • • • • • • • • • • •

CYT5V-SN • • •

CYT5W-SN • • • •

CYT5PV-SN • • • •

CYT5PW-SN • • • • •

CYT5MF-SN • • • • • • • •

CYT5MFA-SN • • • • • • • • •

CYT5F-SN • • • •

CYT5FA-SN • • • • •
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Part
Number 1 2 3 4 5 6 7 8 9 10 11 12 13 14

CYT5M-SN • • • •

1. Fluorescence imaging

2. Brightfield imaging

3. Color brightfield imaging

4. Phase contrast imaging

5. Wide field of view (WFOV) camera

6. Filter-based fluorescence intensity

7. Filter-based fluorescence polarization

8. Filter-based time resolved fluorescence

9. Filter-based luminescence

10. Filter-based Alpha detection

11. Monochromator-based UV-Vis absorbance

12. Monochromator-based fluorescence intensity

13. Monochromator-based time resolved fluorescence (secondary)

14. Monochromator-based Luminescence

“W” model limitations:

During Auto Calibration of the imager, Gen5 captures FL Illumination Correction
images used to correct light fall off at the edges of wide field-of-view acquired images.
But the following LED-Filter cubes are not supported with this method:

LED-Filter Cube Name PNs EX/EM

Cy5.5 1225114 - 1225008 647/794

Cy7 1225106 - 1225006 716/809

CFP/YFP FRET v2 1225119 - 1225011 400/550

PE 1225113 - 1225001 469/593

De-select the Use WFOV option to capture images using the unsupported
imaging components listed above. Images can be successfully captured with a reduced
field of view. [Expand the Control panel in imager manual mode for this option.]
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External Components

1 Dispense tubing feed-through (for Dual Injector dispense module)

2 Top door (fluorescence filter cube or phase annulus access)

3 Microplate carrier eject button

4 Light-blocking microplate carrier access door

5 Power switch

6 LED cubes, imaging filter cubes, and objectives access door
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1 Dispenser port

2 Joystick port

3 USB port

4 Power inlet

5 Gas controller hookup

6 USB 3 cable for camera

Internal Components

Component Description Page

Filter Cube Models with filter fluorescence. The filter cube can
contain excitation and emission filters, mirrors, and
polarizing filters. Preconfigured cubes are available from
BioTek, or you can change the filters and mirrors yourself.

Note: Do not confuse these cubes with the imaging
LED cubes and filter cubes.

page
54

Imaging System Models with the imaging module. The imaging system,
comprising a digital camera, objectives, LED cubes, and
filter cubes, allows you to run experiments with imaging
reads as well as view images in live mode.

page
65

Injector System Models with the dispense module. The syringes may page
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Component Description Page

require replacement over time. The tubing and injectors
require cleaning at regular intervals.

56

Filter Cube

F-model (fluorescence filter) instruments are equipped with a filter cube that contains
excitation and emission filters, mirrors, and, if required, polarizing filters. Each filter cube
contains two filter sets, each of which contains one excitation filter, one mirror, and one
emission filter. The filter cube is accessed via the top door of the instrument.

BioTek ships the Cytation 5 with the default filter cube configuration defined in its onboard
software (or basecode). The default filter cube configuration is shown below. Your sales
order lists the filter cubes shipped separately with the instrument. Verify that your cubes
contain the expected/ordered filters and mirrors. Contact BioTek or your supplier if the
reader is not equipped with the expected filters.

Default Fluorescence Filter Cube Configuration

Position 1 Position 2

Excitation 360/40 485/20

Emission 460/40 528/20

Mirror 400 510

Instrument Configuration.When you install or change
objectives, LED cubes, imaging filter cubes, or fluorescence filter
cubes you must update the instrument configuration values in Gen5
and download the information to the instrument.

Note: Review the recommendations for managing multiple filter cubes, including
changing filter cubes, beginning with Filters and Mirrors Overview on page 72.

Important: Do not open the top door or any compartment during instrument operation.
Doing so may result in invalid data.
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Configuring the System for Luminescence Measurements

If your tests require that light emitted from the samples remain unfiltered, the Emission
filter position in the filter cube should be empty. Installing or Removing a Filter Cube on
page 74.
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Injector System

Applies only to instruments equipped with injectors.

Important

l Clean the tubing and injectors at least every three months. PM-4: Flush/Purge the
Fluid Path on page 99.

l Inspect the injector system daily for leaks, preferably immediately after priming and
whenever tubing changes have been made.

l If a syringe is leaking, it may need to be replaced. Dispenser Syringe Replacement on
page 113.

Dispense Module

Pinch Hazard. Some areas of the instrument and the dispense module
can present pinch hazards when the instrument is operating. The
objective turret and dispense module are marked with the symbol
shown here. Keep hands/fingers clear of these areas when the
instrument is operating.

The dispense module sits on top of the reader or gas controller and pumps fluid from the
reagent bottles to injector located inside the instrument. Fluid is injected into one well at a
time. The injectors support plate types from 6- to 384-well plates.
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1 Two 250 µL syringes draw fluid from the supply bottles

2 Inlet tubes transport fluid from the supply bottles to the syringes.
These tubes are short pieces of opaque PTFE (Teflon) tubing
connected to stainless-steel probes on one end and threaded fittings
on the other end.

3 Solenoid valves allow the fluid drawn from the supply bottles by the
syringe pumps to flow into the outlet tubes.

4 Outlet tubes transport fluid from the syringes into the instrument,
through the tubing ports on the Cytation 5's top cover. The outlet
tubes are opaque PTFE tubes with threaded fittings on each end.

Note: Avoid continuous contact with harsh chemicals. Rinse the fluid path with deionized
water after contact with any strong acid, base, or solvent.

For information on the materials used in the injection system refer to Dispenser Module:
Injection System Chemical Compatibility on page 1.
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Priming the Injector System

Before running a dispense assay, prime the system with the reagent or dispensing fluid. In
addition, tip priming can be performed at the start of an assay and, sometimes, just before
each dispense to a well. The tip prime compensates for any fluid loss at the injector tip due
to evaporation since the last dispense. All priming activities are controlled via Gen5.

Note: If the injector system is
not primed adequately, air
bubbles can get trapped in the
system and affect injection
volumes. Air bubbles in the
system can also result in fluid
spraying or scattering inside
the reader.

Both types of primes require a
fluid reservoir to be present on
the microplate carrier.

l The priming plate is placed on
the microplate carrier for a
Prime operation (to prime the
dispense system with fluid).

l The tip priming trough is
placed in the rear pocket of the
carrier to catch the Tip Prime
before dispensing. The trough
holds up to 1.5 mL of liquid and
must be periodically emptied
and cleaned by the user.

Important: Do not perform tip priming when using tall plates. Generally, plates with
fewer than 96 wells are too tall for error-free tip priming, and tip priming is rarely
required for these larger-volume plates.

The priming plate should be empty before priming and contain fluid after priming.

Dispense Module Control

This section applies only to models with injectors.
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Gen5 performs several dispense
functions, such as initialize, dispense,
prime, and purge. A Dispense Step in
the protocol injects reagent into
specified wells prior to reading the well.

Note: Priming and purging routines
are used to clean the fluid paths. PM-
4: Flush/Purge the Fluid Path on
page 99.

The Prime and Purge functions are
introduced here. See the Gen5 Help
system for more information.

Prime

Before running an experiment with a dispense step, prime the system with the fluid to be
used.

1. Place the priming plate on the carrier.

2. Fill the supply bottle with a sufficient volume of the fluid to be used for the prime and the
assay. Insert the appropriate inlet tube into the bottle.

3. In Gen5, use the Instrument Control tab (or select it from the Systemmenu) to
select Prime/Dispense and select the Prime tab.

4. Select the Dispenser number (1 or 2) associated with the supply bottle.

5. Enter the Volume to be used for the prime. The minimum recommended prime volume
is 2000 µL.

6. Select a prime Rate, in µL/second.

7. Click Prime to start the process.

8. When finished, carefully remove the priming plate from the carrier and empty it.

Note: If the priming plate is empty, the prime volume was too low.

Purge

To save reagent, Gen5 provides the option to purge fluid from the system back into the
supply bottle.

1. In Gen5, use the Instrument Control tab (or select it from the Systemmenu) and
click the Prime tab.

2. Select the Dispenser number (1 or 2) associated with the supply bottle.

3. Enter the desired purge Volume in µL (e.g., 2000).
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4. Select a prime Rate in µL/second.

5. Click Purge to start the process.

Plate Shaking Options

Three shake modes are
available for selection in
Gen5:

l Linear: a linear shake
moves the carrier back
and forth in the y-axis.

l Orbital: an orbital shake
moves the carrier in both
x- and y-axes to scribe a
circle.

l Double Orbital: the carrier
moves in a figure-eight
pattern.

For any mode, a slider bar in the software allows you to adjust the shake frequency from
"Slower" to "Faster." With each adjustment, the corresponding cycles per minute (CPM) is
displayed. For either orbital mode, you can further expand the frequency options by clicking
a Slow or Fast button.

Plate Shaking Specifications

Option Amplitude/Displacement Frequency

Linear 1 mm to 6 mm in 1-mm steps ~18 Hz to ~6 Hz

Orbital Slow 1 mm to 6 mm in 1-mm steps ~10 Hz to ~3 Hz

Orbital Fast 1 mm to 6 mm in 1-mm steps ~14 Hz to ~5 Hz

Double Orbital Slow 1 mm to 6 mm in 1-mm steps ~10 Hz to ~3 Hz

Double Orbital Fast 1 mm to 6 mm in 1-mm steps ~14 Hz to ~5 Hz

Frequency is based on the selected amplitude or displacement.
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Peltier Cooling Module Described

Applicable only when the optional Peltier Cooling Module is installed

The optional, add-on cooling module significantly speeds up the Cytation 5's ability to
return to ambient temperature after incubation. Strategies to minimize condensation in the
instrument are built into the cooling module’s behavior. In long-term room-temperature
experiments the cooling module helps maintain ambient temperature inside the reader.
Otherwise, the cooling module does not control temperature in the reader.

Cytation 5 models with this serial number and higher are compatible with the Peltier Cooling
Module:

l S/N 1808023

Follow the installation instructions provided with the cooling module.

Important: Leave sufficient room around the cooling module to guarantee a fresh supply
of circulating air (to dissipate heat and keep it cool).

Note: BioTek offers a specially designed isolation table (PN 1700508) for use with the
Cytation 5 when the Peltier Cooling Module is installed. The special isolation table
accommodates the extra weight of the cooling module.

When the cooling module is installed and powered-up, the Cytation 5 controls its
performance, telling it when to turn on and off. An LED panel on the side of the cooling
module shows its current status:

Power Green = power on, ready
Red = error state
No color = no power

Cooling Blue = running
No color = no demand for cooling (or no power)

Performance Green = Max energy for fastest cooling possible
Yellow = Reduced energy to prevent condensation1

No color = no demand for cooling (or no power)

Error State

When an error is detected, the Power LED turns red and an alarm sounds:

1Max performance requires Relative Humidity to be 50% or less, otherwise performance is reduced to
prevent condensation buildup.
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1. Press the Silence Alarm button to turn off the alarm.

2. Unplug the cooling module to power it off.

3. Clear any obstructions to the air flow around the cooling module, especially any objects
underneath it.

4. Plug in the cooling module, wait a few minutes to determine if the error state persists.
Contact Technical Support if the error reoccurs.

Maintenance

PM-10: Clean Peltier Cooling Module Filter on page 106.
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Gen5 Software

Use Gen5 to:

l control the instrument, dispense module, and the stacker (if applicable)

l perform data reduction and analysis on the measurement values

l print or export results; and more

After the splash screen disappears,
Gen5 presents "Startup options."
Choose Standard to install the
instrument and perform IQOQPQ
procedures.

l Standard mode is recommended
for imaging;

l Use Simple mode for performing
single-read-step absorbance and
fluorescence protocols.

n Choose an option and fill the checkbox to skip this step in future.

Protocols and Experiments

This section provides brief instructions for working with Gen5 to create protocols and
experiments and read plates. Refer to information provided with the software and the Gen5
help system for more information. Access the help system by selecting Help > Help
Topics or by clicking the Help button in any dialog.

In Gen5, a protocol contains instructions for controlling the instrument and analyzing the
data retrieved from the instrument. A protocol specifies how to process the assay,
including: reading parameters, incubation settings, injection volume, etc., and the data
reduction steps to perform on the collected data. In Gen5, every experiment contains a
protocol (to be more precise, every experiment contains an embedded copy of the
protocol). You run the "experiment" to execute the protocol to read plates and analyze the
acquired data.
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1. From the Task Manger, select
Create New (or Open a)
protocol/experiment.

2. Numerous protocol options
are available. Choose the type
that best fits your assay
requirements.

3. Hover your mouse over the
File tab to expose the
protocol controls.

4. Define the Procedure. At the
prompt, select the Cytation 5
and click OK.

5. Select the Plate Type that
matches your vessel.

6. Define all the steps needed for
your assay, including the Plate
Layout (or plate map), and
data reduction steps you want
to perform.

7. Finally, set up Microsoft Excel
reports and/or export the
data.

8. Create an experiment based on the protocol, if you started
with protocol creation. Gen5 keeps a copy of the original protocol for future
experiments. Meanwhile, in an experiment, you can optimize the protocol
parameters without affecting the original protocol.

9. Click Read Now to read the plate.

Note: Gen5 stores the dimensions and other characteristics of various plate types in a
database. It is essential that you select (or define) a plate type to match your assay
plate/vessel. Otherwise, results may be invalid. For imaging reads, you must also define
the Bottom Elevation parameter for the plate or slide. See the "Plate Type Database"
topic in the Gen5 Help for instructions.
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Imaging System

Imaging instruments can:

l fine-tune Autofocus settings and capture images in manual mode,

l perform "image" reads in experiment mode,

l save the images for later analysis using Gen5 or a third-party software.

The imaging module comprises up to four LED cubes and four imaging filter cubes, up to six
objectives, and a digital camera, which captures images directly through the selected
objective and filter cube assembly.

Camera
Gen5 controls the camera via USB3. Using Gen5, you can focus the camera, determine
exposure settings, and capture images.

LED Cubes and Imaging Filter Cubes
The LED cubes and filter cubes are located in the compartment accessed by the left door of
the instrument and are user-changeable. Changing LED Cubes and Imaging Filter Cubes on
page 81 for more information.

Objectives
The objectives are located next to the LED cubes and imaging filter cubes in an objective
turret. Gen5 supports the installation of up to six user-changeable objectives.

Imaging Modes
The Gen5 imaging module provides two modes of use: manual and experiment.

l Manual mode allows you to view, capture, and analyze images outside of a protocol or
experiment. Images are displayed in real time. You can also retrieve previously captured
and saved images to analyze in manual mode.

l In experiment mode, you can perform an image read step as an endpoint read or
include it in a kinetic block in your procedures and experiments. An imaging procedure
can include additional steps (as supported by the reader), such as dispense, shake,
incubate, gas recharge, and different detection modes.
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Using the Slide Holder and Other Labware

The BioTek-provided slide holder (PN 1220548) has two well
positions. Position the holder on the plate carrier aligning the
"A1" etching in the holder with the A1 mark on the carrier.

For best results, because the objectives read the slide from
below, put the slide in the holder with its cover plate facing
down, if possible.

Manual Mode

1. When prompted, select the Slide Holder All
Mag. (w/A1 mark) as your plate type.

2. Select the objective and color channel. Begin with
your lowest-power objective.

3. If needed, click theWell button to select the
position that contains the slide you want to image.

4. By default, the middle of the selected slide is positioned above the objective. If the
sample on your slide is in a different location, use the dynamic well schematic
and/or the arrow buttons to move the slide around until you find your sample.

5. After finding your sample, you can change to a higher power objective, if desired.

Experiment Mode

1. In an experiment, select Slide Holder All Mag. (w/A1 mark) as the plate type, and
create an Image read step.

2. Clear the Auto box to turn off Auto Exposure, then click to enter manual mode.

3. Perform step 4 in the manual mode procedure (above) to find your samples, if
necessary.
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4. In manual mode, switch between Auto Focus and Auto Exposure to determine optimal
settings, and when satisfied, click Save settings. Gen5 imports your exposure and
focus settings and the Horizontal and Vertical offsets into the read step.
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Recommendations for Optimum Performance

General

l Use clean microplates, free of dust or bottom scratches. Use new microplates from
sealed packages. Do not allow dust to settle on the surface of the solution; use
microplate covers or seals when not reading the plate. Filter solutions to remove
particulates that could cause erroneous readings.

l Use flat-bottomed vessels when possible. Although the Cytation 5 supports standard flat,
U-bottom, and V-bottom microplates, the reader achieves optimum performance with
flat-bottomed wells when running in Absorbance mode. See Appendix A, Specifications
for more information on the supported plates.

l Check for non-uniformity in the microplate’s optical density by reading an empty
microplate. Non-uniformity in the optical density of the well bottoms can cause loss of
accuracy, especially with U- and V-bottom polyvinyl microplates. Dual-wavelength
readings can eliminate this problem or even out the variation in readings to within
acceptable limits for most measurements.

l Inaccuracy in pipetting has a large effect on measurements, especially when using small
volumes. For best results in most cases, use at least 100 µL per well in a 96-well plate
and 25 µL in a 384-well plate.

l Pipetting solution into 384-well plates often traps air bubbles in the wells, which may
result in inaccurate readings. A dual-wavelength reading method usually eliminates
these inaccuracies. For best results, however, remove the air bubbles by degassing the
plate in a vacuum chamber or spinning the plate in a centrifuge before reading.

l The inclination of the meniscus can cause loss of accuracy in some solutions, especially
with small volumes. Shake the microplate before reading to help bring it within
acceptable limits. Use Tween 20, if possible (or some other wetting agent) to normalize
the meniscus for absorbance measurements. Some solutions develop menisci over a
period of several minutes. This effect varies with the brand of microplate and the solution
composition. As the center of the meniscus drops and shortens the light path, the density
readings change. The meniscus shape will stabilize over time.

l It is the user’s responsibility to understand the volumetric limits of the plate type in use
as it applies to the assay being run.

l Use of liquids with concentrations of acids, corrosives, or solvents of 3% or greater can
corrode the materials inside the instrument's chamber. Running multiple plates with
concentrations <3% in long kinetic assays may also have a destructive effect. If the
experiment is incubated, it will accelerate the deterioration of chamber components.
When in doubt about the use of acids, corrosives, or solvents, please contact Technical
Support.
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Note: Dimethyl sulfoxide (DMSO) vapor can create a removable deposit on optical
surfaces, which can trigger instrument self-test errors. Using DMSO assay
concentrations of 2% or below is recommended. Limit long exposure in kinetic
assays or incubated assays when possible. For questions about the use of DMSO,
please contact Technical Support.

Read Direction

The Cytation 5 performs most reads in a row-wise direction, that is, moving from well A1 to
A2, then A3, and so on.

Luminescence Measurements

For highly sensitive luminescence assays using white plates, add a Delay step to your
procedure to "dark adapt" the plates in the Cytation 5's reading chamber before taking
measurements.

Monochromator-Based Fluorescence Systems

Although Time-Resolved Fluorescence can be performed with the monochromator, the
filter-based fluorescence system is more sensitive for TRF and is the better choice.

Models with Dispenser (Injectors)

l To keep the dispense system in top condition, flush and purge the fluid lines with
deionized (DI) water every day or upon completion of an assay run, whichever is more
frequent. Some reagents may crystallize or harden after use, clogging the fluid
passageways. Flushing the tubing at the end of each day, letting the DI water soak, and
then purging the lines at the beginning of each day ensures optimal performance of the
dispense system. See the Periodic Maintenance chapter for more information.

l When dispensing volumes less than or equal to 20 µL/well, we recommend specifying a
tip prime volume that is equal to the dispense volume. For dispense volumes greater
than 20 µL/well, we recommend a tip prime volume of 20 µL.

l To avoid spillage and possible contamination of the instrument, empty the tip prime
trough frequently and do not exceed the total fluid volume of the plate well when
dispensing.

Using 384-Well Microplates

When using a 384-well microplate, you can use the Gen5 Auto Map feature to ensure you
are using an accurate plate map for your reads. See the Gen5 Help for more information.
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Incubation and Partial Plates

Reduce the effects of evaporation on your samples in a partial plate read that includes
incubation by:

l Using microplate lids.

l Filling unused wells with fluid.

l Clustering your sample wells rather than spacing them throughout the plate.

l Placing your sample wells in the center of the plate instead of the edges of the plate.

Imaging

l For the best imaging results use Gen5's default settings. BioTek developed the default
settings after extensive testing with each magnification or objective and LED cube and
filter cube combination.

l Be sure to Define your vessel’s Bottom Elevation on page 91.

l When using high-power objectives: Adjust the Correction Collar on page 87 to match
your sample vessel.
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Fluorescence Filter Cubes, and Imaging
Cubes & Objectives

The Getting Started chapter provided an overview of the
filters, mirrors, and objectives and LED cubes installed in some
Cytation 5 models. This chapter provides more detailed
information on working with these components.
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Filters and Mirrors Overview

Cytation 5 is equipped with excitation and emission filters for obtaining fluorescence and
luminescence measurements. The excitation filter selects the band of light to which the
sample will be exposed. The emission filter selects the band of light with the maximum
fluorescence signal of the sample, to be measured by the photomultiplier tube (PMT).

For filter-based, top-reading fluorescence analysis, the Cytation 5 uses mirrors to direct the
excitation and emission light paths. Mirrors are required for fluorescence polarization (FP)
measurements to direct light to the sample, because fibers cannot carry polarized light.
Mirrors also provide increased sensitivity for fluorescence intensity (FI) and time-resolved
fluorescence (TRF) measurements.

Filters and mirrors are stored in a filter cube. You can replace the entire cube with a
different one; this is the BioTek-recommended option. Alternatively, you can install
different filters or mirrors in the cube. Contact BioTek for more information on purchasing
additional filters and mirrors.

Fluorescence Filter Cubes

Note: For information about the imaging LED cubes and filter cubes, see Imaging LED
Cubes and Filter Cubes on page 81.

Filter Cubes Available from BioTek

Preconfigured filter cubes, LED cubes, and imaging filter cubes are available for purchase
from BioTek. Please note that part numbers are subject to change, and new cubes may
become available. Custom filters are also available. Contact BioTek with any questions.

Overview

Most Cytation 5 models are equipped with
excitation and emission filters and mirrors for
obtaining fluorescence and luminescence
measurements. Each filter cube has two filter
sets, each of which contains one excitation filter,
one emission filter, and one mirror. The filter
cube is accessed through the top door of the
instrument. You can mark the label on the front
of the filter cube with the contents of the cube.
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Filter cubes are easily reconfigured to meet your assay requirements. However, if you
regularly need to change the filters or mirrors, consider purchasing additional filter cubes
from BioTek to make the process easier and faster.

Note: If you have more than one filter cube, use the Gen5 Filter Cube Library to save
time when changing cubes. Adding a Filter Cube to the Optics Library on page 79.

The Synergy H1 filter cubes are interchangeable with the Cytation 5 filter cubes.

The default filter cube configuration is shown below; any changes are reflected in the sales
order.

Default Fluorescence Filter Cube Configuration

Position 1 Position 2

Excitation 360/40 485/20

Emission 460/40 528/20

Mirror 400 510

Filters are not specific to either excitation or emission. Filter direction within the filter cube
is important, and the direction differs depending on the filter type. Each filter has its central
wavelength and band pass values printed on its side, with an arrow to indicate the proper
direction of light through the filter.

The filter cube can hold up to two half-size or one full-size dichroic or 50% mirror. The
mirror positions are labeled “1” and “2” to coordinate with EX1/EM1 and EX2/EM2.

For Cytation 5 models with FP capability, the cube is equipped with up to four polarizers of
the following types:

l Excitation polarizer (2): visible-range and UV-range

l Emission polarizer: parallel to excitation polarizer

l Emission polarizer: perpendicular to excitation polarizer

Two types of excitation (EX) polarizers are available: visible-range (400 nm and above, the
default) or UV-range (300 nm and above, available from BioTek). The polarizers, if used,
are placed below the excitation filters and above the emission filters.

Cleaning the Filters and Mirrors

Instructions are provided in the Periodic Maintenance chapter.
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Installing or Removing a Filter Cube

Important: Do not open the top door of the instrument during operation. Doing so may
affect measurements.

Turn on the reader to move the filter
cube to an accessible position (if
necessary).

Lift up the top door on front of the
reader:

l To install a filter cube: Position the
cube with its magnets and pin
holes facing left. Slide it gently into
its chamber. The magnets hold it in
place inside the reader.

l To remove a filter cube, slide it out
of its chamber.

When changing filter cubes, you must tell Gen5 and the reader which cube you are
installing.

Instrument Configuration.When you install or change
objectives, LED cubes, imaging filter cubes, or fluorescence filter
cubes you must update the instrument configuration values in Gen5
and download the information to the instrument.

First, create a record in the Optics Library describing the filter cube, then update the reader
using that record:

l Adding a Filter Cube to the Optics Library on page 79

l Choose the update method in the Optics Library: most users opt to let Gen5
automatically update the reader when a filter cube is selected in the protocol.

Defining Fluorescence Filter Cubes in Gen5

For "F" models (filter fluorescence), the filter cube's characteristics must be entered into
Gen5 and downloaded to the reader. Perform these steps before using the reader for the
first time, and again if you change the filter cube's contents or switch to a different cube.
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1. Select System > Instrument Configuration. Highlight the Cytation 5, and click
View/Modify.

2. Click Setup, and then click the Filter Cube tab.

3. Enter a name for the filter cube.

4. Select Fluorescence Polarization Cube, if applicable.

5. Enter a filter set name for Filter Set 1, and define the excitation, mirror, and emission
settings:

l Band Pass, a standard interference filter with a defined central wavelength and
bandwidth.

l Long Pass, cutoff filters that transmit longer wavelengths and block shorter
wavelengths.

l Short Pass, cutoff filters that transmit shorter wavelengths and block longer
wavelengths.

l Plug indicates the presence of a plug.

l Hole indicates an empty location.

6. Click Send Values to download the data to the instrument.

7. Repeat steps for Filter Set 2.
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Changing the Filters and Mirrors in a Filter Cube

You need the following tools to change a filter or mirror in a filter cube:

l 7/64" hex wrench

l Lens paper

l Cotton swab

l Linen or cloth gloves

Instrument Configuration.When you install or change
objectives, LED cubes, imaging filter cubes, or fluorescence filter
cubes you must update the instrument configuration values in Gen5
and download the information to the instrument.

Note: If you accidentally touch a mirror or polarizing filter, see PM-3: Inspect/Clean
Mirrors on page 98.

To remove a filter, plug, or mirror

Important: After you remove the filter cube top, the mirrors will fall out of the cube if the
cube is not on a stable, flat surface.

1. Remove the filter cube.

2. Set the cube on the work surface.

3. Using a 7/64" hex wrench, remove
the screw and washer located
between the emission filter
positions (as shown right).

4. Carefully lift the filter cube top
from the cube. The top contains
the emission filters.

Remove the screw from between EM1 and EM2

LED cubes and filter cubes.Wear gloves when changing components
to avoid contaminating them.

Important: When removing or replacing a filter or C-clip filter retainer, do not use a
sharp instrument. Use several layers of lens paper and your finger to remove and replace
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filters and clips. Using a sharp instrument, such as a flat screwdriver, will scratch the filter
surface and make it unusable.

The mirrors are seated on a shelf in the bottom of the cube and are not secured in place.

1. To remove an emission
filter, prepare a multi-
layered “cushion” of lens
paper. Using your finger
covered with the lens
paper, gently push
against the filter and its
retainer until they pop
out.

2. The bottom of the cube
contains the excitation
filters and mirrors.
Remove the mirrors
before removing the
excitation filters:

Filter cube with top removed

l Make note of the mirror placement and label orientation.

l Wearing linen or cloth gloves, carefully grasp the mirror by its edges, lift it out of
the cube, and store it properly.

3. To remove an excitation filter, use a cotton swab to gently push against the filter,
the aperture, and the C-clip retainer until they pop out.

Mirror direction is important.
The mirror label should be in
the lower-right corner of the
mirror and readable. If the
mirror is not positioned
correctly in the filter cube, your
measurement data may be
inaccurate.

Mirrors positioned in the filter cube
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To replace a filter, plug, or mirror

1. To replace a filter or plug:

a. Orient it as shown below. Observe the arrow on the filter indicating the
light direction, then drop it into the desired location.

Note: Make note of the filter position number (EX1/EX2 or EM1/EM2).

b. Using your fingers, squeeze the sides of the C-clip retainer, and then insert
it into the top of the hole containing the new filter. Cover your finger with
several layers of lens paper, and then push down on all sides of the
retainer until it sits flush against the filter.

c. Gently wipe both sides of the filter with lens paper.
2. To replace a mirror, hold the mirror by its edges, turn it so that its label is face-up and

readable, and place it on the shelf in the filter cube.

3. Place the filter cube top back into the cube and replace the screw and washer.

4. When finished, install the filter cube in the reader.
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Fluorescence Filter Cube Library

If you have more than one filter cube, you can
save time and ensure consistency by defining
each cube for Gen5 in the Filter Cubes Library.

The Gen5 Filter Cubes Library keeps a record of
each of your filter cubes and offers the cubes for
selection when you define a read step for the
Cytation 5.

The cubes are listed alphabetically. Default cubes
are named position 1 and 2 (as shown right in the
Gen5 read step window; FluoRed and GFP are
custom cubes).

To open the Filter Cubes Library, from the Gen5 main screen, select System > Optics
Library > Filter Cubes. You can add, modify, and delete filter cube information and select
the desired behavior at runtime when a filter cube is installed or not (a Read Plate Prompt
Option).

Adding a Filter Cube to the Optics Library

Save time when changing filter cubes by creating a filter cube record in Gen5's Optics
Library. Then, you can instantly update the reader's internal software with the current filter
cube configuration.

1. Click System > Optics Library > Filter Cubes.

2. Click Add, and enter a name for the filter cube. You will select this name when defining
the protocol/experiment procedure.

3. Enter a name for Filter Set 1.

Note: Fluorescence Polarization Cube: Only Filter Set 1 is available for definition; the
filters and mirrors of Filter Set 2 must be identical to Filter Set 1.

4. Define the Excitation and Emission filters:

l Select Band Pass, Long Pass, or Short Pass, and enter the wavelength and
bandwidth.

l Select Plug to indicate the presence of a plug.

l Select Hole to indicate an empty location.

5. Select the mirror type and enter the excitation and emission ranges.
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Cut-off (nm) Excitation Range Emission Range

50% 200–850 200–850

320 260–305 335–750

365 290–350 380–800

400 320–390 410–800

435 385–425 445–610

455 400–450 460–710

510 440–505 515–640

525 475–520 530–670

545 512–535 555–578

550 415–540 560–850

555 541–550 560–595

570 515–565 575–735

595 540–590 600–770

635 640–780 400–630

660 580–655 665–850

6. Define Filter Set 2, if necessary.

7. Click OK.
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Imaging LED Cubes and Filter Cubes

Cytation 5 models with imaging capability are equipped with up to four LED cubes and four
filter cubes. The LED cubes hold an LED light source; the filter cubes contain excitation and
emission filters and a dichroic mirror.

The LED cubes and filter cubes are accessed through a door on the left side of the
instrument and are seated on a slide that you can pull out of the instrument, Changing LED
Cubes and Imaging Filter Cubes below.

Note: Do not open the door to access the cubes during instrument operation. Doing so
may result in invalid data.

Changing LED Cubes and Imaging Filter Cubes

Important: Perform this procedure in the specified order to prevent damage to the
LED cubes.

Before physically changing the LED and Filter cubes, to prevent overpowering the LED
cubes, you must first tell the Cytation 5 which LED cube configurations are going to be
installed.

Important: Wear gloves when changing components to avoid contaminating them.

Important: If used, the Laser AutoFocus cube (PN 1225010) must be in Position 1.
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First, use Gen5 to update the Cytation 5’s onboard settings:

1. In Gen5, select System>Instrument Configuration. Double-click the Cytation 5 item
and click Setup. Click the Imaging Configuration tab.

2. Set the LED cube and filter cube configurations for your components.

3. When defined, click Send Values. (Keep this Gen5 window open until the rest of the
procedure is completed.)

4. Turn off the Cytation 5. But keep the Instrument Configuration tab open in Gen5.

5. Open the side access door, and pull the filter slide out of the instrument.

6. Using a 3/32" hex wrench, remove the two screws holding the imaging filter cube on the
LED cube, and lift off the filter cube.

7. Unclip the LED cube's wire from the board, remove the two screws holding the LED cube
on the filter slide, and remove the LED cube.

8. Install the new LED cube and imaging filter cube on the slide in the desired position,
then push the slide back into the instrument.

9. Power up the instrument.

10. After the self-test is completed, on the Instrument Configuration tab, click Auto
Calibration.

After the calibration procedure is finished, the instrument is ready to use.
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Installing the LED Cubes and Filter Cubes

Note: Do not open the side access door during operation. Doing so may affect
measurements.

1. With the instrument powered down,
turn the knob on the side access
door to release the latch, and open
the door.

2. Slide the filter slide out of the
instrument.

3. Place the LED cube in its predefined
position on the filter slide.

4. Insert the screws into the LED cube,
and screw them into the filter slide.

5. Insert the LED cube's wire clip into
the socket on the carrier.

6. Place the imaging filter cube on top
of the LED cube you installed in the
previous step.

7. Using a hex wrench, attach the filter
cube to the LED cube.

8. Slide the filter slide back into the
instrument.

LED Cube and Imaging Filter Cube Library

System > Optics Library > LED and Filter Cubes

The Gen5 LED Cube and Filter Cube Library contains files describing the LED cubes and filter
cubes available for use with the Cytation 5. The cubes are listed by color, filter cube part
number, excitation and emission wavelengths, and LED cube part number.
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Import LED Cube and Filter Cube Definitions

Gen5 automatically installs definitions for the LED cubes and imaging filter cubes that were
available when your Gen5 software version was produced. When you create a protocol or
experiment procedure, the defined cubes are available for selection.

If you purchase a newer or custom cube, you must install its definitions from an XML file
available from BioTek.

1. Go to https://www.biotek.com/products/software-robotics-software/gen5-software-
features-for-imaging-microscopy/software/.

Note: Contact Technical Support if this link is not accessible.

2. Select the option that matches your cube, and click its download link.

3. After downloading the XML file, "Save As" a copy of the file to your computer.

4. In Gen5, go to System > Optics Library > LED and Filter Cubes.

5. Click Import, and navigate to the folder containing the XML file.

6. Select the file, and click Open. If the XML file represents a new LED cube and filter cube,
Gen5 imports its definitions. Otherwise, a message will say the LED Filter Cube list is up-
to-date.
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Imaging Objectives

Readers with the imaging module support fluorescence and brightfield reads using
objectives. objectives can be installed simultaneously.

The objectives are shipped in capsules in the objectives case in the accessories box. Keep
the capsules for storing the objectives when not in use.

The objectives are configured in the Imaging Configuration tab in the Reader Setup dialog.
Gen5 communicates with the instrument to set and get the currently configured objectives.
If you select an objective that is not defined as installed in the instrument, when validating
an imaging read step, Gen5 displays an error message.

Import Objective Definitions

Gen5 automatically installs Objective Definitions for the objectives that were available when
your Gen5 software version was produced. If you purchase a newer objective, you must
install its definitions from an XML file provided by BioTek.

After downloading the XML file to your computer, import its contents:

1. Go to https://www.biotek.com/products/software-robotics-software/gen5-software-
features-for-imaging-microscopy/software/.

Note: Contact Technical Support if the link is not accessible.

2. Select the option that matches your objective, and download its file.

3. After downloading the XML file, save a copy of the file to your computer.

4. In Gen5, go to System > Optics Library > Objectives.

5. Click Import, and navigate to the folder containing the XML file.

6. Select the file, and click Open. If the XML file represents a new objective, Gen5 imports
its definitions. Otherwise, a message will say the Objective list is up-to-date.
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Good Advice from Olympus® Objective Manufacturers

Cleaning Optical Elements - The first rule in fluorescence microscopy (and all other
forms of microscopy) is to keep the optical elements completely free of dust, dirt, oil,
solvents, and any other contaminants. The microscope should be kept in a low-vibration
smoke-free room that is clean as possible and has minimal disturbance of the circulated air.
Use a dust cover on the microscope when not in use and keep all accessories in air-tight
containers. Avoid using corrosive solvents to clean any part of the microscope, and use only
diluted soapy water to clean non-optical surfaces. Objectives should be kept clean using the
following tips:

l Never drag anything across the lens surface with a high degree of pressure, including
lens paper, to avoid the possibility of introducing very fine scratches onto the surface.

l Clean the lens with one of the Recommended Cleaning Solvents on page 104. Avoid other
solvents because they might react with optical coatings on the glass.

l Dust the lens surface with compressed gas prior to cleaning with a solvent to remove
loose particles.

l Soak an optics-grade cotton swab with lens cleaner or ethanol and very gently wipe it
over the lens several times, turning the cotton tip before each pass. Blot excess solvent
with lens tissue and allow the lens to dry thoroughly. Repeat this procedure.

Changing an Objective

Note: Do not open the side access door during operation. Doing so may affect
measurements.

Note: Before installing a 20X, 40X, or 60X objective, either phase or standard, set its
correction collar to match your plate type. Adjust the Correction Collar on the facing page
for more information and instructions.

After defining the objectives and their locations in Gen5 (as described on page 28):

1. Open the side access door.
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Objective turret

Note: Most objectives use an adapter to fit into the objective turret. Make sure to remove
both the objective and its adapter.

2. To change an installed objective, grasp the objective you want to change, unscrew it
from the objective turret, and remove it from the instrument.

3. Screw each new objective into its defined position. Do not overtighten.

Note: Screw securely: Especially with high-power objectives, make sure the objective's
adapter threads properly into its place in the turret. Pay close attention when installing
them. If you feel a stop or misalignment, remove the objective and try again. Verify
proper installation by making sure there is no gap between the adapter and the turret.

4. Close the door.

5. Run Auto Calibration (as described on page 32).

After the calibration procedure is finished, the instrument is ready to use.

Adjust the Correction Collar

Adjust the correction collar on high-power objectives, 20x, 40x, and 60x, to match the
bottom thickness of the sample vessel. If the collar is improperly adjusted images will be
blurry and autofocus may not perform correctly.
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20x Objectives: uninstalled and installed

1. First, set the correction collar to the appropriate value from this table:

Plate Type Typical Bottom Thickness

Glass-bottom microplate 0.17 mm

Cover slip 0.17 mm

Plastic microplate 0.5 mm

Low-density microplate up to 1.0 mm

Check your
plate specs
for the
actual
bottom
thickness.

2. Reinstall the objective in the instrument.

3. In Gen5, click and try to focus on a sample: Run Find Image.

4. If images are still blurry, use the
Focus controls to manually focus
on the well. Record the current
position when you are satisfied
with the image. Auto Expose may
help find focus.

5. Run FM Scan (from the Focus
panel) and record Current
position at the peak value.

Cytation 5 User Manual



Imaging Objectives | 89

If the FM scan peak value doesn't match the manual focus value (by more than a few
microns), the correction collar is not properly set. It may only need a minor adjustment and
the optimal setting can be anywhere between the numbers and notches on the collar:

l Turn the collar to a lower number if the FM scan peak is higher than the manual focus
value.

l Turn the collar to a higher number if the FM peak is lower than manual focus value.

Redo this step for new or different vessels, as needed.

In manual mode, select a readable well before selecting the high-power objective. And,
use the focus controls, rather than Auto Focus, for the best results.

40X, 60X, and 100X Objectives: Limitation

96- and 24-well plate maps when using a high-power objective

Depending on the vessel, high-power objectives may not be able to capture images of all
wells or sections of the vessel. Keep this in mind when you are plating your samples. This
limitation is visible when selecting the wells to read in a read step (click the Full Plate
button). On the contrary, the limitation is not obvious when defining the Plate Layout.

Gen5 identifies this limitation in the plate map:

l X to show when no part of the well can be imaged;

l O to show when only a portion of the well can be imaged.

To view the plate map in manual mode, clickWell.
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To view the plate map in experiment mode:

1. Create a Procedure and select the Plate Type.

2. Click Read, and set Image as the detection method.

3. Set the Objective to 40x, 60x, 100x (phase or standard) and click Full Plate.
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Define your vessel’s Bottom Elevation

Make sure your microplates, slides, and other sample vessels are accurately described in
Gen5. Bottom elevation is the distance in microns (µm) from the top of the plate carrier to
the surface with samples. For imaging, bottom elevation is the starting point for auto
focus - an essential parameter.

The carrier surface and
calibration aperture are at
focus position "0": Bottom
Elevation is measured from
0 to the sample surface.

You need: The vessel
with fixed, properly
stained samples.

When
creating
a new plate
type
record, save
time
by copying
a plate type
with similar
dimensions.

To define Bottom Elevation for your imaging vessel, perform these steps:

1. In Gen5, select System>Plate Type.

2. Highlight your plate type in the list and select View/Modify. (Or, create
a new plate record.)

3. Open the Imaging Parameters window and click - the manual-
mode button.

4. Select your magnification and LED-Filter cube or brightfield light source.

Use the strongest wavelength for your samples, (e.g., Blue (DAPI) or
Green (GFP)).

5. Run Auto Expose and then FM Scan. When you get a defined peak:
Click Set Focus Height to Max FM Ratio.

6. Click Save Settings. Gen5 will update the Bottom Elevation value.
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Periodic Maintenance

This chapter provides instructions for maintaining the Cytation
5 and external dispense module (if used) in top condition, to
ensure that they continue to perform to specification.
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Periodic Maintenance Overview

A general maintenance regimen for all Cytation 5 models includes periodically cleaning all
exposed surfaces and inspecting/cleaning the objectives, emission and excitation filters,
and mirrors (if used).

For models with the external dispense module, additional tasks include flushing/purging the
fluid path and cleaning the tip prime trough, priming plate, supply bottles, dispense tubing,
and injectors.

Daily Cleaning for the Dispense Module

To ensure accurate performance and a long life for the dispense module and injectors, flush
and purge the fluid lines with deionized (DI) water every day or after completing an assay
run, whichever is more frequent. Some reagents may crystallize or harden after use and
clog the fluid passageways. Take special care when using molecules that are active at very
low concentrations (e.g., enzymes, inhibitors). Remove any residual reagent in the
dispense lines using a suitable cleaning solution (review the reagent’s package insert for
specific recommendations).

Flushing the tubing at the end of each day, letting the DI water soak overnight, and then
purging the lines at the beginning of each day ensures optimal performance of the dispense
system. BioTek recommends performing a visual inspection of the dispense accuracy before
running an assay protocol that includes dispense steps.

BioTek also recommends flushing the module with DI water before conducting the
decontamination procedure.

Note: Accumulated algae, fungi, or mold may require decontamination. See the As-
Needed Maintenance chapter for complete decontamination instructions.
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Recommended Maintenance Schedule

This table recommends periodic maintenance tasks and the frequency with which each task
should be performed.

Important: The risk and performance factors associated with your assays may require
that some or all of the maintenance procedures be performed more frequently than
shown here.

Task Daily Quarterly As
Needed

All models:

Decontamination before shipment or storage

PM-1: Clean exposed surfaces √

Models with filter-based fluorescence capability:

PM-2: Inspect/clean excitation and emission
filters

√

PM-3: Inspect/clean mirrors annually

Models with injectors:

PM-4: Flush/purge the fluid path √

PM-5: (Optional) Run Dispense protocol √

PM-6: Empty/clean tip prime trough √

PM-7: Clean priming plate √

PM-8: Clean dispense tubes and injectors √ √

Models with imaging:

PM-9: Clean objectives √ √

BioTek Instruments, Inc.



96 | Chapter 5: Periodic Maintenance

Task Daily Quarterly As
Needed

Models with Peltier Cooling Module:

PM-10: Clean filter annually

Note: Find Decontamination instructions in the As-Needed Maintenance chapter.

Warnings and Precautions

Internal Voltage. Always turn off the power switch and unplug
the power supply before cleaning the outer surface of the
instrument.
Liquids. Avoid spilling liquids on the instrument; fluid seepage into
internal components creates a potential for shock hazard or
instrument damage. If a spill occurs while a program is running,
stop the program and turn off the instrument. Wipe up all spills
immediately. Do not operate the instrument if internal components
have been exposed to fluid.
Liquids. Do not immerse the instrument, spray it with liquid, or
use a dripping-wet cloth on it. Do not allow water or other cleaning
solution to run into the interior of the instrument. If this happens,
contact Technical Support.
Lubricants. Do not apply lubricants to moving parts. Lubricant on
components in the carrier compartment will attract dust and other
particles, which may cause the instrument to produce an error.
Potential Biohazards. Wear protective gloves when handling
contaminated instruments. Gloved hands should be considered
contaminated at all times; keep gloved hands away from eyes,
mouth, nose, and ears.

Mucous membranes are considered prime entry routes for
infectious agents. Wear eye protection and a surgical mask when
there is a possibility of aerosol contamination. Intact skin is
generally considered an effective barrier against infectious
organisms; however, small abrasions and cuts may not always be
visible. Wear protective gloves when handling contaminated
instruments.
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PM-1: Clean Exposed Surfaces

Exposed surfaces may be cleaned (not decontaminated) with a cloth moistened (not
soaked) with water or water and a mild detergent. You’ll need:

l Deionized or distilled water

l Clean, lint-free cotton cloths

l Mild detergent (optional)

l Canned air

1. Turn off and unplug the instrument.

2. Moisten a clean cotton cloth with water, or with water and mild detergent. Do not soak
the cloth.

3. Wipe the plate carrier and all exposed surfaces of the instrument.

4. Instruments with imaging capability: Use canned air to blow debris from the aperture on
the carrier. Do not wipe with liquid, which can seep inside aperture’s glass plates and
affect imaging reads.

5. Wipe all exposed surfaces of the dispense module (if used).

6. Wipe all exposed surfaces of the gas controller module (if used).

7. If detergent was used, wipe all surfaces with a cloth moistened with water.

8. Use a clean, dry cloth to dry all wet surfaces.
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Important: Models with a dispenser: If the tip priming trough or priming plate overflow
and spill fluid inside the instrument, wipe the carrier and the surface beneath the carrier
with a dry cotton cloth. The internal chamber and probes are not customer-accessible. If
overflow is significant, contact Technical Support.

PM-2: Inspect/Clean Excitation and Emission Filters

Applies only to models with filter-based fluorescence capabilities (F models).

Laboratory air is used to cool the flash bulb, and the filter cubes can become dusty as a
result. Filters should be inspected and cleaned at least every three months. You’ll need:

l Isopropyl, ethyl, or methyl alcohol

l 100% pure cotton balls or high-quality lens-cleaning tissue

l Cloth gloves

l Magnifying glass

LED cubes and filter cubes.Wear gloves when changing components
to avoid contaminating them.

1. Open the access door on the front of the instrument. Slide the filter cube out of its
compartment.

2. Inspect the glass filters for speckled surfaces or a “halo” effect. This may indicate
deterioration due to moisture exposure over a long period of time.

Note: If you have any concerns about the quality of the filters, contact your BioTek
representative.

3. Using cotton balls or lens-cleaning tissue moistened with a small amount of high-quality
alcohol, clean each filter by lightly stroking its surface in one direction.

4. Use a magnifying glass to inspect the surface; remove any loose threads left from the
cotton ball.

5. Replace the filter cube and close the door.

PM-3: Inspect/Clean Mirrors

Applies only to models with filter-based fluorescence capabilities.

We recommend inspecting (and cleaning, when necessary) the mirrors and polarizing filters
(if equipped) annually, especially if the filter cube has been opened or changed.

These optical components are delicate and must be handled with care. The glass and anti-
reflective (AR) coated surfaces will be damaged by any contact, especially by abrasive
particles. In most cases, it is best to leave minor debris on the surface. However, if
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performance indicators or obvious defects in the mirrors or filters suggest cleaning them,
here are some guidelines:

l Use of oil-free dry air or nitrogen under moderate pressure is the best method for
removing excessive debris from an optical surface. If the contamination is not dislodged
by the flow of gas, please follow the cleaning instructions below.

l The purpose of the cleaning solvent is only to dissolve any adhesive contamination that is
holding debris on the surface. The towel needs to absorb both the excessive solvent and
entrap the debris so that it can be removed from the surface. Surface coatings on
dichroics are typically less hard than the substrate. It is reasonable to expect that any
cleaning will degrade the surface at an atomic level. Consideration should be given as to
whether the contamination in question is more significant to the application than the
damage that may result from cleaning the surface. In many cases, the AR coatings that
are provided to give maximum light transmission amplify the appearance of
contamination on the surface.

Materials

l 7/64" hex key

l Linen or cloth gloves

l Anhydrous reagent-grade ethanol

l Kimwipes® or comparable lint-free wipes

l Magnifying glass

l 100% pure cotton balls (for the polarizing filters)

Procedure

1. Follow the instructions for Changing the Filters and Mirrors in a Filter Cube on page 76 .

2. Wet absorbent towels such as Kimwipes, not lens paper, with anhydrous reagent-grade
ethanol. Wear gloves or use enough toweling so that solvents do not dissolve oils from
your hands that can seep through the toweling onto the coated surface.

3. Drag the trailing edge of the ethanol-soaked Kimwipe across the surface of the mirror,
moving in a single direction. A minimal amount of pressure can be applied while wiping.
However, too much pressure will damage the mirror.

4. Use the magnifying glass to inspect the surface; if debris is still visible, repeat with a
new Kimwipe.

5. To replace the mirror, hold it by its edges, turn it so that its label is face-up and
readable, and place it on the shelf in the filter cube.

6. Place the filter cube top back onto the cube and replace the screw and washer.

7. When finished, reinstall the filter cube in the reader.

PM-4: Flush/Purge the Fluid Path

Applies only to instruments used with a dispenser.
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At the end of each day when using the dispense module, flush the fluid path using the Gen5
priming utility. Leave the fluid to soak overnight or over a weekend, and then purge the
fluid before using the instrument again.

Note: This flushing and purging routine is also recommended before disconnecting the
outlet tubes, and before decontamination to remove any assay residue prior to applying
isopropyl alcohol or sodium hypochlorite.

To flush the fluid path:

1. Fill two supply
bottles with
deionized or distilled
water. Insert the
supply (inlet) tubes
into the bottles.

2. Place the priming
plate on the carrier.

3. In Gen5, use the
Instrument
Control tab (or
select it from the
Systemmenu).

4. Select .

5. Click the Prime tab and select Dispenser 1.

6. Set the Volume to 5000 µL. Keep the default prime rate.

7. Click Prime to start the process.

8. Repeat the process for Dispenser 2. When the process is complete, carefully remove
the priming plate from the carrier and empty it.

Leave the water in the system overnight or until the instrument will be used again. Purge
the fluid from the system and then prime with the dispense reagent before running an
assay.

To purge the fluid from the system:

1. Place the inlet tubes in empty supply bottles or a beaker.

2. Select Instrument Control.

3. Click the Prime tab and select Dispenser 1.

4. Set the Volume to 2000 µL.

5. Click Purge to start the process.

6. When the purge is complete, repeat the process for Dispenser 2.
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Note: Before reusing the system, run a quick Dispense protocol to visually verify the
dispense accuracy or perform the more thorough Dispense Accuracy and Precision Tests
(in Chapter 7, Instrument Qualification).

PM-5: Run a Dispense Protocol (Optional)

Applies only to instruments with a dispenser.

After flushing/purging the system and before running an assay that requires a dispense
step, visually inspect the dispensing accuracy.

1. Create a Dispense protocol in Gen5:

a. Create a new protocol with the plate type set to match the plate you will use.

b. Add a Dispense step with the following parameters:
l Select Dispenser 1.
l Set Tip Priming to Before this dispense step and Volume to 10 µL.
l Set the Dispense Volume to 100 µL (or an amount to match your assay
protocol).

l Adjust the Rate to support the dispensing volume.
l Click OK to close the dialog and add the Dispense step to the procedure.

c. Add another Dispense step with the same parameters for Dispenser 2.

d. Add a Read step with the following parameters (Gen5 requires a Read step in a
Dispense protocol):

l Select any Detection Method.

l Set the Read Type to Endpoint.

l Click Full Plate, click Clear All, then select well A1. Click OK.

l Select any wavelength or define one Filter Set.

l Click OK to close the dialog and add the Read step to the procedure.

e. Click OK to close the procedure.

f. Select File > Save and give the protocol an identifying name, such as
“Dispense Observation.”

2. Fill the reagent bottles with a DI water–Tween solution (e.g., add 1 mL Tween 20 to
1000 mL of deionized water).

3. Create a new experiment using the "Dispense Observation" protocol.

4. Click Read and follow the prompts.

5. When the procedure is complete, visually assess the fluid level in the wells for accuracy.
If the well volume appears to be unevenly distributed, clean the internal dispense tubes
and injectors.
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PM-6: Clean the Tip Priming Trough

Applies only to instruments with a dispenser.

The tip priming trough is a removable cup located in a rear pocket of the microplate carrier,
used for performing the Tip Prime. The trough holds about 1.5 mL of liquid and must be
periodically emptied and cleaned. Gen5 will instruct you to do this at the start of a run that
requires tip priming.

1. Extend the microplate carrier and carefully remove the tip
priming trough from the carrier.

2. Wash the trough in hot, soapy water. Use a small brush to
clean in the corners.

3. Rinse the trough thoroughly and allow it to dry completely.

4. Replace the trough in the microplate carrier.

PM-7: Clean the Priming Plate

Applies only to instruments with a dispenser.

Clean the priming plate regularly to prevent bacteria growth and residue buildup. Wash the
plate in hot, soapy water, using a small brush to clean in the corners. Rinse thoroughly and
allow it to dry completely.

PM-8: Clean the Dispense Tubes and Injectors

Applies only to instruments with a dispenser.

The Cytation 5’s dispense tubes and injectors require routine cleaning, at least quarterly
and possibly more frequently depending on the type of fluids dispensed.

Required Materials

l Protective gloves

l Safety glasses

l Mild detergent

l Clean, lint-free cotton cloths

l Deionized or distilled water

l Stylus (stored in a plastic cylinder affixed to the rear of the dispense module or reader)
(PN 2872304)
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Remove the Dispense Tubes and Injector Holders

1. Open the door on the top of the reader.

2. Grasp the injector tip holder by the tab and pull it up out of its socket.

3. Using your fingers, remove the thumbscrews securing the light shield to the top of the
reader and slide the shield up the outlets tubes.

4. Slide the injector tip holder through the hole in the top of the reader.

5. Turn each tube’s thumbscrew counterclockwise and gently pull each tube from its
injector tip.

6. On the dispense module, turn each outlet tube’s thumbscrew counterclockwise to
disconnect it from the injector.

Clean the Dispense Tubes and Injectors

Some reagents can crystallize and clog the tubing and injectors. Daily flushing and purging
can help to prevent this, but more rigorous cleaning may be necessary if reagent has dried
in the tubing or injectors.

To clean the dispense tubes, soak them in hot, soapy water to soften and dissolve any
hardened particles. Flush each tube by holding it vertically under a stream of water.

To clean the injectors:

1. Gently insert the stylus into each injector tip to clear any blockages. (The stylus is
stored in a plastic cylinder affixed to the rear of the dispense module.)

2. Stream water through the pipe to be sure it is clean. If the water does not stream out,
try soaking in hot, soapy water and then reinserting the stylus.

Note: Be careful not to damage the injector tips. A damaged tip might not dispense
accurately.
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PM-9: Clean the Objectives

Applies only to "V" and "W" models with the imaging module.

Pinch Hazard. Some areas of the instrument and the
dispense module can present pinch hazards when the
instrument is operating. The objective turret and dispense
module are marked with the symbol shown here. Keep
hands/fingers clear of these areas when the instrument is
operating.
Objectives. Do not use these cleaning solvents: Methyl ethyl
ketone (MEK), Dimethyl ketone (acetone)

Clean the Cytation 5's objectives when necessary using optical-grade swabs or lens paper
moistened with lens cleaning solution or deionized water. Do not rub the lens.

Materials

l Air puffer

l Tweezers

l Magnifying glass

l Lens cleaning tissue

l Optical-grade swabs

l Cleaning solvent

Recommended Cleaning Solvents

Electro-Wash PX from Chemtronics®

Isopropyl alcohol, 70%/30% with deionized water

Methyl alcohol, 70%/30% with deionized water

Ethyl alcohol, 70%/30% with deionized water

1. From the Gen5 main screen, go to System > Instrument Configuration, select
Cytation 5, click View/Modify > Setup.

2. In the Objective Configuration area of the Imaging Configuration tab, click Access next
to the desired objective to rotate the objective turret to the access position.

3. Open the side door of the instrument. Grasp the objective, unscrew it, and remove it
from the instrument.

4. Inspect the lens, using a magnifying glass if necessary, to determine if there is dirt or
dust present. If so, use a blower or a small paintbrush to remove any dirt and dust.
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Note: Any dirt or dust on the surface of the lens can cause extensive damage if dragged
across the surface.

Best practices:

l Do not allow the lens to air dry.

l Always use an unused portion of the lens tissue when wiping the lens.

l If smears are still present after performing these steps, repeat the procedure.

5. Soak either an optical-grade swab or a piece of lens-cleaning tissue wrapped around
tweezers in lens-cleaning solvent or deionized water.

6. Hold the swab or tissue-wrapped tweezers still and rotate the objective's lens around it.

7. Dry the lens immediately with a clean lens tissue.

8. Replace the objective in the objective turret, and screw it in to secure it.

9. Repeat these steps to clean the other objectives, if necessary.

10. Return to the Imaging Configuration tab (opened in step 1), click Auto Calibration to
calibrate the objectives.

When the calibration is finished, the instrument is ready to use.
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PM-10: Clean Peltier Cooling Module Filter

Applies only when the Peltier Cooling Module is installed

BioTek recommends removing and cleaning the filter annually or as needed.

Once a year or more frequently if
instrument usage or the lab
environment are known to require
more rigorous maintenance than
typical, remove the filter on the
bottom of the cooling module and
clean it.

1. Release the 4 thumbscrews
that hold the grate and filter in
place on the underside of the
Peltier Cooling Module.

2. Wash the grate and filter in
mild soap and water. Let them
air dry before reinstalling.
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Decontamination

l The instrument requires decontamination prior to shipping, storage, and disposal.

l Decontamination is required by the U.S. Department of Transportation regulations.

l Persons performing the decontamination process must be familiar with the basic setup
and operation of the instrument.

l BioTek Instruments, Inc., recommends the use of the following decontamination
solutions and methods based on our knowledge of the instrument and
recommendations of the Centers for Disease Control and Prevention (CDC). Neither
BioTek nor the CDC assumes any liability for the adequacy of these solutions and
methods. Each laboratory must ensure that decontamination procedures are adequate
for the biohazard(s) they handle.

Internal Voltage. Always turn off the power switch and
unplug the power supply before cleaning the outer surface of
the instrument.
Liquids. Do not immerse the instrument, spray it with
liquid, or use a dripping-wet cloth on it. Do not allow water
or other cleaning solution to run into the interior of the
instrument. If this happens, contact Technical Support.
Potential Biohazards. Wear protective gloves when
handling contaminated instruments. Gloved hands should
be considered contaminated at all times; keep gloved hands
away from eyes, mouth, nose, and ears.

Mucous membranes are considered prime entry routes for
infectious agents. Wear eye protection and a surgical mask
when there is a possibility of aerosol contamination. Intact
skin is generally considered an effective barrier against
infectious organisms; however, small abrasions and cuts
may not always be visible. Wear protective gloves when
handling contaminated instruments.

Required Materials

For all models:

l Sodium hypochlorite (NaClO, or bleach)
l 70% isopropyl alcohol (as an alternative to bleach)
l Deionized or distilled water
l Safety glasses
l Surgical mask
l Protective gloves
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l Lab coat
l Biohazard trash bags
l 125-mL beakers
l Clean, lint-free cotton cloths

Additional materials for models with the dispense module:

l Screwdriver
l Small brush for cleaning the tip priming trough and priming plate
l (Optional) Mild detergent

Procedure for all instruments: Decon External Surfaces

Internal Voltage. Always turn off the power switch and
unplug the power supply before cleaning the outer surface of
the instrument.
Liquids. Do not immerse the instrument, spray it with
liquid, or use a dripping-wet cloth on it. Do not allow water
or other cleaning solution to run into the interior of the
instrument. If this happens, contact Technical Support.

Important: The sodium hypochlorite (bleach) solution is caustic; wear gloves and eye
protection when handling the solution.

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). If the effects of
bleach are a concern, 70% isopropyl alcohol may be used.

Note: Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is typically 5.0%
NaClO; prepare a 1:10 dilution.

3. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.

4. Open the plate carrier door and slide out the plate carrier.

5. Wipe the carrier/stage and all exposed surfaces of the instrument.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces of the instrument that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. Reassemble the instrument as necessary.

9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.
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Procedure for Models with a Dispenser

Note: Perform the Routine Procedure when the Cytation 5 is functioning normally. If you
are unable to perform a prime due to a system failure, perform the Alternative Decon
Procedure for Dispenser Modules on page 112.

Routine Procedure

Important: If disinfecting with sodium hypochlorite (bleach), be sure to flush repeatedly
with deionized water to remove the bleach.

If disinfecting with alcohol, do not immediately prime with deionized water, because the
drying effect of the alcohol is an important aspect of its disinfectant properties.

Purge any fluid (PM-4: Flush/Purge the Fluid Path on page 99) and detach the outlet tubes
from the instrument. If it is not installed, attach only the dispenser’s communication cable
to the instrument. Remove the supply bottles and their holders.

Clean Exposed Surfaces

1. Turn off and unplug the instrument.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). Alternatively use
70% isopropyl alcohol.

Note: Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is typically 5.0%
NaClO; prepare a 1:10 dilution.

3. Open the plate carrier door and slide out the plate carrier.

4. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.

5. Wipe the plate carrier and all exposed surfaces of the instrument.

6. Wait 20 minutes. Moisten a cloth with deionized (DI) or distilled water and wipe all
surfaces that have been cleaned with the bleach solution or alcohol.

7. Use a clean, dry cloth to dry all wet surfaces.

8. If the dispenser is installed, purge any fluid (PM-4: Flush/Purge the Fluid Path on
page 99) and detach the outlet tubes from the instrument. If it is not installed, attach
only the dispenser’s communication cable to the instrument. Remove the supply bottles
and their holders.

Decontaminate the Fluid Lines

1. Place a beaker with 20 mL of 0.5% sodium hypochlorite solution or 70% isopropyl
alcohol near SYRINGE 1 on the dispenser and put the SYRINGE 1 inlet tube in the
beaker.
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2. If you have not already done so, detach the dispenser’s outlet tubes from the
instrument. Place the ends of the outlet tubes in an empty beaker and set the beaker
next to the dispenser.

3. In Gen5, use the Instrument Control tab (or select it from the Systemmenu), and

select .

4. Select Dispenser 1, enter a Volume of 5000 µL, and keep the default dispense Rate.

5. Place the priming plate on the carrier.

6. Run two prime cycles, for a total of 10,000 µL.

7. Wait at least 20 minutes to allow the solution to disinfect the tubing.

8. Remove the inlet tube from the beaker of disinfectant solution.

9. Change the Volume to 1000 µL.

10. Run one prime cycle, to flush the disinfectant out of the fluid lines.

11. Empty the beaker containing the outlet tubes. Put the tubes back in the empty beaker.

12. If sodium hypochlorite (bleach) was used, perform the Rinse the Fluid Lines steps
below.

Otherwise (or after performing the Rinse procedure), repeat the process for SYRINGE
2/Dispenser 2.

Rinse the Fluid Lines

Note: Perform this procedure only if decontamination was performed using sodium
hypochlorite.

1. Place a beaker containing at least 30 mL of deionized water on the dispenser.

2. Place the SYRINGE inlet tube in the beaker.

3. If you have not already done so, place the outlet tubes in an empty beaker.

4. In Gen5, select the Dispenser and set the Volume to 5000 µL, and keep the default
dispense Rate.

5. Run five prime cycles, for a total of 25,000 µL.

6. Pause for 10 minutes and then run one prime cycle with 5000 µL. This delay will allow
any residual sodium hypochlorite to diffuse into the solution and be flushed out with the
next prime.

7. Empty the beaker containing the outlet tubes.

8. Wipe all surfaces with deionized water.

9. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Clean the Tubing and Injectors

Perform PM-8: Clean the Dispense Tubes and Injectors on page 102.
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Decontaminate the Tip Priming Trough and Priming Plate

1. Remove the tip priming trough and priming plate.

2. Wash the tip priming trough and priming plate in hot, soapy water. Use a small brush or
cloth to clean the corners of the trough and plate.

3. To decontaminate, soak the trough and plate in a container of 0.5% sodium
hypochlorite or 70% isopropyl alcohol for at least 20 minutes.

l If decontaminating in a bleach solution, thoroughly rinse with deionized water.

l If decontaminating with alcohol, let the trough and plate air dry.

4. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Alternative Decon Procedure for Dispenser Modules

If you are unable to prime the tubing due to a system failure, decontaminate the instrument
and the dispenser as follows:

1. Begin by cleaning the dispenser as described: PM-8: Clean the Dispense Tubes and
Injectors on page 102.

2. Prepare an aqueous solution of 0.50% sodium hypochlorite (bleach). Alternatively, use
70% isopropyl alcohol.

Note: Check the percent NaClO of the bleach you are using. Commercial bleach is
typically 10.0% NaClO; prepare a 1:20 dilution. Household bleach is typically 5.0%
NaClO; prepare a 1:10 dilution.

3. Slide the microplate carrier out of the instrument.

4. Moisten a cloth with the bleach solution or alcohol. Do not soak the cloth.

5. Use the cloth to wipe:

l All exterior surfaces of the instrument

l All surfaces of the plate carrier

l The exposed surfaces of the dispenser, including the syringe valves

6. Remove the tubing and the syringes from the dispenser and soak them in the bleach or
alcohol solution. Wait for 20 minutes.

7. Moisten a cloth with DI or distilled water and wipe all surfaces that have been cleaned
with the bleach solution or alcohol.

8. Rinse all tubing and the syringes with DI water.

9. Use a clean, dry cloth to dry all surfaces on the instrument and the dispenser.

10. Reassemble the dispenser as necessary.
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11. Discard the used gloves and cloths using a biohazard trash bag and an approved
biohazard container.

Dispenser Syringe Replacement

Refer to the Periodic Maintenance chapter for cleaning procedures you must perform
regularly and especially in the case of poor performance (for example, when Dispense
Accuracy and Precision tests fail). If cleaning the dispenser does not eliminate performance
problems, or if a syringe is obviously leaking, perform these instructions to replace a faulty
syringe. Contact Technical Support to order replacement syringes.

To change a syringe, first use Gen5 to put the syringe in its maintenance position.

Syringe Maintenance Position

Note: Do not change the syringe position or calibrate the dispensers unless instructed to
do so as part of installation, upgrade, or maintenance.

When a syringe needs to be installed or replaced, it must first be moved to its “maintenance
position.”

1. From the Gen5 main screen, select System > Instrument Control > Cytation 5 and
click the Prime tab.

2. Select the Dispenser number (1 or 2) associated with the syringe.

3. ClickMaintenance. The syringe plunger will move to its furthest-from-home position.
The syringe can then be disconnected from the drive bracket and unscrewed from the
valve.

Replace the Syringe

After using Gen5 to move the syringe into its maintenance position:
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1. Using your fingers,
unscrew the bottom
thumbscrew that
secures the syringe,
underneath the
bracket. Retain this
bottom thumbscrew; it
is needed for the
replacement syringe.

2. Unscrew the top
thumbscrew to
disengage the syringe
from the valve.

3. Remove the new syringe from its protective box. (The syringe should already be
assembled in one piece. Install the Dispenser (Optional) on page 21, if it is not.).

4. Hold the syringe vertically with the threaded end at the top. Screw the top of the syringe
into the bottom of the syringe valve. Finger-tighten only.

5. Carefully pull down the bottom of the syringe until it rests inside the hole in the bracket.

6. Pass the thumbscrew (used to hold the old syringe) up through this hole and thread it
into the bottom of the syringe. Hold the syringe from rotating while tightening the
thumbscrew. Finger-tighten only.

7. From the Gen5 main screen, select System > Instrument Control > Cytation 5.
Click the Prime tab and click Initialize.
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Instrument Qualification Overview

BioTek Instruments recommends performing the following Installation Qualification (IQ),
Operational Qualification (OQ), and Performance Qualification (PQ) procedures for the
Cytation 5.

Every Cytation 5 and dispenser is fully tested at BioTek prior to shipment and should
operate properly upon initial setup. If you suspect that a problem occurred during
shipment, if you have received the equipment after returning it to the factory for service,
and/or if regulatory requirements dictate that you qualify the equipment on a routine basis,
perform the procedures outlined in this chapter.

Note: A Product Qualification Package (PN 1320532N) for the Cytation 5 is available for
purchase. The package contains complete procedures, Gen5 protocols, checklists, and
logbooks for performing Installation Qualification, Operational Qualification, Performance
Qualification, and Periodic Maintenance. Contact your local BioTek dealer for more
information.

Installation Qualification confirms that the instrument and its components have been
supplied as ordered and ensures that they are assembled and configured properly for your
lab environment.

l The recommended IQ procedure consists of setting up the instrument and its
components as described in Chapter 2, Installation, and performing the System Test. For
models with injectors, a quick Injector Test is also performed, to ensure that the
dispense module is properly installed and there are no leaks.

l The IQ procedure should be performed initially (before the reader is used for the first
time).

l The successful completion of the IQ procedure verifies that the instrument is installed
correctly. The Operational Qualification procedure should be performed immediately
following the successful IQ.

Operational Qualification confirms that the equipment operates according to
specification initially and over time.

l The recommended OQ procedure consists of performing the system test, Absorbance
Plate Test, luminescence test, a series of fluorescence tests, imaging autofocus and
carrier level tests , and, if the external dispense module is used, the Dispense Accuracy
and Precision Tests.

l The OQ procedure should be performed initially (before first use) and then routinely; the
recommended interval is annually. It should also be performed after any major repair or
upgrade to the hardware or software.

l Although out-of-tolerance failures will be detected by the OQ tests, results should be
compared with those from the routine Performance Qualification tests and previous OQ
tests to monitor for trends.
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l The successful completion of the OQ procedure, in combination with results that are
comparable to previous PQ and OQ tests, confirms that the equipment is operating
according to specification initially and over time.

Performance Qualification confirms that the instrument consistently meets the
requirements of the tests performed at your laboratory.

l The recommended PQ procedure consists of performing the system test, Absorbance
Plate Test, luminescence test, a series of fluorescence tests, imaging autofocus and
carrier level tests, and, if the external dispense module is used, the Dispense Accuracy
and Precision Tests.

l Your facility’s operating policies may also require that you routinely perform an actual
assay, to confirm that the reader will consistently give adequate results for the assays to
be run on it.

l These tests should be performed routinely; the recommended interval is monthly or
quarterly, depending on the test. This frequency may be adjusted depending on the
trends observed over time.

l The successful completion of the PQ procedure confirms that the equipment is
performing consistently under normal operating conditions.
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Recommended Qualification Schedule

This table defines BioTek-recommended intervals for qualification for an instrument used
two to five days a week. The schedule assumes that the Cytation 5 is properly maintained
as outlined in the Periodic Maintenance section.

Important: The risk and performance factors associated with your assays may require
that the Operational and Performance Qualification procedures be performed more or less
frequently than shown here.

Tasks/Tests

IQ OQ PQ

Initially Initially/
Annually Monthly Quarterly

All models:

Installation, setup, and
configuration of the instrument,
dispense module (if equipped),
gas controller (if equipped),
controller/host computer, and
Gen5 software.

ü

System Test ü ü ü

Plate Shaker Test ü

Absorbance capability*:

Software Wavelengths Table
Verification

ü ü ü

Absorbance Plate Test (400-800
nm)

ü ü

Absorbance Liquid Test 1 or
Liquid Test 21

ü ü

(Optional) Absorbance Liquid Test
3 or 340 nm Absorbance Plate
Test

ü ü

Fluorescence capability*:

1If you have the Absorbance Test Plate (400-800 nm), PN 7260522, run Liquid Test 1; otherwise, run
Liquid Test 2.
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Tasks/Tests

IQ OQ PQ

Initially Initially/
Annually Monthly Quarterly

Corners, Sensitivity, Linearity
Tests

ü ü

Fluorescence Polarization Test ü ü

Time-Resolved Fluorescence Test ü ü

Luminescence capability*:

Luminescence Test ü ü

Dispenser system*:

Injection System Test ü

Dispense Accuracy and Precision
Test

ü ü

Imaging capability*:

Carrier Level Test ü ü

Capture an Image ü

Joystick Verification (if used) ü

Alpha Laser capability*

Alpha Detection Test ü

* If applicable to your reader model

System Test

Each time the Cytation 5 is turned on, it performs a series of tests on the reader’s motors,
lamp(s), the PMT(s), and various subsystems. The system test may take a few minutes to
complete. If all tests pass, the microplate carrier is presented and the green LED on the
carrier switch remains on.

If any test results do not meet the internally coded Failure Mode Effects Analysis (FMEA)
criteria established by BioTek, the instrument beeps repeatedly and the red LED on the
carrier button flashes. If this occurs, press the carrier button to stop the beeping. If
necessary, initiate another system test using Gen5 to try to retrieve an error code from the
instrument. Refer to Appendix B, Error Codes for troubleshooting tips.
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Note: If the power-up system test fails, when you initiate a system test using Gen5,
Gen5 displays a message stating that the instrument has a pending system test report.
Click OK in the message box to review the report; it contains information obtained up to
the point of the failure.

Run the test using Gen5:

1. Turn on the instrument and launch Gen5.

2. If your assays use incubation, we recommend turning on the incubator and letting it
reach its set point before running the system test. To access this feature, from the Gen5
main screen, select Incubate from the Instrument Control tab.

3. Select System > Diagnostics > Run System Test.

Note: If the test fails during execution, a message appears. Close the message;
the test report contains the error code that was generated by the failure.

4. When the test is complete, a dialog appears, requesting additional information. Enter
your user name and other information (if desired) and then click OK.

5. The results report appears. It should show “SYSTEM TEST PASS”.

6. Turn off the incubator.

7. Print the report, if desired.

l Gen5 stores the results in a database, so the results can be retrieved at any time.

8. If the test failed, look up the error code to determine its cause. If it is something you can
fix, turn off the instrument, fix the problem, and then power on the instrument and retry
the test.

If the test continues to fail, or if the cause is not something you can fix, contact Technical
Support.

Imaging Test Procedures

Two imaging tests are performed to ensure 1) the carrier is level, and 2) satisfactory
images are captured.

Important: Do not perform these tests with the special High Contrast Bright Field
(HCBF) aperture installed. Replace the HCBF aperture with the standard brightfield
aperture before testing the instrument.

Required Materials

l Imaging qualification plate, PN 1222520

l 4X (recommended), or 2.5X or 10X objective (phase or standard)

l Microscope slide holder (adapter plate) (PN 1220548)
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l H&E slide or comparable sample for testing

l Gen5 protocol described on page 122: Cytation 5 <objective>_CarrierLevel.prt

Carrier Level Test

This test ensures the carrier is level in relation to the imaging system. You can run the test
with any of these objectives: Meiji 2.5X, Zeiss 2.5X, 4X, or 10X (phase or standard) (PL ACH
or PL FL). We recommend using the 4X.

Procedure
1. If you have not already done so, create the Carrier Level Gen5 protocol as described in

Gen5 Imaging Protocol on the next page.

2. Inspect/clean the imaging qualification plate (part number 1222520) prior to use.
Inspect the four (4) corner holes. Clean any debris from the holes using clean dry
compressed air.

3. Place the imaging qualification plate on the carrier with well A1 on the plate (facing up)
adjacent to the etched A1 in the corner of the carrier.

4. Create a new experiment in Gen5 using the CarrierLevel.prt protocol for the objective
you have chosen for the test.

5. Click Plate > Read Plate, save the experiment, then click OK.

6. When prompted by Gen5, rotate the plate 180 degrees in the carrier.

7. When the read is finished, analyze the results as described below.

Analyze the Results
1. Calculate the Mean focus height for each set of ten reads in the "Normal" position in

wells A1, A12, H1, and H12.

2. Calculate the Mean focus height for each set of ten reads in the "Turnaround" position in
wells A1, A12, H1, and H12.

3. Compare the Mean values for each well in its Normal and Turnaround positions by
performing these calculations:

a. –1 * (A1 Normal Mean – H12 Turnaround Mean)
b. (H12 Normal Mean – A1 Turnaround Mean)
c. –1 * (A12 Normal Mean – H1 Turnaround Mean)
d. (H1 Normal Mean – A12 Turnaround Mean)

4. For A1/H12:

l Calculate the Mean Delta (µm): (step a results + step b result) / 2

l Calculate the Carrier Tilt: Mean Delta / 25400 µm

l The Carrier Tilt must be less than 0.005" to Pass.

5. For A12/H1:
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l Calculate the Mean Delta (µm):(step c results + step d result) / 2

l Calculate the Carrier Tilt: Mean Delta / 25400 µm

l The Carrier Tilt must be less than 0.005" to Pass.

Gen5 Imaging Protocol

Note: The 4X objective is recommended for the Carrier Level Test. If a 4X objective is not
available, use a 2.5X or 10X objective. Phase or standard objectives perform these tests
equivalently.

Use the parameters in this table to create the Carrier Level Test protocol. Retain default
values for any protocol parameters that are not specified in the tables below.

Carrier Level Test

Cytation 5 <installed objective>_CarrierLevel.prt

Parameter Setting

Detection Method: Imaging

Read Type: Endpoint

Plate Type: 1222520 (imaging qualification plate)
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Parameter Setting

Read Step 1

Process Mode: Well Mode

Kinetic Step: Run Time: 18:00
Interval: 2 seconds
Reads: 10

Objective: 2.5X or 4X or 10X

“W” models De-select (disable) “Use Wide FOV (field of
view)”

Read Wells: A1, A12, H1, H12

Color Channel: Bright Field

Exposure: Illumination/LED: 5
Integration time: 50
Gain: 0

Auto Focus Options: Focus method: Auto focus with optional scan
Minimum focus metric ratio: 3
Scan distance: 600
Scan increment: 30
Minimum focus delta: 8
% of capture exposure for focus: 75
Offset from bottom of well: 0

Vibration Detection Options: CV Threshold: 0.01
Images to average: 1

Horizontal offset from center of
well:

0

Vertical offset from center of well: 0

Single image per well: Selected

Delay after plate movement: 300 msec
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Parameter Setting

After Read Step 1

Plate Out, In "Please rotate the plate 180 degrees"

Read Step 2

Process Mode: Well Mode

Kinetic Step: Run Time: 18:00
Interval: 2 seconds
Reads: 10

Objective: 2.5X or 4X or 10X

Read Wells: A1, A12, H1, H12

Color Channel: Bright Field

Exposure: Illumination: 5
Integration time: 50
Gain: 0

Auto Focus Options: Focus method: Auto focus with optional scan
Minimum focus metric ratio: 3
Scan distance: 600
Scan increment: 30
Minimum focus delta: 8
% of capture exposure for focus: 75
Offset from bottom of well: 0
Search width: 350

Vibration Detection Options: CV Threshold: 0.01
Images to average: 1

Horizontal offset from center of
well:

0

Vertical offset from center of well: 0

Single image per well: Selected
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Parameter Setting

Delay after plate movement: 300 msec
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Capture an Image Test

Perform this test to ensure images can be captured in each imaging modality.

Note: BioTek recommends using an H&E slide or comparable sample for this test.

1. Load the H&E slide or
comparable sample in the slide
holder with its cover slip facing
down.

2. In Gen5, launch manual
mode by clicking the
microscope button. Choose
the Slide Holder All Mag.
(w/A1 mark) as the Plate
Type.

3. Select a "Phase" Objective, if
available.

4. One at a time, cycle through
the options for each Color
channel capturing an image
with available options:

l Fluorescence: DAPI or
GFP

l Bright Field
l Phase Contrast
l Color Bright Field

Note: Apply Auto Exposure and Auto Focus
iteratively as needed in each Color channel.
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Joystick Performance Verification

Gen5 recognizes the joystick when it is installed. On the Stage
Movement panel, when the joystick is connected, two checkboxes
are offered, including Joystick enabled. As needed, click the
checkbox to use the joystick rather than the computer controls.
Choose Joystick inverted to reverse the direction settings.

Note: After connecting a joystick to the imager, you must restart the imager to activate
the connection.

If the joystick is installed, follow these steps to verify its performance:

1. In Gen5, launch manual mode. Choose Slide Holder All Mag. (w/A1 mark) as
the Plate Type and put the slide holder on the stage.

Using the imager

2. Select a 4X or Phase 4X or your lowest objective.

3. Set Color to: DAPI 377, 447.

4. Expand the Stage Movement panel and make sure the Joystick enabled checkbox is
filled.

5. Use the joystick to center the image vertically and horizontally.

6. Switch to 20X or Phase 20X (or your highest objective).

7. Click Auto Expose.

8. Use the joystick focus control to find the image focus.

9. Test all directional positions and focus up/down.

If all works as expected, the test passes. If not, contact Technical Support.
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Absorbance Plate Test

Applies only to models with absorbance capabilities.

This test uses BioTek's Absorbance Test Plate (PN 7260522) to confirm the mechanical
alignment; optical density accuracy, linearity, and repeatability; and wavelength accuracy
of the Cytation 5. The Absorbance Test Plate compares the reader's optical density and
wavelength measurements to NIST-traceable values.

Note: An alternate method for confirming accuracy, linearity, and repeatability is Liquid
Test 2, described on page 134.

To run this test, you need the BioTek Absorbance Test Plate (PN 7260522), with its
accompanying certificate.

l The Absorbance OD Standards section contains NIST-traceable standard OD values for
the filters at several different wavelengths. We recommend testing at six wavelengths—
those at or close to the wavelengths used in your assays.

l The Wavelength Accuracy Standards section contains Expected Peak wavelength values
for the filter in position C6 on the plate. Each value has a valid test range associated with
it. For example, an Expected Peak value may be 586 nm with tolerance values of –6/+4
(or a test range of 580 to 590 nm).

Note: The instructions provided below are guidelines. Refer to the Gen5 Help system for
more information.

Note: BioTek's Absorbance Test Plate PN 7260551 can be used to confirm optical density
accuracy, linearity, and repeatability at 340 nm and is offered as an alternative to
conducting Absorbance Liquid Test 3.

Define Absorbance Test Plate Parameters

1. Obtain the certificate that came with the Test Plate.

2. Start Gen5 and from the main screen select System > Diagnostics > Test Plates >
Add/Modify Plates.

3. Click Add. The Absorbance Test Plate dialog appears.

4. Select the appropriate Plate Type and enter the plate’s serial number.

5. Enter the Last Certification and Next Certification dates from the calibration sticker on
the Test Plate.

6. If the wavelength values in the top row of the grid in Gen5 are appropriate for your
tests, enter the OD values from the data sheet into the grid. Make sure you enter the
correct value for each well/wavelength combination.
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Note: If you need to change the wavelength values, clickWavelength List. Click the
Gen5 Help button for assistance.

7. Select the number of Peak Wavelength tests to run (up to 4).

8. Enter the Expected Peak value(s) from the certificate and set the Test Range – and +
values.

l If the certificate contains two Spectral Band Pass tables: The Cytation 5 has a band
pass wider than 5 nm for wavelengths greater than 285 nm and narrower than 4 nm for
230–285 nm. As a result, we recommend using expected peak values from the 2.4 nm
table for peaks that are 285 nm and lower, and from the 5.0 nm table for all other
peaks.

9. Review all the values you entered. Click OK to save the data.

The information you just entered is available on Gen5 each time the Absorbance Plate Test
is performed. It may need to be modified after the annual recertification of your test plate.

Run the Absorbance Plate Test

1. From the Gen5 main screen, select System > Diagnostics > Test Plates > Run. If
prompted, select the desired Test Plate and click OK.

2. When the Absorbance Test Plate Options dialog appears, select Perform Peak
Wavelength Test if it is not already selected.

3. Highlight the wavelength(s) to be included in this test.

Note: Select only those wavelengths most appropriate for your use of the reader.

4. (Optional) Enter any Comments.

5. Click Start Test.

6. Place the Test Plate in the microplate carrier so that well A1 is in the right-rear corner of
the carrier.

7. Click OK to run the test.

8. When the test is completed, the results report appears. Scroll through the report; every
result should show “PASS”.

Gen5 stores the results in a database; they can be retrieved any time. We recommend
you print and save the report to document that the test was performed.

Results and Troubleshooting Tips

The Absorbance Test Plate Report contains results for the following:

l Peak Absorbance:When the test is performed, the C6 filter is scanned at the test ranges
defined by the user in the Absorbance Test Plate dialog. To verify wavelength accuracy,
the wavelength of the maximum absorbance is compared with the peak wavelength
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value entered in the software, which comes from the certificate supplied with the
Absorbance Test Plate. The accuracy of the wavelength should be ± 3 nm (± 2 nm
instrument, ± 1 nm filter allowance). If the reader fails this test:

n Make sure the information entered into Gen5 matches the Test Plate’s
Certificate.

n Verify that the Test Plate has a filter in location C6. (Test Plates with the part
numbers 9000547 and 7260551 do not have this filter.)

n Check the C6 filter to make sure it is clean. If needed, clean it with lens paper.
Do not remove the filter from the Test Plate, and do not use alcohol or other
cleaning agents.

n Verify that the Test Plate is within its calibration certification period. If it is out of
date, contact BioTek to schedule a recertification.

n Check the microplate carrier to ensure it is clear of debris.

l Alignment: This test measures the alignment of the microplate carrier with the optical
path. A reading greater than 0.015 OD represents an out-of-alignment condition. Wells
A1, A12, H1, and H12 are the only valid alignment holes for the reader on the PN
7260522 Test Plate.

If the reader fails this test:

n Ensure that the Test Plate is correctly seated in the microplate carrier.

n Check the four alignment holes (A1, A12, H1, H12) to ensure they are clear of
debris.

n Check the microplate carrier to ensure it is clear of debris.

l Accuracy: Accuracy is a measure of the optical density of Test Plate wells C1, D4, E2, F5,
G3, and H6 as compared with known standard values contained in the Standards
Certificate that accompanies each Test Plate.

If the reader fails this test:

n Verify that the filter calibration values entered in Gen5 are the same as those on
the Test Plate’s Standards Certificate.

n Check the filters on the Test Plate to ensure they are clean. If necessary, clean
them with lens paper. Do not remove the filters from the test plate, and do not
use alcohol or other cleaning agents.

n Verify that the Test Plate is within its calibration certification period. If it is out of
date, contact BioTek to schedule a recertification.

l Repeatability: Repeatability is a measure of the instrument’s ability to read the same well
with minimum variation between two reads with the well in the same location. If the
reader fails this test:

n Check the filters on the Test Plate to ensure there is no debris that may have
shifted between readings and caused changes.

n Check the microplate carrier to ensure it is clear of debris.
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Linearity of the optical density readings is confirmed by default if the optical density
readings are accurate. To further verify this, you can perform a regression analysis on
the Test Plate OD values in a spreadsheet program such as Microsoft Excel. An R-
Squared value of at least 0.9900 is expected.
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Absorbance Liquid Tests

Conducting liquid tests confirms the reader’s ability to perform to specification with liquid
samples. Liquid testing differs from testing with the Absorbance Test Plate in that liquid in
the wells has a meniscus, whereas the Test Plate’s neutral density glass filters do not. The
optics characteristics may differ in these two cases, thus alerting the operator to different
types of problems.

Absorbance Liquid Test 1

Absorbance Liquid Test 1 confirms repeatability and alignment of the reader when a
solution is used in the microplate. If these tests pass, then the lens placement and optical
system cleanliness are proven.

Materials

Note: Manufacturer part numbers are subject to change over time.

l New 96-well, clear, flat-bottom microplate (Corning Costar #3590 recommended)

l Stock Solution A or B, which may be formulated by diluting a dye solution available from
BioTek (Solution A) or from the ingredients listed below (Solution B).

Solution A

l BioTek QC Check Solution No. 1 (PN 7120779, 25 mL; PN 7120782, 125 mL)

l Deionized water

l 5 mL Class A volumetric pipette

l 100 mL volumetric flask

1. Pipette 5 mL BioTek QC Check Solution No. 1 into a 100 mL volumetric flask.

2. Add 95 mL of DI water; cap and shake well. The solution should measure approximately
2.000 OD when using 200 µL in a flat-bottom microwell.

Solution B

l Deionized water

l FD&C Yellow No. 5 dye powder (typically 90% pure)

l Tween 20 (polyoxyethylene (20) sorbitan monolaurate) or BioTek wetting agent (PN
7773002) (a 10% Tween solution)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l Weigh boat

l 1-liter volumetric flask
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1. Weigh 0.092 g of FD&C Yellow No. 5 dye powder in a weigh boat.

2. Rinse the contents into a 1-liter volumetric flask.

3. Add 0.5 mL of Tween 20, or 5 mL of BioTek’s wetting agent.

4. Fill to 1 liter with DI water; cap and shake well. The solution should measure
approximately 2.000 OD when using 200 µL in a flat-bottom microwell.

Prepare the Plate

Note: Be sure to use a new microplate, because fingerprints or scratches may cause
variations in readings.

1. Using freshly prepared stock solution (Solution A or B), prepare a 1:2 dilution using
deionized water (one part stock, one part deionized water; the resulting solution is a 1:2
dilution).

2. Pipette 200 µL of the concentrated solution (A or B) into the first column of wells in the
microplate.

3. Pipette 200 µL of the diluted solution into the second column of wells.

Shake the plate for four minutes after pipetting and before reading the plate to allow
any air bubbles in the solution to settle and the meniscus to stabilize. Alternatively, wait 20
minutes after pipetting the test solution before reading the plate.

Read the Plate
1. Using Gen5, read the microplate five times at 405 nm using the Normal read mode,

single wavelength, no blanking. Save the data after each read (“Normal” plate position).

2. Without delay, rotate the microplate 180 degrees so that well A1 is in the “H12”
position. Read the plate five more times, saving the data after each read (“Turnaround”
plate position).

3. Print out the ten sets of raw data, or export them to an Excel spreadsheet.

Analyze the Results

1. The plate is read five times in the “Normal” position at 405 nm. Calculate the Mean OD
and Standard Deviation of those five reads for each well in columns 1 and 2.

2. For each well in columns 1 and 2, calculate the Allowed Deviation using the repeatability
specification for a 96-well plate: ± 1% ± 0.005 OD from 0.000 to 2.000 OD (Mean *
0.010 + 0.005). For each well, its standard deviation should be less than its allowed
deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a mean of 0.8004 and a standard deviation of 0.0018. The mean multiplied by
1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this
is the allowed deviation for well A1. Since the standard deviation for well A1 is less
than 0.013, the well meets the test criteria.
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3. The plate is read five times in the “Turnaround” position at 405 nm. Calculate the Mean
OD of those reads for each well in columns 11 and 12.

4. Perform a mathematical comparison of the Mean values for each microwell in its Normal
and Turnaround positions (that is, compare A1 to H12, A2 to H11, B1 to G12,… H2 to
A11). To pass the test, the differences in the compared mean values must be within the
accuracy specification for a 96-well microplate: ± 1.0% ± 0.010 OD from 0.000 to
2.000 OD.

Example: If the mean value for well A1 in the Normal position is 1.902 with a
specified accuracy of ± 1.0% ± 0.010 OD, then the expected range for the mean
of the well in its Turnaround (H12) position is 1.873 to 1.931 OD. 1.902 x 0.010 +
0.010 = 0.029; 1.902 - 0.029 = 1.873; 1.902 + 0.029 = 1.931.

Repeatability Specification:
± 1.0% ± 0.005 OD from 0.000 to 2.000 OD

± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD

Accuracy Specification:
± 1.0% ± 0.010 OD from 0.000 to 2.000 OD

± 3.0% ± 0.010 OD from 2.000 OD to 2.500 OD

Absorbance Liquid Test 2

The recommended method for testing the instrument’s alignment, repeatability, and
accuracy is to use the Absorbance Plate Test on page 128. If the test plate is not available,
this Absorbance Liquid Test 2 can be used instead.

Materials

l A new 96-well, clear, flat-bottom microplate (Corning Costar #3590 is recommended)

l Ten test tubes, numbered consecutively, set up in a rack

l Calibrated hand pipette (Class A volumetric pipette recommended)

l Solution A or B (see the instructions for Liquid Test 1)

l A 0.05% solution of deionized water and Tween 20

Prepare the Dilutions
Create a percentage dilution series, beginning with 100% of the original concentrated stock
solution (A or B) in the first tube, 90% of the original solution in the second tube, 80% in
the third tube, all the way to 10% in the tenth tube. Dilute using the 0.05% solution of
deionized water and Tween 20. This solution can also be made by diluting the BioTek
wetting agent 200:1.
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Test Tube Dilutions for Liquid Test 2

Tube Number 1 2 3 4 5 6 7 8 9 10

Volume of Original
Concentrated Solution
(mL)

20 18 16 14 12 10 8 6 4 2

Volume of 0.05% Tween
Solution (mL)

0 2 4 6 8 10 12 14 16 18

Absorbance expected if
original solution is 2.0 at
200 μL

2.0 1.8 1.6 1.4 1.2 1.0 0.8 0.6 0.4 0.2

Note: The choice of dilutions and the absorbance of the original solution can be varied.
Use this table as a model for calculating the expected absorbances of a series of dilutions,
given a different absorbance of the original solution.

Prepare the Plate
l Pipette 200 µL of the concentrated solution from Tube 1 into each well of the first column,
A1 to H1, of a new flat-bottom microplate.

l Pipette 200 µL from each of the remaining tubes into the wells of the corresponding
column of the microplate (Tube 2 into wells A2 to H2, Tube 3 into wells A3 to H3, and so
on).

Linearity and Repeatability Tests
1. Using Gen5, read the microplate prepared above five times using Normal mode, dual

wavelength at 450/630 nm. Save the data after each read.

Note: Do not discard the plate; you will use it for the Alignment Test.

2. Print out the five sets of Delta OD data, or export them to an Excel spreadsheet.

3. Calculate the results for Linearity:

l Calculate the mean absorbance for each well, and average the means for each
concentration.

l Perform a regression analysis on the data to determine if there is adequate
linearity.

Since it is somewhat difficult to achieve high pipetting accuracy when conducting
linear dilutions, an R-Square value of at least 0.9900 is considered adequate.

4. Calculate the results for Repeatability:

l Calculate the mean and standard deviation for the five readings taken in Step 1 at
each concentration. Only one row of data needs to be analyzed.
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l For each mean below 2.000 OD, calculate the allowed deviation using the
repeatability specification for a 96-well plate of ± 1.0% ± 0.005 OD. If above
2.000 OD, apply the ± 3.0% ± 0.005 specification.

l The standard deviation for each set of readings should be less than the allowed
deviation.

Example: Absorbance readings of 1.950, 1.948, 1.955, 1.952, and 1.950 will
result in a mean of 1.951, and a standard deviation of 0.0026. The mean (1.951)
multiplied by 1.0% (1.951 x 0.010) = 0.0195, which, when added to the 0.005
(0.0195 + 0.005) = 0.0245 OD, which is the allowed deviation. Since the standard
deviation is less than this value, the reader meets the test criteria.

Repeatability Specification:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD

± 3.0% ± 0.005 OD from 2.000 to 2.500 OD

Alignment Test
1. Using the plate prepared for the Linearity Test on the previous page, conduct a

Turnaround test by reading the plate five times with the A1 well in the H12 position.
Save the data after each read.

This test results in values for the four corner wells that can be used to determine
alignment.

2. Calculate the means of the wells A1 and H1 in the Normal plate position (data from
Linearity Test) and in the Turnaround position (from Step 1).

3. Compare the mean reading for well A1 to its mean reading when in the H12 position.
Next, compare the mean values for the H1 well to the same well in the A12 position. The
difference in the values for any two corresponding wells should be within the accuracy
specification for the instrument.

Example: If the mean of well A1 in the normal position is 1.902, where the
specified accuracy is ± 1.0% ± 0.010 OD, then the expected range for the mean of
the same well in the H12 position is 1.873 to 1.931 OD. (1.902 x 1.0% = 0.019 +
0.010 = 0.029, which is added to and subtracted from 1.902 for the range.)

If the four corner wells are within the accuracy range, the reader is in alignment.

Accuracy Specification:

± 1.0% ± 0.010 OD from 0.000 to 2.000 OD

± 3.0% ± 0.010 OD from 2.000 to 2.500 OD

Absorbance Liquid Test 3

Absorbance Liquid Test 3 is provided for sites requiring proof of linearity at 340 nm. This
test is optional because the reader has good “front end” linearity throughout its wavelength
range.
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Note: BioTek Absorbance Test Plate PN 7260551 is offered as an alternative to
conducting this test, Absorbance Liquid Test 3.

Materials

Note: Manufacturer part numbers are subject to change.

l New 96-well, clear, flat-bottom microplate (Corning Costar #3590 recommended)

l Calibrated hand pipette(s)

l Beakers and graduated cylinder

l Precision balance with readability to 0.01 g

l Buffer solution described below

Buffer Solution
l Deionized water

l Phosphate-Buffered Saline (PBS), pH 7.2–7.6, Sigma tablets, #P4417 (or equivalent)

l β-NADH Powder (β-Nicotinamide Adenine Dinucleotide, Reduced Form) Sigma bulk
catalog number N 8129, or preweighed 10-mg vials, Sigma number N6785-10VL (or
BioTek PN 98233). Store the powder according to the guidelines on its packaging.

1. Prepare a PBS solution from the Sigma tablets.

2. In a beaker, mix 50 mL of the PBS solution with 10 mg of the β-NADH powder and mix
thoroughly. This is the 100% Test Solution.

3. (Optional) Read a 150-µL sample of the solution at 340 nm; it should be within 0.700 to
1.000 OD. If low, adjust up by adding more powder. Do not adjust if slightly high.

Prepare the Plate
1. Prepare the 75% Test Solution by mixing 15 mL of the 100% Test Solution with 5 mL

of the PBS Solution.

2. Prepare the 50% Test Solution by mixing 10 mL of the 100% Test Solution with 10
mL of the PBS Solution.

3. Carefully pipette the three solutions into a new 96-well microplate:

l 150 µL of the 100% Test Solution into all wells of columns 1 and 2

l 150 µL of the 75% Test Solution into all wells of columns 3 and 4

l 150 µL of the 50% Test Solution into all wells of column 5 and 6

Read the Plate

1. Using Gen5, read the microplate five times using Normal mode, single wavelength at
340 nm, no blanking. Save the data after each read.

2. Print out the five sets of raw data, or export them to an Excel spreadsheet.
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Analyze the Results

Note: The plate is read five times at 340 nm.

1. For each well, calculate the Mean OD and Standard Deviation of the five readings.

2. For each mean calculated in step 1, calculate the allowed deviation using the
repeatability specification for a 96-well plate: ± 1% ± 0.005 OD from 0.000 to 2.000 OD
(Mean x 0.010 + 0.005). For each well, its standard deviation should be less than its
allowed deviation.

Example: Five readings in well A1 of 0.802, 0.802, 0.799, 0.798, and 0.801 result
in a mean of 0.8004 and a standard deviation of 0.0018. The mean multiplied by
1.0% (0.8004 * 0.010) equals 0.008, and when added to 0.005 equals 0.013; this
is the allowed deviation for well A1. Since the standard deviation for well A1 is less
than 0.013, the well meets the test criteria.

3. Calculate the results for Linearity:

l For each of the three test solutions, calculate the average Mean OD for the wells
containing that solution (mean of wells A1 to H2, A3 to H4, and A5 to H6).

l Perform a regression analysis on the data to determine if there is adequate
linearity. The three average Mean OD values are the “Y” values. The solution
concentrations are the “X” values (1.00, 0.75, 0.50).

Since it is somewhat difficult to achieve high pipetting accuracy when conducting
linear dilutions, an R-Squared value of at least 0.9900 is considered adequate.

Repeatability Specification:

± 1.0% ± 0.005 OD from 0.000 to 2.000 OD

± 3.0% ± 0.005 OD from 2.000 OD to 2.500 OD
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Fluorescence Testing Overview

BioTek provides two options for testing the Cytation 5 fluorescence system. One uses a
solid state Fluorescence Test Plate (package PN 14005011). The other uses liquid plates,
the materials for which are available for purchase from BioTek (Optional Accessories on
page 5).

1Fluorescence Test Plate PN 7092092 cannot be used for these tests.
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BioTek Fluorescence Plate Tests

The BioTek Fluorescence Test Plate simplifies the process for conducting fluorescence
intensity, fluorescence polarization, and time-resolved fluorescence qualification tests. The
test plate is solid and, therefore, immune to the pipetting errors, evaporation issues, and
costs experienced with conventional liquid tests.

The test-plate package includes Gen5 protocols1 designed specifically for use with the test
plate. The protocols include embedded Microsoft Excel spreadsheets to automatically
calculate results and determine pass/fail. The protocols and their spreadsheets were fully
validated in accordance with BioTek Instrument’s Product Validation policies and
procedures.

The package also contains a user guide that describes the test methods, helps you get
started with using the plate, and provides important information for cleaning and
maintaining the test plate. The guide also provides troubleshooting tips and information on
the annual recalibration program.

Requirements

Refer to the Fluorescence Test Plate User Manual for information on the required
materials and prerequisite tasks.

Test Procedure

The Qualification Tests section of the Fluorescence Test Plate User Manual contains
a procedure for cleaning the plate and then creating and running experiments based on
supplied Gen5 protocols. As described in the user guide, when each experiment is finished,
Gen5 exports the measurement data to a prepared Microsoft Excel .xls file. The worksheet
(s) in that Excel file calculate results and determine pass or fail.

Identify the reader-specific Gen5 protocols on the USB flash drive that came with the test
plate. Use only those protocols that apply to your reader model and your organization's
qualification requirements.

Results Analysis

Refer to the Fluorescence Test Plate User Manual for descriptions of the data reduction
calculations for each test, as well as troubleshooting tips. The tests must meet the following
criteria to pass:

Fluorescence Intensity (FI) Tests

Corners %CV < 3.0

Linearity R2 >= 0.9500

Sensitivity, filter-based system:

Top optics, Sodium Fluorescein analogue Detection Limit <= 10.0 pM
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Fluorescence Intensity (FI) Tests

Top optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Sensitivity, monochromator-based system:

Top optics, Sodium Fluorescein analogue Detection Limit <= 20.0 pM

Bottom optics, Sodium Fluorescein analogue Detection Limit <= 20.0 pM

Top optics, Methylumbelliferone analogue Detection Limit <= 160.0 pg/mL

Bottom optics, Methylumbelliferone
analogue

Detection Limit <= 160.0 pg/mL

Time-Resolved Fluorescence (TRF) Test Detection Limit <= 250.0 fM

Fluorescence Polarization (FP) Test Mean PHPR > 340 mP, STD PLPR < 5

1Gen5 version 2.07 or higher is required.

Fluorescence Liquid Tests

Perform all the tests that represent the assays performed in your laboratory to confirm the
reader is performing to specifications.

Required Materials

Important: Use perfectly clean microplates, free of dust or bottom scratches, e.g., new
microplates from sealed packages.

For All Tests: Test-Specific Materials:

l Deionized or distilled water

l Various beakers, graduated cylinders,
and pipettes

l 95% ethanol (for cleaning clear-bottom
plates)

l Aluminum foil

l (Optional, but recommended) 0.45-
micron filter

l (Optional) Black polyethylene bag(s) to
temporarily store plate(s)

l Gen5 protocols listed on page 143.

l Corners-Sensitivity-Linearity Tests
Materials on page 152

l Fluorescence Polarization (FP) Test
Materials on page 152

l Time-Resolved Fluorescence (TRF)
Test Materials on page 153

and

l Prepare the Fluorescence Test
Solutions on page 153

l Pipette Maps on page 156
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For the Filter-Based Fluorescence System

Cytation 5_FI_T_SF.prt Corners, Sensitivity, and Linearity Tests, using the top optics

Cytation 5_FI_T_MUB.prt Alternative Top Optics Test, using methylumbelliferone

Cytation 5_FP.prt Fluorescence Polarization Test

Cytation 5_TRF.prt Time-Resolved Fluorescence Test

For the Monochromator-Based Fluorescence System

Cytation 5_M_FI_T_SF.prt Corners, Sensitivity, and Linearity Tests, using the Top optics

Cytation 5_M_FI_B_SF.prt Corners, Sensitivity, and Linearity Tests, using the Bottom
optics

Cytation 5_M_FI_T_
MUB.prt

Alternative Top Optics Test, using methylumbelliferone

Filter Set Setup
Before using the filter-based fluorescence test protocols, create the applicable filter sets
shown below in Gen5 ("Green" is used for sodium fluorescein tests, "Blue" for MUB).
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Gen5 Fluorescence Liquid Test Protocols

Here are the recommended reading parameters. It is possible that your tests will require
modifications to some of these parameters, such as the Plate Type (see Troubleshooting
Tips on page 161).

Important: Make sure the Plate Type setting in the Gen5 protocol matches the
microplate you are using.

Cytation 5_FI_T_SF.prt

This procedure contains two Read steps using filters (as described on page 142) to test the
top optics: one for the Corners Test and one for the Sensitivity/Linearity Test.

Parameter Setting

Plate Type: Costar 96 black opaque (#3915)

Read Step 1

Detection
Method:

Fluorescence

Read Type: Endpoint

Kinetic Loop Run Time: 00:00:45
Interval: 00:00:03
Reads: 16

Step Label: "Sensitivity Read"
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Parameter Setting

Read Well: D7

Filter Set: 1 (Green)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position: Top 510 nm

Gain: Auto, Scale to High Wells, D7, 50000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 2

Detection
Method:

Fluorescence

Read Type: Endpoint

Kinetic Loop Run Time: 00:01:35
Interval: 00:00:06
Reads: 16

Step Label: "Sensitivity Read Buffer"

Read Wells: C9..E9

Filter Set: 1 (Green)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position: Top 510 nm

Gain: Auto, Use first filter set gain from FIRST Read
Step
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Parameter Setting

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 3

Detection
Method:

Fluorescence

Read Type: Endpoint

Step Label: "Corners Read"

Read Wells: A1..A3, A10..A12, H1..H3, H10..H12

Filter Set: 1 (Green)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position: Top 510 nm

Gain: Auto, Scale to High Wells, A3, 50000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 4

Detection
Method:

Fluorescence

Read Type: Endpoint
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Parameter Setting

Step Label: "Linearity Read"

Read Wells: C1..F5

Filter Set: 1 (Green)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position: Top 510 nm

Gain: Auto, Scale to High Wells, C1, 50000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point:50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Cytation 5_FP.prt

This procedure contains one Read step using filters with Fluorescence Polarization enabled,
inside a Plate Mode block.

Parameter Setting

Detection Method: Fluorescence polarization

Read Type: Endpoint

Plate Type: Costar 96 black opaque (#3915)

Shake Step: Linear for 15 seconds

Delay Step: 5 seconds after shake

Synchronized
Mode:

Plate Mode with Timing Control
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Parameter Setting

Read Wells: A6–H8

Filter Sets: 1 (filter cube)

Filters: EX 485/20 nm, EM 528/20 nm

Optics Position: Top 510 nm

Gain: Auto, Scale to high Wells, A8, 10000

Read Speed: Normal
Delay after plate movement: 350
msec
Measurements per data point: 60
Lamp Energy: Low

Read Height: 7.00 mm

Cytation 5_TRF.prt

Parameter Setting

Plate Type: Costar 96-well white opaque

Delay Step: 3 minutes

Shake Step: Linear for 30 seconds

Read Step 1

Detection Method: Time-resolved fluorescence

Read Type: Endpoint

Kinetic Loop Run Time: 00:00:15
Interval: 00:00:01
Reads: 16

Step Label: "Sensitivity Read"

BioTek Instruments, Inc.



148 | Chapter 7: Instrument Qualification

Parameter Setting

Read Well: A8

Filter Sets: 1 (filter cube)

Filters: EX 360/40 nm, 620/40 nm

Optics Position: Top 400 nm

Gain: Auto, Scale to High Wells, A8, 50000

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low

Time-Resolved FL
Options:

Delay before collecting data: 300 µsec

Data collection time: 1000 µsec

Read Height: 7.00 mm

Read Step 2

Detection Method: Time-resolved fluorescence

Read Type: Endpoint

Kinetic Loop Run Time: 00:00:45
Interval: 00:00:03
Reads: 16

Step Label: "Sensitivity Read Buffer"

Read Well: A6–C6

Filter Sets: 1 (filter cube)

Filters: EX 360/40 nm, 620/40 nm

Optics Position: Top 400 nm
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Parameter Setting

Gain: Auto, Use first filter set gain from FIRST Read
Step

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low

Time-Resolved FL
Options:

Delay before collecting data: 300 µsec

Data collection time: 1000 µsec

Read Height: 7.00 mm

Cytation 5_M_FI_T_SF.prt and Cytation 5_M_FI_B_SF.prt

Parameter Setting

Plate Type: Top: Costar 96 black opaque
Bottom: Greiner SensoPlate

Read Step 1

Detection Method: Fluorescence

Read Type: Endpoint

Kinetic Loop Run Time: 00:00:45
Interval: 00:00:3
Reads: 16

Step Label: "Sensitivity Read"

Read Well: D7

Wavelength: 1, EX 485/14, EM 528/14 nm

Optics Position: Top/Bottom

Gain Auto, Scale to High Wells, D7, 50000
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Parameter Setting

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height (for top
optics):

7.00 mm

Read Step 2

Detection Method: Fluorescence

Read Type: Endpoint

Kinetic Loop Run Time: 00:01:35
Interval: 00:00:6
Reads: 16

Step Label: "Sensitivity Read Buffer"

Read Well: C9..E9

Wavelength: 1, EX 485/14, EM 528/14 nm

Optics Position: Top/Bottom

Gain Auto, Use first filter set gain from FIRST Read
Step

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height (for top
optics):

7.00 mm

Read Step 3
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Parameter Setting

Detection Method: Fluorescence

Read Type: Endpoint

Step Label: "Corners Read"

Read Wells: A1..A3, A10..A12, H1..H3, H10..H12

Wavelength: 1, EX 485/14, EM 528/14 nm

Optics Position: Top/Bottom

Gain Auto, Scale to High Wells, A3, 50000

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height (for top
optics):

7.00 mm

Read Step 4

Detection Method: Fluorescence

Read Type: Endpoint

Step Label: "Linearity Read"

Read Wells: C1..F5

Wavelength: 1, EX 485/14, EM 528/14 nm

Optics Position: Top/Bottom

Gain Auto, Scale to High Wells, C1, 50000

Read Speed: Normal
Delay after plate movement: 100 msec
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Parameter Setting

Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height (for top
optics):

7.00 mm

Corners-Sensitivity-Linearity Tests Materials

Note: BioTek offers a liquid test kit (PN 7160010) containing the microplates and
solutions needed for all fluorescence liquid tests (SF/MUB/Eu). Kits for each individual
procedure are also available: Optional Accessories on page 5. Sodium Fluorescein Test Kit
(PN 7160013) contains the buffer and SF already diluted.

Note: Methylumbelliferone can be used as an alternative or supplemental method for
performing these tests.

l Buffer:

n NIST-traceable Sodium Borate Reference Standard (pH 9.18) (e.g., Fisher-
Scientific 1 L Sodium Borate Mfr. #159532, or equivalent), or

n Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfr.
#P4417, or equivalent) and pH meter or pH indicator strips with pH range 4 to
10

l Sodium Fluorescein Powder (1-mg vial, BioTek PN 98155)

l If testing both Top and Bottom optics (mono-based fluorescence only): A new, clean 96-
well glass-bottom Greiner SensoPlate (Mfr. #655892); or a clean Hellma Quartz 96-well
titration plate (Mfr. #730.009.QG); or equivalent

l If testing the Top optics only: A new, clean 96-well solid black microplate, such as
Corning Costar #3915, or equivalent

l Excitation filter 485/20 nm installed

l Emission filter 528/20 nm installed

l 510-nm dichroic mirror installed

Fluorescence Polarization (FP) Test Materials

l A new, clean, 96-well solid black microplate, such as Corning Costar #3915. A Greiner
SensoPlate can also be used.
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Note: The FP Test can be performed in conjunction with the top
Corners/Sensitivity/Linearity Tests, in the same microplate.

l The recommended test solutions are available from Invitrogen Corporation in their “FP
One-Step Reference Kit” (PN P3088) or from BioTek (PN 7160014). This kit includes:

n (Green) Polarization Reference Buffer, 15 mL

n Green Low Polarization Reference, 4 mL

n Green High Polarization Reference, 4 mL

Note: The Invitrogen kit also includes two red polarization solutions that are not used.

l Excitation filter 485/20 nm installed

l Emission filter 528/20 nm installed

l 510-nm dichroic mirror and polarizers installed

Time-Resolved Fluorescence (TRF) Test Materials

BioTek offers a preconfigured qualification TRF filter cube (PN 8040555) for purchase.

l 15-mL conical-bottom, polypropylene sample tube

l Excitation filter 360/40 nm installed

l Emission filter 620/40 nm installed

l 400-nm dichroic mirror installed

l A new, clean 96-well solid white microplate, such as Corning Costar #3912

l The recommended test solution (FluoSpheres carboxylate-modified microspheres, 0.2
µm europium luminescent, 2 μL) is available from Invitrogen Corporation (PN F20881) or
from BioTek (PN 7160011)

Prepare the Fluorescence Test Solutions

Corners/Sensitivity/Linearity Tests

Important: If using BioTek’s sodium fluorescein powder (PN 98155), be sure to hold the
vial upright and open it carefully; the material may be concentrated at the top. If a
centrifuge is available, spin down the tube before opening. When diluting the sodium
fluorescein powder in buffer, it takes time for the powder to completely dissolve. Allow
the solution to dissolve for five minutes, with intermittent vortexing, before preparing the
titration dyes. Wrap the vial containing the stock solution in foil to prevent exposure to
light. Discard unused solution after seven days. Discard any open, unused buffer solution
after seven days.
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1. The Sodium Borate solution does not require further preparation; proceed to step 2. If
you are using PBS, prepare the solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of deionized
or distilled water.

l Follow the manufacturer’s instructions on the PBS packaging to create 200 mL,
dissolving the necessary amount of PBS into the filtered water.

l Stir the solution (preferably using a stir table) until the PBS is completely
dissolved.

l Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the sodium fluorescein stock solution:

l Add 2.0 mL of the buffer solution to the 1 mg Sodium Fluorescein (SF) vial. This
yields a 1.3288 mM stock solution.

l Make sure the dye has completely dissolved and is well mixed.

3. Carefully prepare the dilutions. Label each with “SF” and the concentration:

Mix This SF Solution: With
Buffer:

To
Make:

0.53 mL of 1.3288 mM stock
solution

13.47 mL 50.2 μM

110 µL of 50.2 μM SF 13.89 mL 400 nM

3.5 mL of 400 nM SF 10.5 mL 100 nM

0.46 mL of 100 nM SF 13.54 mL 3.3 nM Corners Test

4.24 mL of 3.3 nM SF 9.76 mL 1 nM Sensitivity & Linearity
Tests

Fluorescence Polarization (FP) Test
As described in Fluorescence Polarization (FP) Test Materials on page 152, the
recommended test solutions are available from Invitrogen Corporation or from BioTek. They
do not require additional preparation.

Time-Resolved Fluorescence (TRF) Test
As described in Time-Resolved Fluorescence (TRF) Test Materials on the previous page, the
recommended test solutions are available from Invitrogen Corporation or from BioTek.

l Shake the FluoSpheres container vigorously for 30 seconds prior to pipetting.
Alternatively, sonicate or vortex the container.
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l Mix 10 µL of FluoSpheres with 10 mL of deionized water, in a 15 mL conical-bottom,
polypropylene sample tube. This yields a 20 nM equivalent suspension.

l Shake the vial vigorously for 30 seconds prior to pipetting. Alternatively, sonicate or
vortex the container.

l Mix 10 µL of 20 nM suspension with 10 mL of deionized water, in a 15 mL conical-bottom,
polypropylene sample tube. This yields a 20 pM equivalent suspension.

l Refrigerate any unused portions of the FluoSpheres. The temperature must be between
+2°C to +6°C.

Note: The prepared TRF plate can be kept for a maximum of seven days, if covered and
stored in the dark between +2°C to +6°C.

Note: Allow the plate to sit at room temperature for approximately 15 minutes prior to
use.

Fluorescence Test Procedure

1. If you have not already done so, create the Gen5 protocols as described starting on
page 143.

2. If you have not already done so, prepare the solutions for the tests you plan to perform.
Required Materials on page 141.

Note: Refer to the pipette maps starting on page 156 for the remaining steps.

3. Perform the Corners/Sensitivity/Linearity tests using the Top optics of the filter-based
fluorescence system:

l Pipette the test solutions into a clean 96-well microplate.

l Create an experiment based on Cytation 5_FI_T_SF.prt.

l Read the plate, and then save the experiment.

4. Perform the Corners/Sensitivity/Linearity tests for the monochromator-based
fluorescence system:

l Create experiments based on Cytation 5_M_FI_T_SF.prt (top optics) and
Cytation 5_M_FI_B_SF.prt (bottom optics).

l Read the plate, and then save the experiment

5. To test Fluorescence Polarization capability:

l Pipette the solutions for the “FP” test into the same plate as used in step 3.

l Create an experiment based on Cytation 5_FP.prt.

l Read the plate, and then save the experiment.

6. To test the Time-Resolved Fluorescence capability:
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l Pipette the solutions for the “TRF” test into a new 96-well solid white plate.

l Create an experiment based on Cytation 5_TRF.prt.

l Read the plate and then save the experiment.

7. Calculate and evaluate results as described under Results Analysis.

Pipette Maps

Important: Seal the plates with foil or store them in black polyethylene bags until use.
When using a clear-bottom plate, if the base of the plate is touched, clean the entire base
with alcohol (95% ethanol) and then wipe with a lint-free cloth. Before placing the plate in
the instrument, blow the bottom of the plate with an aerosol duster.

Perform these steps carefully, referring to the plate maps provided.

Corners, Sensitivity, Linearity Test
For the Corners test (light gray wells):

l Pipette 200 μL of the 3.3 nM SF solution into wells A1–A3, A10–A12, H1–H3, and H10–
H12.

l If using a Hellma plate: Pipette 200 μL of buffer into the wells surrounding the 3.3 nM
wells ("CBUF" in the grid).

For the Sensitivity test (dark gray wells):

l Pipette 200 μL of the 1 nM SF solution into well D7.

l Pipette 200 μL of the buffer solution into wells C9, D9, and E9.

For the Linearity test (wells C1–F5):

l Use a multichannel pipette with just four tips installed.

l Pipette 150 μL of buffer solution into wells C2–F5. Discard the tips.

l Pipette 150 μL of the 1 nM SF solution into wells C1–F1.

l Pipette 150 μL of the 1 nM SF solution into wells C2–F2. Mix the wells using the pipette.
Do not discard the tips.

l Aspirate 150 μL from wells C2–F2, and dispense into wells C3–F3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from wells C3–F3, and dispense into wells C4–F4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from wells C4–F4, and dispense into wells C5–F5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 μL from wells C5–F5, and discard the tips.
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Fluorescence Polarization (FP) Test
l Pipette 200 µL of the (green) polarization buffer (BUF) into wells A6–H6.

l Pipette 200 µL of the green high polarization reference (HPR) into wells A7–B7.

l Pipette 200 µL of the green low polarization reference (LPR) into wells A8–H8.

1 2 3 4 5 6 7 8 9 10 11 12

A BUF HPR LPR

B BUF HPR LPR

C BUF LPR

D BUF LPR

E BUF LPR

F BUF LPR

G BUF LPR

H BUF LPR

Time-Resolved Fluorescence (TRF) Test
l Pipette 200 µL of deionized water into wells A6–C6.

l If you have not already done so, shake the vial of 20 pM europium suspension vigorously

BioTek Instruments, Inc.



158 | Chapter 7: Instrument Qualification

for 30 seconds prior to pipetting. Alternatively, sonicate or vortex the vial.

l Pipette 200 µL of the 20 pM europium suspension (Eu) into well A8.

1 2 3 4 5 6 7 8 9 10 11 12

A DI Eu

B DI

C DI

D

E

F

G

H

Results Analysis

Corners Test
1. Calculate the Mean of the 12 wells containing the 3.3 nM SF test solution (A1–A3, A10–

A12, H1–H3, and H10–H12).

2. Calculate the Standard Deviation for the same 12 wells.

3. Calculate the %CV: (Standard Deviation / Mean) * 100

The %CV must be < 3.0 to pass.

Sensitivity Test
1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer wells

(C9, D9, E9).

2. Among the three buffer wells, find the Median Standard Deviation and corresponding
Mean.

3. Calculate the Mean for the 16 reads of the SF Concentration well (D7).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean SF Concentration, Buffer
Median STD with its corresponding Buffer Mean:
(SF Mean – Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in pM, using the known concentration value of SF and the
Calculated SNR: 1000/SNR

Filter-Based Fluorescence System

Optic Probe To pass, the Detection Limit
must be less than or equal to:

Top 10 pM
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Monochromator-Based Fluorescence System

Optic Probe To pass, the Detection Limit
must be less than or equal to:

EX 485 nm, EM 528 nm Top/Bottom: 20 pM

Linearity Test
1. Calculate the Mean of the four wells for each concentration in columns 1–5.

2. Perform linear regression using these values as inputs:

Filter- and Monochromator-Based
Fluorescence System

x y

1000 Mean of the 1000 pM wells

500 Mean of the 500 pM wells

250 Mean of the 250 pM wells

125 Mean of the 125 pM wells

62.5 Mean of the 62.5 pM wells

3. Calculate the R-Square value; it must be >= 0.9500 to pass.

Fluorescence Polarization (FP) Test
1. Using the raw data from the Parallel read:

l Calculate the Mean Blank (wells A6–H6).

l Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

l Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

2. Using the raw data from the Perpendicular red:

l Calculate the Mean Blank (wells A6–H6)

l Calculate the Signal for each HPR well: Subtract the Mean Blank from its
measurement value.

l Calculate the Signal for each LPR well: Subtract the Mean Blank from its
measurement value.

3. Calculate the G-Factor for each LPR well:
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(Parallel LPR Sign * (1–0.02)) / (Perpendicular LPR Signal *
(1+0.02))

4. Calculate the Mean G-Factor.

5. Calculate the Polarization value in mP for each HPR well (“PLPR”):

Parallel HPR Signal – Mean G-Factor * Perpendicular HPR Signal *
1000

Parallel HPR Signal + Mean G-Factor * Perpendicular HPR Signal

6. Calculate the Mean PHPR, in mP.

Optic Probe To pass, the Mean PHPR
must be greater than:

Top, with 510 nm dichroic mirror 340 mP

7. Calculate the Polarization value in mP for each LPR well (“PLPR”):

Parallel LPR Signal – Mean G-Factor * Perpendicular LPR Signal *
1000

Parallel LPR Signal + Mean G-Factor * Perpendicular LPR Signal

8. Calculate the Standard Deviation of the “PLPR,” in mP.

Optic Probe To pass, the Standard Deviation
of the PLPR must be less than:

Top, with 510 nm dichroic mirror 5

Time-Resolved Fluorescence (TRF) Test
1. Calculate the Mean and Standard Deviation of the 16 reads for each of the buffer wells

(A6, B6, C6).

2. Among the three buffer wells, find the Median Standard Deviation and corresponding
Mean.

3. Calculate the Mean for the 16 reads of the Eu Concentration well (A8).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean Eu Concentration and Buffer
Median STD with its corresponding Buffer Mean:
(Eu Mean – Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in fM:
20000 / ((Mean Eu – Mean DI water) / (3 * Standard Deviation DI water))

Optic Probe To pass, the Detection Limit
must be less than or equal to:

Top, with 400 nm dichroic mirror 250 fM
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Troubleshooting Fluorescence Liquid Tests

If any tests fail, please try the following suggestions. If the test(s) continue to fail,
print the results and contact Technical Support.

l Are the solutions fresh? Discard the plate and any open, unused test solutions after
seven days.

l Are the excitation/emission filters clean? Are they in the proper locations and in the
proper orientation in the filter cube?

l If the Corners Test continues to fail, the hardware may be misaligned.

l Are you using new/clean plates? If the base of a clear-bottom plate is touched, clean the
entire base with alcohol (95% ethanol) and then wipe with a lint-free cloth. Before
placing the plate in the instrument, blow the bottom of the plate with an aerosol duster.
If the test fails again, the optical probe(s) may need to be cleaned.

l Review the pipetting instructions to verify the plate was correctly prepared: Pipette Maps
on page 156.

l Does the Plate Type setting in the Gen5 protocol match the plate you used?

l For injector models, spilled fluid inside the reader may be fluorescing, which can corrupt
your test results.

l When testing Fluorescence Polarization capability using a solid black plastic microplate, if
the standard deviation for the buffer wells is too high, try moving the buffer wells to
another column. With some black plastic plates, the wells in the center of the plate may
be slightly distorted due to the plate molding process, and this can affect the standard
deviation.

l The Read steps in the protocols use the Gen5 Automatic Gain Adjustment feature to
determine optimum sensitivity values for the plate. If an Auto Gain Result value is
outside the range of 30–200, this may indicate a problem.

If the value is less than 30:

n The stock solution/dilution concentrations may be too high. Try creating fresh
solutions/dilutions, and rerun the test using a new, clean plate.

n If all of the tests are passing but the Gain value is low, a PMT in your reader may
just be very sensitive.

If the value is greater than 200:

n The stock solution/dilution concentrations may be too low. Try creating fresh
solutions/dilutions, and rerun the test using a new, clean plate.

n For injector models, spilled fluid inside the reader may be fluorescing, which can
corrupt your test results.

n The PMTs or optical path(s) may be deteriorating, or the optics or other
hardware may be misaligned.
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Fluorescence Test Procedure (Methylumbelliferone)

As an alternative to using Sodium Fluorescein, Methylumbelliferone (“MUB”) can be used to
test the top optics.

Required Materials

Note: BioTek offers a liquid test kit (PN 7160012) containing the microplates and
solutions used in the MUB fluorescence liquid test.

Important: Use perfectly clean microplates, free of dust or bottom scratches, e.g., new
microplates from sealed packages.

Note: Manufacturer part numbers are subject to change over time.

l Methylumbelliferone (“MUB”) (10-mg vial, BioTek PN 98156)

l Carbonate-Bicarbonate buffer (“CBB”) capsules (BioTek PN 98158)

l 100% methanol (BioTek PN 98161)

l A new, clean 96-well solid black plate microplate, such as Corning Costar #3915 or
equivalent.

l Excitation filter 360/40 nm installed

l Emission filter 460/40 nm installed

l 400 nm dichroic mirror installed

l Deionized or distilled water

l Various beakers, graduated cylinders, and pipettes

l Aluminum foil

l (Optional, but recommended) 0.45-micron filter

l Gen5 protocols (as described on page 165):

n Cytation 5_FI_T_MUB.prt tests filter-based fluorescence performance.

n Cytation 5_M_FI_T_MUB.prt tests monochromator-based fluorescence
performance.

Test Solutions

1. Prepare the buffer (CBB) solution:

l (Optional, but recommended) Using a 0.45-micron filter, filter 200 mL of deionized
or distilled water.

l Open and dissolve the contents of two CBB capsules (do not dissolve the outer
gelatin capsule) into 200 mL of the water.
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l Stir the solution (preferably using a stir table) until the CBB is completely
dissolved.

2. Prepare the MUB stock solution:

l Add 1 mL of 100% methanol to the 10 mg vial of MUB.

l Make sure all of the dye has completely dissolved and is well mixed. This yields a
10 mg/mL stock solution.

l Wrap the solution in aluminum foil to prevent exposure to light.

3. Prepare the dilutions. Label each with “MUB” and the concentration.

Mix This MUB Solution: With: To Make:

0.5 mL of 10 mg/mL stock solution 4.5 mL of 100% methanol 1 mg/mL

0.88 mL of 1 mg/mL solution 4.12 mL of CBB 176 μg/mL

0.1 mL of 176 μg /mL solution 9.9 mL of CBB 1.76 μg /mL

0.5 mL of 1.76 μg /mL solution 4.5 mL of CBB 176 ng/mL

1 mL of 176 ng/mL solution 9 mL of CBB 17.6 ng/mL
(100 nM)

Procedure

1. If you have not already done so, create the Gen5 protocols on page 165.
2. If you have not already done so, prepare the test solutions.

3. Perform the Sensitivity/Linearity tests using the Top filter-based optics:

l Refer to the pipette map in the next section and pipette the solutions into a clean,
96-well solid black plate.

l Create a Gen5 experiment based on Cytation 5_FI_T_MUB.prt.

l Read the plate, and then save the experiment.

4. Perform the Sensitivity/Linearity tests for the Topmonochromator-based fluorescence
system:

l Create a Gen5 experiment based on Cytation 5_M_FI_T_MUB.prt.

l Read the plate, and then save the experiment.

5. Calculate and evaluate the results as described under Results Analysis, starting on page
163.

Results Analysis

Sensitivity Test

1. Calculate the Mean and Standard Deviation for the 16 reads for each of the buffer wells
(C9, D9, E9).
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2. Among the three buffer wells, find the Median Standard Deviation and corresponding
Mean.

3. Calculate the Mean for the 16 reads of the MUB concentration well (D7).

4. Calculate the Signal-to-Noise Ratio (SNR) using the Mean MUB Concentration and Buffer
Median STD with its corresponding Buffer Mean:
(Mean MUB – Buffer Mean)/(3 * Buffer STD)

5. Calculate the Detection Limit, in ng/mL, using the known concentration value of MUB
and the calculated SNR: 17.6/SNR

Filter-Based Fluorescence System

Optic Probe To pass, the Detection Limit
must be less than or equal to:

Top, with 400 nm dichroic mirror 0.16 ng/mL (0.91 nM)

Monochromator-Based Fluorescence System

Optic Probe To pass, the Detection Limit must be
less than or equal to:

Top 0.16 ng/mL (0.91 nM)

Linearity Test

1. Calculate the Mean of the four wells for each concentration in columns 1–5.

2. Perform linear regression using these values as inputs:

Filter- and Monochromator-Based Fluorescence Systems

x y

100 Mean of the 100 nM wells

50 Mean of the 50 nM wells

25 Mean of the 25 nM wells

12.5 Mean of the 12.5 nM wells

6.25 Mean of the 6.25 nM wells

3. Calculate the R-Square value; it must be ≥ 0.9500 to pass.

Pipette Map
Perform these steps carefully and refer to the grid below:

For the Sensitivity test (dark gray wells):

l Pipette 200 µL of CBB buffer into wells C9, D9, and E9.

l Pipette 200 µL of the 17.6 ng/mL (100 nM) MUB solution into well D7.

For the Linearity test (wells C1–F5):
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l Use a multi-channel pipette with just four tips installed.

l Pipette 150 µL of buffer into wells C2–F5. Discard the tips.

l Pipette 150 µL of the 17.6 ng/mL (100 nM) solution into wells C1–F1. Discard the tips.

l Pipette 150 µL of the 17.6 ng/mL (100 nM) solution into wells C2–F2. Mix the wells using
the pipette. Do not discard the tips.

l Aspirate 150 µL from wells C2–F2 and dispense into wells C3–F3. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 µL from wells C3–F3 and dispense into C4–F4. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 µL from wells C4–F4 and dispense into wells C5–F5. Mix the wells using the
pipette. Do not discard the tips.

l Aspirate 150 µL from wells C5–F5. Discard the tips.

Gen5 Protocol Reading Parameters
The following tables list the recommended reading parameters. Your tests may require
modifications to some of these parameters, such as the Plate Type or Sensitivity value. (
Troubleshooting Fluorescence Liquid Tests on page 161).

Important: Make sure the Plate Type setting in the Gen5 protocol matches the
microplate you are using.
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Cytation 5_FI_T_MUB.prt

Parameter Default Setting

Detection Method: Fluorescence

Read Type: Endpoint

Plate Type: Costar 96-well black opaque

Read Step 1

Kinetic Loop: Run Time: 00:00:45
Interval: 00:00:03
Reads: 16

Step Label: "Sensitivity Read"

Read Well: D7

Filter Sets: 1 (Blue)

Filters: EX 360/40 nm, EM 460/40 nm

Optics Position: Top 400 nm

Gain: Auto, Scale to High Wells, D7, 80000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 2

Kinetic Loop: Run Time: 00:01:35
Interval: 00:00:06
Reads: 16
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Parameter Default Setting

Step Label: "Sensitivity Read Buffer"

Read Well: C9..E9

Filter Sets: 1 (Blue)

Filters: EX 360/40 nm, EM 460/40 nm

Optics Position: Top 400 nm

Gain: Auto, Use first filter set gain from FIRST Read Step

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 3

Step Label: "Linearity Read"

Read Well: C1..F5

Filter Sets: 1 (Blue)

Filters: EX 360/40 nm, EM 460/40 nm

Optics Position: Top 400 nm

Gain: Auto, Scale to High Wells, C1, 80000

Read Speed: Normal
Delay after plate movement: 350 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm
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Cytation 5_M_FI_T_MUB.prt

Parameter Default Setting

Detection Method: Fluorescence

Read Type: Endpoint

Plate Type: Costar 96-well black opaque

Read Step 1

Kinetic Loop: Run Time: 00:00:45
Interval: 00:00:03
Reads: 16

Step Label: "Sensitivity Read"

Read Well: D7

Wavelengths: EX 360/14 nm, EM 460/14 nm

Optics Position: Top

Gain: Auto, Scale to High Wells, D7, 80000

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 2

Kinetic Loop: Run Time: 00:01:35
Interval: 00:00:06
Reads: 16

Step Label: "Sensitivity Read Buffer"
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Parameter Default Setting

Read Well: C9..E9

Filter Sets: 1 (Blue)

Wavelengths EX 360/14 nm, EM 460/14 nm

Optics Position: Top 400 nm

Gain: Auto, Use first filter set gain from FIRST Read Step

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 3

Step Label: "Linearity Read"

Read Well: C1..F5

Filter Sets: 1 (Blue)

Wavelengths: EX 360/14 nm, EM 460/14 nm

Optics Position: Top 400 nm

Gain: Auto, Scale to High Wells, C1, 80000

Read Speed: Normal
Delay after plate movement: 100 msec
Measurements per data point: 50
Lamp Energy: Low
Dynamic Range: Standard

Read Height: 7.00 mm

BioTek Instruments, Inc.



170 | Chapter 7: Instrument Qualification

Luminescence Test

For models with luminescence capability, BioTek uses the Harta Luminometer Reference
Microplate to test the luminescence system. The test plate is LED-based and NIST-
traceable. Contact BioTek to purchase a plate (PN 8030015; includes microplate carrier
adapters).

Prerequisite

Before using the Cytation 5 F-LumTest_Harta.prt protocol described in this section, create
the filter set shown below:

Harta Plate Test

Materials

l Harta Luminometer Reference Microplate, PN 8030015

l Harta Plate Adapter, PN 1222205

l Filter cube PN 8040553, LUM Filter Block or a filter cube with a plug in EX position 1 or 2
and a hole in the corresponding EM position

l Default filter cube PN 8040583, LUM-Green Filter Block or a filter cube with a plug in
EX position 1 or 2 and a hole in the corresponding EM position

l Gen5 Luminescence Test Protocol Parameters on page 173
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Procedure

1. Turn on the Harta reference plate using the I/O switch on the back of the plate.

2. Check the plate’s battery by pressing the test button on the back of the plate and
ensuring that the test light turns on.

Note: The test light may be difficult to see in bright light. Change your angle of view or
move to a darker environment if you cannot see it.

3. Place the Harta plate adapter on the reader’s carrier, then place the test plate on top of
the adapter.

4. Create an experiment based on the Cytation 5 F-LumTest_Harta.prt or
Cytation 5 M-LumTest_Harta.prt protocol and read the plate.

Note: The read starts with a three-minute delay.

5. Calculate and evaluate results as described under Results Analysis below.

Note: Be sure to turn off the Harta plate when you are finished with the test to preserve
battery life.

Plate Layout

Cytation 5 F-LumTest_Harta.prt

1 2 3 4 5 6 7 8 9 10 11 12

A A2
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battery
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D BUF BUF BUF BUF

E BUF BUF BUF BUF

F BUF BUF BUF BUF

G BUF BUF BUF BUF
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Cytation 5 M-LumTest_Harta.prt

1 2 3 4 5 6 7 8 9 10 11 12
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Results Analysis

Important: Through a manual correlation process, it was found that the system requires
approximately 35 photons per attomole of ATP, thus a conversion factor of 0.02884
attomole/photon was applied to determine ATP concentration from the NIST data in
photons/s.

1. On the Harta plate’s Calibration Certificate, locate the NIST measurement for the A2
position and convert it to attomoles:
(A2 NIST measurement * 0.02884)

2. Determine if the plate’s battery is still functioning properly:

l If A8 > (0.2 * A7), the battery is good. Otherwise, it requires replacement.

Note: A replacement battery is included with each Harta plate. A new spare battery
will be supplied when the plate is recertified.

3. Calculate the signal-to-noise ratio:
(A2 – Mean of the buffer cells)/(3 * Standard deviation of buffer cells)

4. Calculate the detection limit:
A2 NIST measurement in attomoles/signal-to-noise ratio

n If the reader is equipped with the low-noise PMT, the detection limit must be <=
75 amol to pass.

n If the reader is equipped with the red-shifted PMT, the detection limit must be
<= 500 amol to pass.
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To determine which PMT is installed, in Gen5, select
System>Instrument Configuration>View/Modify>Instrument Settings in
the Reader Settings window.

Gen5 Luminescence Test Protocol Parameters

Protocol reading parameters for luminescence testing:

Cytation 5 F-LumTest_Harta.prt

Parameter Setting

Plate Type: 8030015 Harta - w/o 8032028 adapter

Delay Step: 3 minutes

Read Step 1

Detection Method: Luminescence

Read Type: Endpoint

Step Label: "Reference well A2"

Read Wells: A2

Filter Sets: 1 (open)

Excitation: Plug

Emission: Hole

Gain: 135

Integration Time: 0:10.00 MM:SS.ss

Delay after plate movement: 350 msec

Dynamic Range: Standard

Read Height: 7.00 mm
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Parameter Setting

Read Step 2

Detection Method: Luminescence

Read Type: Endpoint

Step Label: "Background"

Read Wells: D1..G4

Filter Sets: 1 (Open)

Excitation: Plug

Emission: Hole

Gain: 135

Integration Time: 0:10.00 MM:SS.ss

Delay after plate movement: 350 msec

Dynamic Range: Standard

Read Height: 7.00 mm

Read Step 3

Detection Method: Luminescence

Read Type: Endpoint

Step Label: "Battery Check"

Read Wells: A7–A8

Filter Sets: 1 (Open)

Excitation: Plug
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Parameter Setting

Emission: Hole

Gain: 60

Integration Time: 0:01.00 MM:SS.ss

Delay after plate movement: 350 msec

Dynamic Range: Extended

Read Height: 10. 00 mm

Cytation 5 M-LumTest_Harta.prt

Parameter Default Setting

Plate Type: 8030015 Harta - w/o 8032028 adapter

Delay Step: 3 minutes

Read Step 1

Detection Method: Luminescence

Read Type: Endpoint

Step Label: "Reference well A2"

Read Well: A2

Wavelength 1

Gain: 150

Integration Time: 0:10.00 MM:SS.ss

Delay after plate movement: 350 msec

Dynamic Range: Standard

BioTek Instruments, Inc.



176 | Chapter 7: Instrument Qualification

Parameter Default Setting

Read Height: 1.00 mm

Read Step 2

Detection Method: Luminescence

Read Type: Endpoint

Step Label: "Background"

Read Wells: F1..G12

Wavelength 1

Gain: 150

Integration Time: 0:10.00 MM:SS.ss

Delay after plate movement: 350 msec

Dynamic Range: Standard

Read Height: 1.00 mm

Read Step 3

Detection Method: Luminescence

Read Type: Endpoint

Step Label: "Battery Check"

Read Wells: A7–A8

Wavelength 1

Gain: 80

Integration Time: 0:01.00 MM:SS.ss
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Parameter Default Setting

Delay after plate movement: 350 msec

Dynamic Range: Extended

Read Height: 1.00 mm

Luminescence Troubleshooting

If the test fails, try the following suggestions. If the test continues to fail, print the results
and contact Technical Support.

l Ensure that the reading is performed through a hole in the filter cube, not through a glass
filter.

l Verify that the filter cube settings in Gen5 match the physical cube.

l Make sure the Harta test plate is present and positioned correctly on the carrier.

l Make sure the test plate adapter is present.

l If the test continues to fail, the optical probe(s) may need to be cleaned. Contact
Technical Support for instructions.
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Alpha Detection Test

This section applies only to models with the alpha module.

The alpha laser has been factory-calibrated to meet specification. BioTek Instruments, Inc.,
has developed a test protocol that can be used with AlphaScreen™ TruHits™ Kit, available
from PerkinElmer (Mfg. #6760627), to verify the functionality of the alpha laser system.
Because the detector for the alpha system is functionally and optically identical to the
luminescence system, the luminescence test may be used to verify detector functionality.

The Crosstalk test is a measure of how well the optical system can distinguish the signals
emitted from the well being read from those of any adjacent well. This test also determines
the signal-to-noise ratio (SNR) of the test plate and verifies that the signal is at an
acceptable level for the sample material used. The test is designed for use with AlphaScreen
TruHits, and it is assumed that 96-well plates are used with 100 µL well volumes.

After pipetting the solutions into the microplate, allow the plate to sit at room
temperature for 15 minutes before starting the experiment. Cover the plate to prevent any
light from hitting the beads.

Required Materials

Note: Manufacturer part numbers are subject to change over time.

l Recommended test solution, AlphaScreen TruHits Kit, available from PerkinElmer (Mfg.
#6760627)

l Buffer: Phosphate-Buffered Saline (PBS), pH 7.2–7.6 (e.g., Sigma tablets, Mfg. #P4417
or equivalent)

l Clean 96-well solid white microplate

l 1.5-mL conical-bottom, polypropylene sample tube

l Alpha filter cube

l Gen5 protocol on page 181

Test Solutions

Note: AlphaScreen beads are light sensitive. All tests should be performed under
subdued laboratory lighting of less than 100 lux.
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1. Prepare the PBS buffer solution:

a. (Optional, but recommended) Use a 0.45-micron filter to filter 200 mL of
deionized or distilled water.

b. Follow the manufacturer's instructions on the PBS packaging to create 200 mL,
dissolving the necessary amount of PBS into the filtered water.

c. Stir the solution (preferably using a stir table) until the PBS is completely
dissolved.

d. Check the pH; it should be between 7.2 and 7.6 at 25°C.

2. Prepare the TruHits bead suspension:

a. Shake the container of TruHits bead suspension vigorously for 30 seconds prior
to pipetting. Alternatively, sonicate or vortex the container.

b. Pipette the Donor and Acceptor beads into the bottom of a 1.5 mL conical-
bottom, polypropylene sample tube
l Donor beads 8 µL
l Acceptor beads 8 µL

c. Replace the tube cap and cover the tube with foil.

d. Incubate for 15 minutes at room temperature.

e. Add diluent to a final volume of 1 mL.
l PBS 984 µL

f. Replace the tube cap and cover the tube with foil.

g. Incubate for 15 minutes at room temperature.

h. This yields a TruHits bead suspension that is 20 µg/mL with respect to the
Acceptor beads.

i. Discard the remaining bead solution.

j. If extra beads have been reacted, they can be stored for later use. For storage,
refrigerate any unused portions of the TruHits bead suspension. The
temperature must be between +2°C and +6°C.

Note: Do NOT use sodium azide as a preservative as it will affect the AlphaScreen signal.
Procline™ 300 at 0.03% is suggested.
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Pipette Map
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Procedure

Crosstalk Test
1. Pipette 100 µL of PBS in wells A1–A12, B1, B3–B4, B6–B7, B9–B10, B12, C1–C12, and

G1–H12 (see pipette map, “BUF“ wells).

2. Pipette 100 µL of 20 µg/mL AlphaScreen beads suspension into wells B2, B5, B8, and
B11 (see pipette map, “20 µg/mL OMB” wells).

Note: Allow the plate to sit at room temperature for approximately 15 minutes prior to
use.

3. Create an experiment based on the Cytation 5 AlphaTest_Crosstalk.prt protocol. Read
the plate, and then save the experiment.

4. Open the Plate menu and export the data to the embedded Power Export spreadsheet.
The spreadsheet reports pass or fail for the test performed. See Results Analysis, next,
for descriptions of the calculations and troubleshooting tips.

5. Print the spreadsheets and store them with your test records.

Results Analysis

1. Calculate the crosstalk for each of the four wells of AlphaScreen beads solution by
dividing the background-subtracted Mean value of the surrounding adjacent wells by
the background-subtracted AlphaScreen beads suspension well.
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2. Average the % crosstalk of the four test wells to determine level of crosstalk (Crosstalk
Mean).

3. Verify that the % crosstalk is less than or equal to 0.1%

4. Calculate the signal-to-noise ratio (SNR) by using the following equation:
SNR = (signal mean – background mean)/(SQRT(signal STD² + background
STD²))

5. Verify that SNR is greater than or equal to 10.

Troubleshooting Alpha Tests

If the test fails, please try the following suggestions. If the test(s) continue to fail, print the
results and contact Technical Support.

l Are the solutions fresh?
l Have the solutions been stored properly (between +2°C and +6°C)?
l Has the kit been exposed to excessive light (in excess of 100 lux)?
l If the Crosstalk test continues to fail, the laser may not be firing. Contact Technical
Support.

Gen5 Protocol Reading Parameters

The information in the following table represents the recommended reading parameters. It
is possible that your tests will require modifications to some of these parameters, such as
Plate Type or Gain value (see Troubleshooting Tips above).

Note: The Plate Type setting in the Gen5 protocol should match the plate you are actually
using.

Cytation 5 AlphaTest_Crosstalk.prt
This procedure contains one read step and calculates crosstalk based on the full plate data.

Parameter Default Setting

Plate Type Costar 96-well white opaque

Detection Method Alpha

Read Type Endpoint

Read Wells Full plate

Gain 120
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Parameter Default Setting

Delay after plate
movement

0 msec

Excitation time 100 msec

Delay after excitation 120 msec

Integration time 100 msec

Read height 7.00 mm
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Dispense Module Qualification Tests

This section applies only to instruments with the dispenser.

BioTek provides qualification tests to ensure that the dispense module performs to
specification initially and over time. We recommend performing these tests before first use,
and then every three months.

l The Accuracy Test is a measure of the mean volume per well for multiple dispenses. The
actual weight of the dispensed fluid is compared to the expected weight and must be
within a certain percentage to pass. Pass/Fail criteria depend on the per-well volume
dispensed: 2.0% for 80 µL, 5.0% for 20 µL, and 20.0% for 5 µL. It is assumed that one
gram is equal to one milliliter.

The test uses a single green dye test solution and a 96-well microplate (per injector) to
test the three different volumes. The balance is tared with the empty plate, and then
the 80 µL dispense is performed for columns 1–4. The fluid is weighed and the balance
is tared again (with the plate on the balance). This process is repeated for the 20 µL
and 5 µL dispenses. It is assumed that the solutions used are at room temperature. A
precision balance (three-place) is used to weigh the plate.

l The Precision Test is a measure of the variation among volumes dispensed to multiple
wells. For each volume dispensed (80 µL, 20 µL, and 5 µL) to four columns, the %CV
(coefficient of variation) of 32 absorbance readings is calculated. Pass/Fail criteria depend
on the per-well volume dispensed: 2.0% for 80 µL, 7.0% for 20 µL, and 10.0% for 5 µL.
The plate is read in an absorbance reader at 405/750 nm for columns 1–4 and at 630/750
nm for columns 5–12.

The two tests are performed simultaneously and use the same plate.

Required Materials

Note: Manufacturer part numbers are subject to change over time.

l Absorbance reader with capability of reading at 405, 630, and 750 nm. The reader must
have an accuracy specification of ± 1.0% ± 0.010 OD or better and a repeatability
specification of ± 1.0% ± 0.005 OD or better.

Note: The Cytation 5 may be used if it is equipped with Absorbance capabilities and
has passed the Absorbance Plate Test or Absorbance Liquid Test 1.

l Microplate shaker (if the absorbance reader does not support shaking)

l Precision balance with capacity of 100 g minimum and readability of 0.001 g

l 50–200 µL hand pipette and disposable tips

l Deionized water

l Supply bottles

l 250-mL beaker
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l New 96-well, clear, flat-bottom microplates

l BioTek’s Green Test Dye Solution (PN 7773003) undiluted, or one of the alternate test
solutions listed in the next section

l 100-mL graduated cylinder and 10-mL pipettes (if not using BioTek’s Green Test Dye
Solution)

l Gen5 software installed on the host PC

l Gen5 protocols as defined by the procedure beginning on page 189

Alternate Test Solutions

Note: 80 µL of test solution with 150 µL of deionized water should read between 1.300
and 1.700 OD at 405/750 nm. The solutions should be at room temperature.

If you do not have BioTek’s Green Test Dye Solution (PN 7773003), prepare a dye solution
using one of the following methods:

Using BioTek’s Blue and Yellow Concentrate Dye Solutions:

Ingredient Quantity

Concentrate Blue Dye Solution
(PN 7773001, 125 mL) 4.0 mL

QC (Yellow) Solution (PN
7120782, 125 mL) 5.0 mL

Deionized water 90.0 mL

Using FD&C Blue and Yellow Dye Powder:

Ingredient Quantity

FD&C Blue No. 1 0.200 grams

FD&C Yellow No. 5 0.092 grams

Tween 20 1.0 mL

Sodium Azide N3Na 0.100 gram

Deionized water Make to 1 liter
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Procedure for Models with Absorbance Capabilities

Note: If you have not already done so, create Gen5 protocols Cytation 5 Disp 1 Test.prt
and Cytation 5 Disp 2 Test.prt. Instructions begin on page 189.

1. Prime both dispensers with 4000 µL of deionized or distilled water.

2. Purge both dispensers with the Volume set to 2000 µL. This prevents the water from
diluting the dye. Remove the inlet tubes from the supply bottles.

3. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers with
2000 µL of the solution. When finished, remove the priming plate from the carrier.

4. In Gen5, create an experiment based on Cytation 5 Disp 1 Test.prt.

5. Place a new 96-well microplate on the balance and tare the balance.

6. Place the plate on the microplate carrier.

Important: Running a dispense procedure without placing a plate in the reader will
result in contamination of the reader from spilled liquid.

Note: When each dispense step is finished, you will weigh the plate, record the
weight, tare the balance with the plate on it, and then place the plate back on the
carrier for the next step.

7. Select Plate > Read and click READ. Gen5 prompts you to empty the tip priming
trough.

8. When ready, click OK at the Load Plate dialog to begin the experiment. The sequence is
as follows:

a. Dispense 80 µL/well to columns 1–4.

b. Remove the plate and weigh it. Record the weight and tare the balance.

c. Place the plate on the carrier and dispense 20 µL/well to columns 5–8.

d. Remove the plate and weigh it. Record the weight and tare the balance.

e. Place the plate on the carrier and dispense 5 µL/well to columns 9–12.

f. Remove the plate and weigh it. Record the weight.

g. Manually pipette 150 µL of deionized or distilled water into all 12 columns, on top
of the green test dye solution.

h. Place the plate on the carrier for a 15-second shake, the “80 µL” read at 405/750
nm, and the “20 and 5 µL” read at 630/750 nm.

9. When processing is complete, select File > Save As. Enter an identifying file name and
click Save.

10. Remove the plate from the carrier and set it aside.

11. Repeat steps 4–9 using Cytation 5 Disp 2 Test.prt.
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12. See instructions for analyzing the results on page 186.

Important: Running a dispense procedure without placing a plate in the reader will
result in contamination of the reader from spilled liquid.

Note: When all tests are complete, prime both dispensers with at least 5000 µL of
deionized water to flush out the green dye solution.

Results Analysis

Note: For your convenience, worksheets are included at the end of this chapter for
recording the dispense weights, Delta OD values, calculations, and pass/fail.

The pass/fail criteria for each set of 32 wells with the same dispense volume is based on the
calculated coefficient of variation (% CV) and Accuracy % Error.

For each volume dispensed (80 µL, 20 µL, 5 µL), for each dispenser (1, 2):

l Calculate the Standard Deviation of the 32 wells

l Calculate the Mean of the 32 wells

l Calculate the %CV: (Standard Deviation / Mean) x 100

l Calculate the Accuracy % Error:
((Actual Weight – Expected Weight)/Expected Weight)* 100

Note: Expected Weights for 32 wells: 80 µL (2.560 g), 20 µL (0.640 g), 5 µL (0.160 g). It
is assumed that one gram is equal to one milliliter.

Dispense Volume To pass, %CV must be To pass, Accuracy % 
Error must be:

80 µL ≤ 2.0% ≤ 2.0%

20 µL ≤ 7.0% ≤ 5.0%

5 µL ≤ 10.0% ≤ 20.0%

Procedure for Models without Absorbance Capabilities

The Product Qualification package contains Gen5 protocols for use with this test. When
running this procedure, you'll create experiments based on these protocols.

Cytation 5 Disp 1 Test No Read.prt and Cytation 5 Disp 2 Test No Read.prt

Each protocol contains three Dispense steps for dispensing three different volumes of the
green dye test solution into a microplate.
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Note: Despite the "No Read" text in the protocol names, the last step in both protocols is
actually a brief Read step. This step is necessary because Gen5 requires a Read step with
any Dispense procedure; however, the resulting measurement value is not used.

To avoid errors when running the experiments, examine the following default protocol
parameters. If your Cytation 5 model does not support some of the parameters, change the
Read step in both protocols so that it will work with your model. The Read step is defined as
follows:

l Read well A1 only

l Detection Method: Luminescence (filter-based)

l Filter Set: Open

l Read Height: 7.00 mm

l Gain: 135

Cytation 5 Disp 1 Test Other Reader.prt and Cytation 5 Disp 2 Test Other
Reader.prt

These protocols contain the absorbance Read steps necessary for testing the dispense
module, and they also contain Microsoft Excel spreadsheets for performing the results
analysis.

These two protocols can be used only if your absorbance reader is a BioTek reader and is
supported by Gen5. If you cannot use these protocols, prepare your reader to perform two
reads with the following characteristics:

80 µL Read 20 & 5 µL Read

Primary Wavelength 405 nm 630 nm

Reference Wavelength 750 nm 750 nm

Plate Columns 1-4 5-12

1. If you have not already done so, create the necessary Gen5 protocols; instructions
begin on page 189.

2. Prime both dispensers with 4000 µL of deionized or distilled water.

3. Purge both dispensers with the Volume set to 2000 µL. This prevents the water from
diluting the dye. Remove the inlet tubes from the supply bottles.

4. Fill a beaker with at least 20 mL of the green dye solution. Prime both dispensers with
2000 µL of the solution. When finished, remove the priming plate from the carrier.

5. In Gen5, create an experiment based on Cytation 5 Disp 1 Test No Read.prt.

6. Place a new 96-well microplate on the balance and tare the balance.

7. Place the plate on the microplate carrier.

Important: Running a dispense procedure without placing a plate in the reader will
result in contamination of the reader from spilled liquid.
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Note: Gen5 provides instructions for processing the plates; follow the steps
carefully. When each dispense step is finished, you will weigh the plate, record the
weight, tare the balance with the plate on it, and then place the plate back on the
carrier for the next step.

8. Select Plate > Read and click READ. Gen5 prompts you to empty the tip priming
trough.

9. When ready, click OK at the Load Plate dialog to begin the experiment. The sequence is
as follows:

a. Dispense 80 µL/well to columns 1–4.

b. Remove the plate and weigh it. Record the weight and tare the balance.

c. Place the plate on the carrier and dispense 20 µL/well to columns 5–8.

d. Remove the plate and weigh it. Record the weight and tare the balance.

e. Place the plate on the carrier and dispense 5 µL/well to columns 9–12.

f. Remove the plate and weigh it. Record the weight.

g. Manually pipette 150 µL of deionized or distilled water into all 12 columns, on top
of the green test dye solution.

10. Close the experiment without saving it.

Note: If you are not using a BioTek reader for taking absorbance measurements, read
the plate using the wavelengths shown in the table earlier, and then perform the Results
Analysis as described on page 186.

Also, be sure to shake the plate after each dispense step to ensure the dye and water is
mixed adequately.

11. If you are using a BioTek absorbance reader, configure Gen5 to communicate with the
reader.

12. Create a Gen5 experiment based on the Cytation 5 Disp 1 Test Other Reader
protocol.

13. Initiate a plate read. Place the plate on the carrier, and click OK at the Load Plate dialog.
The protocol instructs the absorbance reader to:
a. Perform the "80 µL" read at 405/750 nm.
b. Perform the "20 and 5 µL" read at 630/750 nm.

14. When processing is complete, click Plate > Export to export the data to the embedded
PowerExport spreadsheet.

15. Enter the 80 µL, 20 µL, and 5 µL dispense weights recorded. Results are calculated
based on the dispense weights; each dispense volume should show "PASS" for Accuracy
% Error and for %CV. See the calculation descriptions below and Section 6, System
Description for troubleshooting tips.
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16. Save the changes, and then print the spreadsheet. Sign the sheet and store it with your
test records.

17. Close Excel, and then close the experiment.

18. Remove the plate from the carrier, and set it aside.

19. Repeat steps 5-17 using Cytation 5 Disp 2 Test No Read.prt and Cytation 5 Disp 2
Test Other Reader.

20. See instructions on analyzing the results on page 186.

Note: When all tests are complete, prime both dispensers with at least 5000 µL of
deionized water to flush out the green dye solution.

Gen5 Test Protocols for Models with Absorbance Capabilities

1. Select System > Instrument Configuration, and add/configure the Cytation 5 (if it is
not already there).

2. Create a new protocol.

3. Perform the steps in the following three sections to define the Procedure, customize the
Plate Layout, and add Data Reduction steps, to test Dispenser #1.

4. When finished, select File > Save As and save the file as Cytation 5 Disp 1 Test.prt.

5. Repeat steps 2–4 above to create Cytation 5 Disp 2 Test.prt to test Dispenser 2.

Define the Procedure
In brief, the protocol’s procedure follows the sequence below. After each Dispense step, the
plate is ejected to allow the operator to weigh it and then tare the balance.

l Dispense 80 µL dye to columns 1–4

l Dispense 20 µL dye to columns 5–8

l Dispense 5 µL dye to columns 9–12

l Shake the plate for 15 seconds

l Read columns 1–4 at 405/750 nm and calculate the Delta OD

l Read columns 5–12 at 630/750 nm and calculate the Delta OD

The detailed procedure is described on the next page. To add a step to the procedure, click
the appropriate button on the left side of the Procedure dialog and define the required
parameters.

Note: The comments suggested for use with the Plate Out/In steps are optional, but they
may be useful for the person running the test. When the Plate Out/In step is executed,
Gen5 displays its comment in a message box.

BioTek Instruments, Inc.



190 | Chapter 7: Instrument Qualification

Gen5 Procedure Steps

# Step Type Details

1 Dispense Dispenser <select 1 or 2, depending on the
protocol>

Dispense to wells A1..H4

Tip prime before this dispense step, 20 µL

Dispense 80 µL at rate 275 µL/sec

2 Plate Out,In Suggested comment: Weigh the plate (80 uL test).
RECORD the weight, TARE the balance. Place the
plate back on the carrier. Click OK to continue.

3 Dispense Dispenser <select 1 or 2, depending on the
protocol>

Dispense to wells A5..H8

Tip prime before this dispense step, 20 µL

Dispense 20 µL at rate 250 µL/sec

4 Plate Out,In Suggested comment: Weigh the plate (20 uL test).
RECORD the weight and TARE the balance. Place
the plate back on the carrier. Click OK to continue.

5 Dispense Dispenser <select 1 or 2, depending on the
protocol>

Dispense to wells A9..H12

Tip prime before this dispense step, 5 µL

Dispense 5 µL at rate 225 µL/sec

6 Plate Out,In Suggested comment: Weigh the plate (5 uL test).
RECORD the weight. PIPETTE 150 uL/well of DI
water into all 12 columns. Place the plate back on
the carrier. Click OK to perform the Read steps.

7 Shake Linear at 567 cpm (3 mm) for 15 seconds

8 Read Step label: “80 ul Read_Disp 1” (or _Disp 2)
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Gen5 Procedure Steps

# Step Type Details

Wells: A1..H4

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 405 and 750 nm

9 Read Step label: “20 and 5 ul Read_Disp 1” (or _Disp 2)

Wells: A5..H12

Detection Method: Absorbance

Read Type: Endpoint

Read Speed: Normal

Two Wavelengths: 630 and 750 nm

Customize the Plate Layout (Optional)
The results analysis worksheet at the end of this chapter requires the calculation of the
Standard Deviation, Mean, and % CV of the ODs read for each dispense volume in each
plate (six sets of calculations). By identifying the wells by their dispense volumes in the
Plate Layout, Gen5 will calculate these values for you.

1. In the protocol, open the Plate Layout dialog.

2. Set the Type set to Assay Control, and define three control types: Disp_80, Disp_20,
and Disp_5.

3. In the Plate Layout, select Disp_80 and highlight wells A1 to H4.

4. Select Disp_20 and highlight wells A5 to H8.

5. Select Disp_5 and highlight wells A9 to H12.

6. Click OK to save the changes and close the dialog.

Note: After running the experiment, view the Statistics for each Delta OD Data Set to
view the calculations

Add Data Reduction Steps
Each Read step is performed using two wavelengths, so you will create two data reduction
steps to calculate the Delta OD values.
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1. In the protocol, open the Data Reduction dialog and click Custom.

2. Click Select multiple data sets and then select DS2.

3. Set the Data In for DS1 to the 80 µL Read step at 405 nm.

4. Set the Data In for DS2 to the 80 µL Read step at 750 nm.

5. Click OK to return to the Transformation dialog.

6. In the New Data Set Name field, type an identifying name such as Delta OD 80 ul_Disp
1.

7. Clear Use single formula for all wells.

8. In the Current Formula field, type DS1–DS2 and then highlight wells A1 to H4 to
assign the formula.

9. Click OK to add the transformation to the Data Reduction list.

10. Create another Transformation similar to the above, with these characteristics:

l DS1 set to the 20 and 5 µL Read step at 630 nm

l DS2 set to the 20 and 5 µL Read step at 750 nm

l New Data Set Name resembling Delta OD 20 and 5 uL_Disp 1

l Remember to clear Use single formula for all wells

l Formula DS1–DS2 applied to wells A5 to H12

11. Click OK to close the Data Reduction dialog. When you are finished, the Data Reduction
Steps list shows two Delta OD transformations.

Gen5 Test Protocols for Models without Absorbance Capabilities

The test procedure must dispense three volumes of fluid to a microplate and then read the
plate on an absorbance reader. The procedure is performed twice, once for each dispenser.
You will create two Gen5 protocols to perform the dispense steps. If you will use a BioTek
absorbance reader that is supported by Gen5, you will create one additional protocol to
perform the Read step.

Create the Dispense Protocols

Note: Perform these steps to create a protocol to test Dispense 1. Then, open a copy of
the protocol and change the relevant Procedure parameters to Dispenser 2.

1. In Gen5, create a new protocol.

2. Define the Procedure with the steps and settings as described in the following table:

# Step Type Details

1 Dispense Dispenser <select 1 or 2, depending on the

Cytation 5 User Manual



Dispense Module Qualification Tests | 193

# Step Type Details

protocol>

Dispense to wells A1..H4

Tip prime before this dispense step, 20 µL

Dispense 80 µL at rate 275 µL/sec

2 Plate Out,In Suggested comment: Weigh the plate (80 uL
test). RECORD the weight, TARE the balance.
Place the plate back on the carrier. Click OK to
continue.

3 Dispense Dispenser <select 1 or 2, depending on the
protocol>

Dispense to wells A5..H8

Tip prime before this dispense step, 20 µL

Dispense 20 µL at rate 250 µL/sec

4 Plate Out,In Suggested comment: Weigh the plate (20 µL
test). RECORD the weight and TARE the
balance. Place the plate back on the carrier.
Click OK to continue.

5 Dispense Dispenser <select 1 or 2, depending on the
protocol>

Dispense to wells A9..H12

Tip prime before this dispense step, 5 µL

Dispense 5 µL at rate 225 µL/sec

6 Plate Out,In Suggested comment: Weigh the plate (5 uL
test). RECORD the weight. Set the plate aside
and click OK.

7 Read Wells: A1

Detection Method: <select any valid method>

Read Type: Endpoint

Read Speed: Normal
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# Step Type Details

Wavelength: <select any valid wavelength
(s)>

The Read step is necessary because Gen5 requires a Read step within any
Dispense procedure. When the test is run, the measurement value is not used.

3. Save the protocols as Cytation 5 Disp 1 Test.prt and Cytation 5 Disp 2 Test.prt.

Create the Read Protocol (if needed)
1. In Gen5, create a new protocol for the BioTek reader.

2. Define the Procedure with the steps and settings as described in the following table:

# Step
Type Details

1 Read Step Label: "80 ul Read"
Wells: A1..H4
Detection Method: Absorbance
Read Type: Endpoint
Read Speed: Normal
Two Wavelengths: 405 nm and 750 nm

2 Read Step Label: "20 and 5 ul Read"
Wells: A5..H12
Detection Method: Absorbance
Read Type: Endpoint
Read Speed: Normal
Two Wavelengths: 630 nm and 750 nm

3. Create Data Reduction steps to calculate Delta OD values:

l Select Protocol > Data Reduction and select Custom.

l Within this dialog, click Select Multiple Data Sets and then click DS2.

l Set the Data In for DS1 to the 80 ul Read step at 405 nm.

l Set the Data In for DS2 to the 80 ul Read step at 750 nm.

l Click OK to return to the dialog.

l In the New Data Set Name field, type an identifying name such as "Delta OD 80
ul_Disp 1."

l Clear Use single formula for all wells.
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l In the Current Formula field, type DS1-DS2 and then assign the formula to wells
A1 to H4.

l Click OK to add the transformation to the Data Reduction list.

l Create another Transforming similar to above, with these characteristics:

l DS1 set to the 20 and 5 ul Read step at 630 nm

l DS2 set to the 20 and 5 ul Read step at 750 nm

l New Data Set Name resembling "Delta OD 20 and 5 ul_Dispense (#)"

l Formula DS1-DS2 applied to wells A5 to H12

4. The results analysis worksheet at the end of this chapter requires the calculation of the
Standard Deviation, Mean, and % CV of the ODs read for each dispense volume in each
plate (six sets of calculations). By identifying the wells by their dispense volumes in the
Plate Layout, Gen5 will calculate these values for you.

l Open the Plate Layout dialog.

l Set the Type set to Assay Control, and define three control types: Disp_80, Disp_
20, and Disp_5.

l In the Plate Layout, select Disp_80 and highlight wells A1 to H4.

l Select Disp_20 and highlight wells A5 to H8.

l Select Disp_5 and highlight wells A9 to H12.

l Save the protocol as Cytation 5 Disp Test Other Reader.prt.

Note: After running the experiment, view the Statistics for each Delta OD Data Set to
view the calculations.

BioTek Instruments, Inc.
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Appendix A

Specifications

This appendix contains BioTek's published specifications for
the Cytation 5. Note: Unless otherwise stated, all
specifications are based on normal plate-carrier speed, not
“slower carrier speed.”
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Imaging Specifications 208
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General Specifications

Microplates/Labware

The Cytation 5 accommodates standard 6-, 12-, 24-, 48-, 96-, 384-, and 1536-well
microplates with 128 x 86 mm geometry, (1536-well plates for imaging only), Take3 and
Take3 Trio Micro-Volume Plates, microplate slides, T25 cell culture flasks (with adapter),
and 35 mm, 60 mm, and 100 mm Petri dishes (with adapter). Maximum Plate Height:
25.4 mm (1.0").

Hardware and Environmental

Light Source

Absorbance,
Fluorescence
(monochromator)

Xenon flash light source, 20W maximum average power

Fluorescence
(FI/FP), filter-based:

Xenon flash light source, 5W maximum average power

TRF (filter-based): Xenon flash light source, 5W maximum average power

Dimensions: 20.25" D x 15.50" W x 17.5" H (51.4 cm D x 39.4 cm W x 44.5 cm
H )

Weight: With all modules installed, without power supply or dispense
module, < 80 lbs. (36.3 kg)

Environment: Operational temperature 18ºC to 30ºC (64.4ºF to 86ºF)
Note: Performance measurements, including detection limits,
were verified up to 25ºC (77ºF).

Storage temperature -25ºC to 50ºC (-13ºF to 122ºF)

Humidity: Operational: 10% to 85% relative humidity (non-condensing)

Storage: 10% to 80% relative humidity (non-condensing)

Power: The instrument is powered from an external 250W (minimum),
24VDC power supply compatible with 100-240 volts AC @50-
60Hz.
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Hardware and Environmental

Incubation: Temperature control ranges from 4ºC over ambient to 65ºC

Temperature variation ± 0.5ºC across the plate @ 37ºC, tested
with Innovation Instruments, Inc. temperature test plate.

Top and bottom incubation controlled via software-adjustable
gradient.

For models with the alpha laser module: Alpha laser module
operation is disabled above an internal instrument temperature of
35º C.

BioTek Instruments, Inc.
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Dispense/Read Specifications

Dispense/Read, for models with the dual-reagent dispense module

Plate Type Injectors dispense to standard height 6-, 12-, 24-, 48-,
96-, and 384-well microplates.

Detection Method Absorbance, Fluorescence (FI, FP, TRF), Luminescence,
Imaging (well mode only)

Volume Range 5–1000 µL with a 5–20 µL tip prime

Reagent Dead Volume < 1100 µL, with dead volume recovery function (purge)

Injection Speeds 225, 250, 275, 300 µL/second

Accuracy ± 1 µL or 2.0%, whichever is greater

Precision ≤ 2.0% for volumes of 50–200 µL

≤ 4.0% for volumes of 25–49 µL

≤ 7.0% for volumes of 10–24 µL

≤ 10.0% for volumes of 5–9 µL

Maximum Delay between End of Dispense and Beginning of Read
96/384-well plates, default probe heights (using normal plate-carrier
speed)

Bottom Mono Fluorescence T ≤ 0.5 second

Luminescence T ≤ 0.5 second

Top Filter Fluorescence T ≤ 1.0 second

Top Mono Fluorescence T ≤ 1.0 second

Absorbance T ≤ 1.0 second
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Absorbance Specifications

Note: For the performance specifications described in this section, the gain on the optics
test should be <= 8.

Optics

Wavelength Range 230 to 999 nm

Wavelength Bandpass < 4 nm (230–285 nm), < 8 nm (> 285 nm)

Measurement Range 0.000 to 4.000 OD

Resolution 0.0001 OD

Increment 1 nm

Wavelength Accuracy ± 2 nm

Wavelength Precision ± 0.2 nm

Minimum kinetic interval
(450 nm)

≤ 20 seconds, sweep mode, 96-well microplate

Plate In/Plate Out Speed

≤ 35 seconds, 450 nm, sweep mode, 96-well microplate

Accuracy, Linearity, Repeatability

Specifications apply from 250–999 nm, 200 µL (96-well microplates)

Accuracy (tested with certified neutral density glass)

96-well plate, normal read speed
0–2.0 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms
2.0–2.5 OD: +/-3% +/-0.010 OD, delay after plate movement = 100 ms

384-well plate, normal read speed
0–2 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms
2–2.5 OD: +/-5% +/-0.010 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed
0–1.0 OD: +/-1% +/-0.010 OD

Linearity (by liquid dilution)

96-well plate, normal read speed

BioTek Instruments, Inc.
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Accuracy, Linearity, Repeatability

0–2.0 OD: +/-1% +/-0.010 OD, delay after plate movement = 100 ms
2.0–2.5 OD: +/-3% +/-0.010 OD, delay after plate movement = 100 ms

384-well plate, normal read speed
0–2.0 OD: +/-2% +/-0.010 OD, delay after plate movement = 100 ms
2–2.5 OD: +/-5% +/-0.010 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed
0–1.0 OD: +/-1% +/-0.010 OD

Repeatability (tested with certified neutral density glass/measured by one
standard deviation: 8 measurements per data point)

96-well and 384-well plate, normal read speed
0–2.0 OD: +/-1% +/-0.005 OD, delay after plate movement = 100 ms
2.0–2.5 OD: +/-3% +/-0.005 OD, delay after plate movement = 100 ms

96-well and 384-well plate, sweep read speed
0–1.0 OD: +/-2% +/-0.010 OD

Take3 Plate

260 nm dsDNA Detection Limit: 5 ng/µL
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Fluorescence Specifications (Mono-Based)

The Cytation 5 measures fluorescence with monochromators from the top and bottom of 6-
to 384-well plates.

Monochromator-Based Fluorescence

Excitation range 250–700 with low-noise PMT

250–900 nm with red-shifted PMT

Emission range 250–700 nm with low-noise PMT

300–700 nm for emission scans with low-noise PMT

250–900 nm with red-shifted PMT

300–900 nm for emission scans with red-shifted PMT

Selectable
increment

1 nm

Bandpass Variable from 9 nm to 50 nm in 1 nm increments (both excitation
and emission)

Minimum kinetic
interval

< 20 seconds, sweep mode, 96-well microplate

Plate In/Plate Out Speed

≤ 35 seconds, sweep mode, 96-well microplate

Sensitivity

Sodium Fluorescein in phosphate buffered saline (PBS)
DL ≤ 20 pM top or bottom read, 5 pM typical
Excitation 485 nm, Emission 528 nm

Methylumbelliferone (MUB) in carbonate-bicarbonate buffer (CBB)
DL ≤ 0.16 ng/mL (0.91 nM) top read
Excitation 360 nm, Emission 460 nm

Propidium Iodide (PI) in PBS
DL ≤ 62.5 ng/mL bottom read

BioTek Instruments, Inc.
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Sensitivity

Excitation 485 nm, Emission 645 nm

Fluorescence Specifications (Filter-Based)

The Cytation 5 measures fluorescence with filters from the top of 6- to 384-well plates.

Plate In/Plate Out Speed

≤ 35 seconds for filter set, sweep mode, 96-well microplate

Fluorescence Intensity

DL ≤ 10 pM solution of Sodium Fluorescein in PBS Excitation 485/20, Emission 528/20, 510
nm mirror

DL ≤ 0.16 ng/mL (0.91 nM) solution of Methylumbelliferone in CBB, Excitation 360/40,
Emission 460/40, 400 nm mirror

Time-Resolved Fluorescence

DL Europium ≤ 250 fM
Excitation 360/40 nm, Emission 620/40 nm, 400 nm mirror

Integration time 20 to 2000 µs

Delay 0 to 2000 µs

Granularity 1-µs step

Fluorescence Polarization

5 mP standard deviation at 1 nM Sodium Fluorescein
Excitation 485/20 nm, Emission 528/20 nm, 510 nm mirror
Excitation range: 400 to 700 nm
Emission range: 400 to 700 nm

Luminescence Specifications

The Cytation 5 measures luminescence from the top of 6- to 384-well plates. The following
requirements apply to 96-well plates with 200 µL/well, at room temperature. Production
testing is performed using a Harta plate.
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Luminescence

DL ≤ 75 amol/well, 30 amol typical with low-noise PMT
≤ 500 amol/well with red-shifted PMT

Integration Time 10 seconds

Gain 150

Blank Wells 16

BioTek Instruments, Inc.
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Imaging Specifications

Imaging specifications based on using an NIH 3T3 plate: 10,000 cells per well, GFP stain, 1
image per well, 96-well Costar 3603 black-sided, plastic-bottom plate.

Read Speed

At 20X using
standard Autofocus

< 10 minutes with normal plate-carrier speed; < 15 minutes
with “slower carrier speed”

Cytation 5 User Manual
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may appear in Gen5.
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Overview

When a problem occurs during operation with the Cytation 5, an error code appears in
Gen5. Error codes typically contain four characters, such as “5A01,” and in most cases are
accompanied by descriptive text, such as “Plate carrier hit obstruction and lost
steps.” With many errors, the instrument will beep repeatedly; press the carrier button to
stop this alarm.

Some problems can be solved easily, such as “2B0A: Priming plate not detected” (place a
priming plate on the carrier). Other problems can be solved only by BioTek service
personnel. This appendix lists the most common and easily resolved error codes that you
may encounter.

Note: Error codes beginning with “A” (e.g., A100) indicate conditions that require
immediate attention. If this type of code appears, turn the instrument off and on. If the
System Test is not successful, record the error code and contact Technical Support.

If an error code appears in Gen5, you may want to run a System Test for diagnostic
purposes. In Gen5, select System > Diagnostics > Run System Test.

Note: If an error message appears while an experiment is in process and after having
received measurement data, it is your responsibility to determine if the data is valid.

Use this appendix to diagnose problems and solve them if possible. If you need further
assistance, contact Technical Support. See Contact Information on page viii.

Note: For errors that are displayed during operation of the Cytation 5 with the BioStack,
refer to the BioStack User manual.

Cytation 5 “W” Models: FL Illumination Correction

Objective Setup Plate (PN 1852501) is required

“W” models with their WFOV
cameras require “fluorescent
illumination correction“ files
that are created and stored
on the controller or host
computer during initial
instrument calibration. If
another computer is used to
control the reader, the
correction files must be
recaptured:

1. In Gen5, select System>Instrument Configuration>Setup>Imaging
Configuration.
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2. Click FL Illumination Correction and follow prompts to put the objective setup plate
on the carrier.

You do not need to rerun Auto Calibration unless you are also changing objectives or LED-
Filter cubes.

Error Codes

This table lists the most common and easily resolved error codes that you may encounter. If
an error code appears in Gen5, look for it here. If you find the code, follow the suggestions
provided for solving the problem. If you cannot find the code or if you are unable to solve
the problem, please contact Technical Support. The Gen5 Help system also provides
troubleshooting tips.

Code Description and Possible Remedy

2353 Filter block not found on filter/mirror slide
Verify that the filter block is correctly installed and that it matches the Gen5
optics library.

2B0x Dispenser syringe 1 or 2 (respectively) did not home
x=1–3
Generally, this error indicates the syringe was not properly installed. Make
sure the syringe’s thumbscrews are properly threaded. (Refer to the
Installation chapter for instructions.) Restart the instrument.

2B0A Priming plate not detected
Place priming plate on the carrier.

2B04 Dispenser syringe 1 or 2 (respectively) failed position verify.
Generally, this error indicates the syringe was not properly installed. Make
sure the syringe’s thumbscrews are properly threaded. Restart the reader.
(Refer to the Installation chapter for instructions.)

2C02-03 Dispense tips mismatch: dimensions of defined dispense tips do not match
the installed tips. Check the "Instrument Configuration" to ensure the correct
tips were selected.

2D4E Gas is not on. Check the connections and status of the gas controller. Make
sure it is turned on and the tubing is properly connected.

2D0A Tip priming cup is full. Empty the priming cup.

2D4F Environmental cover is open, and must be closed for the current operation.
Close the cover and do not open it until the session is ended.

2D50 Incompatible stage insert. Only the "Humidity" or environmental-chamber
stage insert supports gas recharging. If attempting to incubate, install the
top cover.
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Code Description and Possible Remedy

2D51 Gas recharge in progress. Wait until the gas recharge step is complete.

2D52 Fan test failure. Contact Technical Support.

37x0/47x0
38x0/48x0
39xy/49xy

Noise Test Errors
Offset Test Errors
Dark Range Errors
x=0, 1; y=0–6
This series of System Test errors may indicate too much light inside the
chamber. Make sure the plate carrier door and the top hinged door are
properly closed. For models with the dispense module, if the dispense tubes
are not connected to the reader, re-install the light shield that shipped with
the instrument (or cover the hole with black tape). Restart the reader.

4xxx PMT overload well error at <well #xxx>
This error typically means that the fluid in a well has oversaturated the PMT
(i.e., the well is too bright). Try lowering the sensitivity value in the read
step.
To identify the well:
Wells are counted starting at A1, moving left-to-right, row-by-row. The row
and column of the well can be extracted from the well number code by
applying the following formula (example uses 8 x 12 geometry, 96-well
plate):
1. Convert the ASCII hex string to a decimal equivalent. Ex: “057” indicates
57 hex, yielding a well code of 87 decimal.
2. Row = (well code) / (columns in plate), rounded up to a whole number.
Ex: 87/12 = 7.25, indicating row 8 (or H).
3. Column = (well code) - ((row-1) * (columns in plate)). Ex: 87 - ((8 - 1) *
12) = column 3.
NOTE: If this code is returned during an area scan, it indicates the scan point
corresponding to the row/column equivalent in the currently defined scan
map, not the actual well where the error occurred.

4Exy Detector saturated (too much light). Relative Fluorescing Units (RFU)
reached (99999).
x=0, 1; y=0–6
This error can indicate one of several scenarios. It is possibly due to incorrect
chemistry, e.g., the fluorescence standards dispensed to the plate exceed
expectations.
Try lowering the gain in your Read step(s).
For models with the dispense module, the internal chamber may require
cleaning (contact Technical Support).
If a 4E18 error is detected during monochromator-based fluorescence, the
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Code Description and Possible Remedy

luminescence probe may be picking up stray light. Try installing a plug in the
filter cube. Restart the reader.

4Fxy Fluorescence signal out of range
x=0,1; y=0–6
Verify that the Gen5 Fluor/Lum wavelengths table matches the actual filter
installed in the filter cube. Verify that there is no filter wavelength overlap
between the emission/excitation positions.
Verify that the microplate door is fully closing and the instrument cover is
properly installed and sealed.
Try lowing the gain in your Read step(s).
The reading chamber may be contaminated by a spill that is fluorescing; see
the Periodic Maintenance chapter.

5003
5103

Filter cube did not home
Generally, this error indicates the filter cube is not seated properly in the
reader. Remove it, ensure each filter or plug is properly positioned, and
reinstall it securely. Restart the reader.

5403 Filter cube failed positional verify
Generally, this error indicates the filter cube is not seated properly in the
reader. Remove it, ensure each filter or plug is properly positioned, and
reinstall it securely. Restart the reader.

55xy <Motor> not homed successfully
xy=axis
This error indicates that an axis failed a previous verify function and now
needs to be homed. Verify that the shipping brackets have been removed.
Check for any obstructions that may prevent the carrier, syringes, or filter
cube and objective turret from moving normally. Restart the instrument.

570x Axis obstruction error
This error indicates that a moving part is being obstructed. Verify that:

l the tip priming trough, microplate, plate lid, or other object has not
become dislodged in the reading chamber.

l the Plate Type selection in the Gen5 procedure is correct for the plate in
use, and the Plate Height measurement is correct.

l the filter cube is correctly installed.

l nothing is preventing the dispenser syringes from moving.

For some plate type and read probe combinations, it might not be possible to
define the entire area scan matrix offered by Gen5 for some perimeter wells
due to the physical limitations of carrier travel. Redefine the area scan to
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Code Description and Possible Remedy

include a small matrix, or select wells in a different row or column.

500C
520C
550C

Imager LED/Filter Slide error
Verify that the filter slide shipping bracket is removed and the slide moves
freely when the instrument is powered off. An object may be obstructing the
path.

500D
520D
540D
550D
570D

Imager Objective Changer error
Verify that the objective turret shipping bracket is removed and the turret
rotates freely when the instrument is powered off. An object may be
obstructing the path.
Ensure that the installed objective matches the objective configuration. If
the objective installed is too tall, it may contact the bottom of the incubator.
Verify that the z-axis motor is moving and that the objective is not binding on
the incubator.

500E
520E
540E
550E

Z-Axis error
Verify that the carrier shipping bracket is removed.
Axis did not home successfully.

5A0x1 Plate carrier hit obstruction and lost steps
x=0, 1
Verify that the microplate is properly and securely seated in the carrier and
nothing is obstructing carrier movement inside the reading chamber.
Make sure the Plate Type defined in the Gen5 Protocol matches the plate you
are using.
This error can also occur if the plate type is correct but the lid was left on the
plate. If you wish to read the plate with a lid on it, update the plate type
record in Gen5 with the correct lid dimensions and Plate Height.

5B00 Plate carrier needs to be ejected from the reading chamber
The carrier is inside the read chamber and the probe needs to move down for
the requested operation. Press the carrier eject button. This may occur if the
read was aborted and "home all axes" was not performed.
This error can also occur if the carrier is inside and the newly defined plate
height is different from the most recently specified plate height.
To resolve the error, eject the carrier prior to running the experiment.

7A0C Side/Access door interlock signal deactivated while LED is on or
during an attempt to turn on the LED

1The last 2 digits in the error code series refer to these components: 00 = carrier X axis, 01 = carrier Y
axis, 02 = camera Z axis (focus), 03 = LED-Filter slider, 04 = objective turret, 05 = Brightfield paddle.
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Code Description and Possible Remedy

Verify the access/side door is closed.
Verify the magnet has not become dislodged from the door.

7A0D LED intensity at reference diode measures more than 5% below the
specified target
Run a System Test to see if the error is generated again.
Check to see if the small aperture hole on the top of the imaging filter cube is
blocked.
Ensure the LED cube and imaging filter cube are present, plugged in, or not
defective.
Verify the imaging filters and are clean and match the configuration defined
in Gen5.

7A0E LED intensity at reference diode measures more than 5% above the
specified target
Run a System Test to see if the error is generated again.
Ensure that the LED cube and imaging filter cube are not defective.
Verify that the imaging filters are not delaminating or do not match the
configuration defined in Gen5.

7A0F Current DAC adjusted to more than double the starting value within
the first 20 control cycles
This error can be generated if a System Test is not run after sending new
values to the instrument for imager configuration. Run a System Test to
clear the error.
Verify that the imaging filter cube and fluorescence filter cube configuration
is correct.
Ensure that the LED cube and imaging filter cube are not defective.

7A10 With current DAC adjusted to maximum output, LED intensity at
reference diode measures more than 5% below the specified target
Run a System Test to see if the error is generated again.
Check to see if the small aperture hole on the top of the imaging filter cube is
blocked.
Ensure the LED cubes and imaging filter cubes are present, plugged in, or not
defective.
Verify the imaging filters are clean and match the configuration defined in
Gen5.

7A85 LED gain calibration signal is out of range
This error occurs only during the System Test.
Ensure the imaging filter cubes and fluorescence filter cube are present and
clean. Dust or finger prints can scatter light in unexpected ways and cause
this error.
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Code Description and Possible Remedy

Check the wire clip between the LED cube and the instrument's PCB to
ensure it is not loose or defective.
Verify that the light aperture on the top of the imaging filter cube is not
blocked.
Ensure that the LED cube and imaging filter cube are not defective.

7A86 LED control timeout
The LED output setpoint was not reached within 20 msec after turn on.
Verify the LED cube and imaging filter cube settings. The XML file must
match the LED cube and imaging filter cube contents.
Run a System Test to reset LED gain calibrations.

7A87 LED-on current feedback is out of range (low)
Ensure the LED cube is present, plugged in, or not defective.
Run a System Test to see if the error is generated again.

7A88 LED-on current feedback is out of range (high)
Run a System Test to see if the error is generated again.

7A89 User-initiated positional calibration needed
Run imager objective calibration in Gen5 setup.

7A8A Carrier calibration needed
Run imager objective calibration in Gen5 setup.

7A85 LED calibration signal is out of range
Ensure the imaging filter cubes and fluorescence filter cube are present and
clean. Dust or finger prints can scatter light in unexpected ways and cause
this error.
Verify that the light aperture on the top of the imaging filter cube is not
blocked.
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Veiligheidsmededelingen
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Sicherheitshinweise
Avvisi di sicurezza
Avisos de seguridad

This appendix contains safety information for the Cytation 5,
translated into Dutch, French, German, Italian, and Spanish.
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Safety Notices

Veiligheidsmededelingen

Avis de sécurité

Sicherheitshinweise

Avvisi di sicurezza

Avisos de seguridad

Pay special attention to the following safety notices in all product documentation.

Let vooral op de volgende veiligheidsmededelingen in alle productdocumentatie.

Portez une attention particulière aux avis de sécurité suivants dans l'ensemble de la
documentation du produit.

Achten Sie besonders auf die folgenden Sicherheitshinweise in allen
Produktdokumentationen.

Prestare particolare attenzione agli avvisi di sicurezza presenti in tutta la documentazione
del prodotto.

Preste especial atención a los siguientes avisos de seguridad en toda la documentación del
producto.

A WARNING notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like that, if not correctly performed or
adhered to, could result in personal injury or death. Do not proceed
beyond a WARNING notice until the indicated conditions are fully
understood and met.
De aanduiding WAARSCHUWING duidt op een gevaar. Deze vestigt de
aandacht op een bedieningsprocedure, praktijk of iets dergelijks die,
indien niet correct uitgevoerd of nageleefd, persoonlijk letsel of de dood
tot gevolg kan hebben. Ga niet verder bij een aanduiding
WAARSCHUWING voordat de aangegeven voorwaarden volledig
begrepen zijn en eraan voldaan is.
Un AVERTISSEMENT signale un danger. Il attire l'attention sur une
procédure d'utilisation, une pratique ou autre qui, si elle n'est pas
correctement exécutée ou respectée, peut entraîner des dommages
corporels, voire un décès. Ne passez pas outre l'AVERTISSEMENT
uniquement si les conditions indiquées sont entièrement comprises et
remplies.
Ein WARNHINWEIS weist auf eine Gefahr hin. Er weist auf ein
Betriebsverfahren, eine Vorgehensweise oder ähnliches hin, deren
falsche Ausführung oder Nichtbeachtung zu Verletzungen oder zum Tod
führen können. Fahren Sie bei einem WARNHINWEIS erst dann mit Ihrer
Arbeit fort, wenn die angegebenen Bedingungen vollständig verstanden
und erfüllt sind.
Un avviso di AVVERTENZA indica un pericolo. Richiama l'attenzione su
procedure operative, pratiche o azioni simili che, se non rispettate o
eseguite correttamente, potrebbero causare lesioni personali o decesso.
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Non procedere ignorando un avviso di AVVERTENZA fino a quando le
condizioni indicate non sono state completamente comprese e
soddisfatte.
Un aviso de ADVERTENCIA indica un peligro. Destaca la importancia de
un procedimiento operativo, una práctica o un proceso similar que, si no
se realiza o se sigue correctamente, podría provocar lesiones o la
muerte. No siga adelante sin antes comprender y cumplir plenamente
los requisitos indicados en el aviso de ADVERTENCIA.
A CAUTION notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like that, if not correctly performed or
adhered to, could result in damage to the product or loss of important
data. Do not proceed beyond a CAUTION notice until the indicated
conditions are fully understood and met.
De aanduiding VOORZICHTIG duidt op een gevaar. Deze vestigt de
aandacht op een bedieningsprocedure, praktijk of iets dergelijks die,
indien niet correct uitgevoerd of nageleefd, schade aan het product of
verlies van belangrijke gegevens tot gevolg kan hebben. Ga niet verder
bij een aanduiding VOORZICHTIG voordat de aangegeven voorwaarden
volledig begrepen zijn en eraan voldaan is.
Une MISE EN GARDE signale un danger. Elle attire l'attention sur une
procédure d'utilisation, une pratique ou autre qui, si elle n'est pas
correctement exécutée ou respectée, peut endommager le produit ou
entraîner la perte de données importantes. Ne passez pas outre la MISE
EN GARDE uniquement si les conditions indiquées sont entièrement
comprises et remplies.
Ein VORSICHTSHINWEIS weist auf eine Gefahr hin. Er weist auf ein
Betriebsverfahren, eine Vorgehensweise oder ähnliches hin, deren
falsche Ausführung oder Nichtbeachtung zu einer Beschädigung des
Produkts oder zum Verlust wichtiger Daten führen kann. Fahren Sie bei
einem VORSICHTSHINWEIS erst dann mit Ihrer Arbeit fort, wenn die
angegebenen Bedingungen vollständig verstanden und erfüllt sind.
Un avviso di ATTENZIONE indica un pericolo. Richiama l'attenzione su
procedure operative, pratiche o azioni simili che, se non rispettate o
eseguite correttamente, potrebbero causare danni al prodotto o perdita
di dati importanti. Non procedere ignorando un avviso di ATTENZIONE
fino a quando le condizioni indicate non sono state completamente
comprese e soddisfatte.
Un aviso de PRECAUCIÓN indica un peligro. Destaca la importancia de
un procedimiento operativo, una práctica o un proceso similar que, si no
se realiza o no se sigue correctamente, podrían provocar daños en el
producto o la pérdida de datos importantes. No siga adelante sin antes
comprender y cumplir plenamente los requisitos indicados en el aviso de
PRECAUCIÓN.
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Warnings and Precautions

Electrical Hazards

Elektrische gevaren

Risques électriques

Elektrische Gefahren

Rischi elettrici

Peligros eléctricos

Internal Voltage. Always turn off the power switch and unplug the
power supply before cleaning the outer surface of the instrument.
Interne spanning. Zet altijd de stroomschakelaar uit en haal de
stekker uit het stopcontact voordat de buitenkant van het instrument
wordt gereinigd.
Tension interne. Désactivez toujours l'interrupteur d'alimentation
électrique et débranchez l'alimentation avant de nettoyer la surface
extérieure de l'instrument.
Spannung im Geräteinneren. Vor dem Reinigen der Außenfläche des
Geräts grundsätzlich den Stromschalter ausschalten und das
Stromkabel aus der Steckdose ziehen.
Tensione interna. Spegnere sempre l'interruttore dell'alimentazione
e scollegare l'alimentazione prima di pulire le superfici esterne dello
strumento.
Tensión interna. Siempre apague el interruptor y desconecte la
fuente de alimentación antes de limpiar la superficie exterior del
instrumento.
Power Rating. The instrument’s power supply or power cord must be
connected to a power receptacle that provides voltage and current
within the specified rating for the system. Use of an incompatible power
receptacle may produce electrical shock and fire hazards.
Vermogensklasse. De voeding of het netsnoer van het instrument
moet worden aangesloten op een stopcontact dat spanning en stroom
levert binnen de gespecificeerde nominale waarden voor het systeem.
Gebruik van een niet-compatibel stopcontact kan leiden tot elektrische
schokken en brandgevaar.
Puissance électrique nominale. L'alimentation ou le cordon
d'alimentation de l'instrument doit être raccordé(e) à une prise de
courant qui fournit la tension et le courant correspondants à la
puissance spécifiée du système. L'emploi d'une prise de courant
incompatible peut entraîner un choc électrique et un risque d'incendie.
Leistungsbemessung. Die Stromversorgung des Geräts bzw. das
Anschlusskabel muss mit einer Steckdose verbunden werden, deren
Spannungs- und Stromwerte innerhalb der für das System
vorgeschriebenen Nennwerte liegen. Die Verwendung einer nicht
kompatiblen Steckdose kann zu einem elektrischen Schlag und
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Brandgefahr führen.
Potenza nominale. L'alimentazione o il cavo di alimentazione dello
strumento devono essere collegati a una presa di corrente che fornisca
tensione e corrente comprese entro il valore nominale previsto per il
sistema. L'uso di una presa di alimentazione non compatibile può
causare scosse elettriche e rischi di incendio.
Potencia nominal. La fuente de alimentación o el cable de
alimentación del instrumento tienen que conectarse a un receptáculo
que suministre tensión y corriente dentro de la potencia especificada
para el sistema. El uso de un receptáculo incompatible puede producir
descargas eléctricas y riesgo de incendio.
Electrical Grounding. Never use a plug adapter to connect primary
power to the external power supply. Use of an adapter disconnects the
utility ground, creating a severe shock hazard. Always connect the
power cord directly to an appropriate receptacle with a functional
ground.
Elektrische aarding. Gebruik nooit een stekkeradapter om de
primaire stroom aan te sluiten op de externe voeding. Het gebruik van
een adapter verbreekt de verbinding met de aarding van het
elektriciteitsnet, waardoor een ernstige schok kan ontstaan. Sluit het
netsnoer altijd rechtstreeks aan op een geschikt stopcontact met
werkende aarding.
Mise à la terre électrique. N'utilisez jamais d'adaptateur de prise
pour raccorder l'alimentation principale à l'alimentation électrique
extérieure. L'utilisation d'un adaptateur déconnecte la terre du secteur,
créant un risque important de choc. Raccordez toujours le cordon
d'alimentation directement à une prise appropriée dotée d'une mise à
la terre fonctionnelle.
Elektrische Erdung. Verwenden Sie niemals einen Steckeradapter
zum Anschließen der Primärstromversorgung an die externe
Stromversorgung. Bei Verwendung eines Adapters wird die Verbindung
zur Gebäudeerde unterbrochen, sodass ein erhebliches
Stromschlagrisiko besteht. Das Stromkabel ist immer direkt an eine
geeignete Steckdose mit Funktionserdung anzuschließen.
Messa a terra elettrica. Non usare mai un adattatore per collegare
l'alimentazione principale all'alimentazione esterna. Se si usa un
adattatore, si scollega la messa a terra della rete elettrica creando un
grave pericolo di scosse elettriche. Collegare sempre il cavo di
alimentazione direttamente a una presa idonea dotata di messa a terra
funzionale.
Conexión a tierra. Nunca use un adaptador de enchufe para conectar
la corriente principal a la fuente de alimentación externa. El uso de un
adaptador desconecta la tierra del servicio y crea un riesgo de descarga
grave. Conecte siempre el cable de alimentación directamente a un
receptáculo adecuado con una toma de tierra funcional.
Service. Only qualified technical personnel should perform service
procedures on internal components.
Service. Alleen gekwalificeerd technisch personeel mag
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serviceprocedures aan interne onderdelen uitvoeren.
Entretien. L'exécution des procédures d'entretien des composants
internes doit être réservée au personnel technique qualifié.
Wartung.Wartungsarbeiten an Komponenten im Geräteinneren
sollten nur von qualifizierten Servicetechnikern durchgeführt werden.
Manutenzione. Le procedure di manutenzione sui componenti interni
devono essere eseguite esclusivamente da personale tecnico
qualificato.
Revisión. Solo puede realizar procedimientos de revisión de los
componentes internos el personal técnico cualificado.
Power Supply. Use only the power supply shipped with the
instrument, and operate it within the range of line voltages listed on it.
Voeding. Gebruik alleen de voeding die bij het instrument is geleverd
en gebruik deze binnen het bereik van de netspanningen die op de
voeding staan vermeld.
Alimentation électrique. Utilisez exclusivement l'alimentation
électrique fournie avec l'instrument dans la plage de tension de ligne
indiquée dessus.
Stromversorgung. Verwenden Sie nur die im Lieferumfang des
Geräts enthaltene Stromversorgung und betreiben Sie diese innerhalb
des darauf angegebenen Netzspannungsbereichs.
Alimentazione. Usare esclusivamente l'alimentatore fornito con lo
strumento, utilizzando quest'ultimo entro l'intervallo delle tensioni di
linea indicato sull'unità.
Fuente de alimentación. Use únicamente la fuente de alimentación
incluida con el instrumento y úsela en el rango de tensiones de línea
indicado en ella.
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Chemical/Environmental

Chemisch/Milieu

Substances chimiques/Environnement

Chemie/Umwelt

Rischi chimici/ambientali

Riesgos químicos y medioambientales

Potential Biohazards. Some assays or specimens may pose a
biohazard. Adequate safety precautions should be taken as outlined in
the assay’s package insert. Always wear safety glasses and appropriate
protective equipment, such as chemical-resistant rubber gloves and
apron.
Potentiële biologische gevaren. Sommige tests of specimens
kunnen een biologisch gevaar inhouden. Er moeten adequate
veiligheidsmaatregelen worden getroffen zoals aangegeven in de
bijsluiter van de test. Draag altijd een veiligheidsbril en geschikte
beschermingsmiddelen, zoals chemicaliënbestendige rubberen
handschoenen en een schort.
Risques biologiques potentiels. Certains tests ou échantillons
peuvent présenter un risque biologique. Des précautions de sécurité
adéquates doivent être prises, comme indiqué dans la notice de
l'emballage du test. Portez toujours des lunettes de sécurité et un
équipement de protection approprié, comme des gants en caoutchouc
résistant aux substances chimiques et un tablier.
Potenzielle Biogefahren. Manche Assays oder Proben stellen eine
Biogefahr dar. Es sollten angemessene Sicherheitsvorkehrungen
entsprechend der Packungsbeilage des Assays ergriffen werden. Tragen
Sie immer eine Schutzbrille und eine geeignete Schutzausrüstung, wie
chemikalienbeständige Gummihandschuhe und Schürze.
Potenziali rischi biologici. Alcuni test o campioni potrebbero
comportare un rischio biologico. Implementare misure di sicurezza
adeguate secondo quanto delineato nel foglietto della confezione del
test. Indossare sempre occhiali di sicurezza e dispositivi di protezione
appropriati, ad esempio guanti e grembiule in gomma resistenti alle
sostanze chimiche.
Riesgos biológicos potenciales. Algunos ensayos y especímenes
pueden constituir un riesgo biológico. Se han de tomar precauciones de
seguridad suficientes tal como se indica en el folleto del paquete del
ensayo. Use siempre gafas de seguridad y equipos protectores
adecuados, como guantes de caucho resistentes a productos químicos y
un delantal.
Liquids. Avoid spilling liquids on the instrument; fluid seepage into
internal components creates a potential for shock hazard or instrument
damage. If a spill occurs while a program is running, stop the program
and turn off the instrument. Wipe up all spills immediately. Do not
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operate the instrument if internal components have been exposed to
fluid.
Vloeistoffen. Voorkom dat vloeistoffen op het instrument worden
gemorst; het doorsijpelen van vloeistoffen in interne onderdelen kan
leiden tot schokgevaar of beschadiging van het instrument. Als een
lekkage optreedt terwijl een programma loopt, stopt u het programma
en schakelt u het instrument uit. Veeg alle gemorste vloeistof
onmiddellijk op. Gebruik het instrument niet als interne onderdelen aan
vloeistof zijn blootgesteld.
Liquides. Évitez de renverser des liquides sur l'instrument ; les
infiltrations de liquide dans les composants internes créent un risque
potentiel de choc ou de détérioration de l'instrument. En cas de
déversement de liquide alors qu'un programme est en cours
d'exécution, arrêtez le programme et mettez l'instrument hors tension.
Essuyez immédiatement tout liquide renversé. N'utilisez pas
l'instrument si les composants internes ont été exposés à du liquide.
Flüssigkeiten. Keine Flüssigkeiten auf dem Gerät verschütten! In die
Bauteile im Geräteinneren bilden einsickernde Flüssigkeiten ein
Potenzial für die Gefahr von Stromschlägen oder Schäden am Gerät. Bei
Verschütten von Flüssigkeiten während ein Programm läuft, ist dieses
zu stoppen und das Gerät auszuschalten. Verschüttete Flüssigkeiten
sind unverzüglich abzuwischen. Das Gerät darf nicht betrieben werden,
wenn Komponenten im Geräteinneren Flüssigkeiten ausgesetzt waren.
Liquidi. Evitare di versare liquidi sullo strumento; l'infiltrazione di fluidi
nei componenti interni crea rischi di scosse elettriche o danni allo
strumento. Se si verifica un versamento durante l'esecuzione di un
programma, arrestare il programma e spegnere lo strumento. Ripulire
immediatamente tutti i versamenti. Non utilizzare lo strumento se i
componenti interni sono stati esposti a fluidi.
Líquidos. Procure no derramar líquidos sobre el instrumento, ya que si
se filtran fluidos en los componentes internos se puede producir un
riesgo de descarga o de deterioro del instrumento. Si se produce un
derramamiento mientras se está ejecutando un programa, detenga el
programa y apague el instrumento. Limpie el derrame inmediatamente.
No utilice el instrumento si los componentes internos han estado
expuestos a fluidos.
Liquids. Do not immerse the instrument, spray it with liquid, or use a
dripping-wet cloth on it. Do not allow water or other cleaning solution to
run into the interior of the instrument. If this happens, contact
Technical Support.
Vloeistoffen. Dompel het instrument niet onder, bespuit het niet met
vloeistof en gebruik er geen druipnatte doek op. Zorg ervoor dat er
geen water of andere schoonmaakmiddelen in het inwendige van het
instrument terechtkomen. Als dit gebeurt, neem dan contact op met de
afdeling Technische Ondersteuning.
Liquides. N'immergez pas l'instrument, ne le vaporisez pas de liquide
et n'utilisez pas de chiffon non essoré dessus. Ne laissez pas d'eau ou
autre solution de nettoyage pénétrer à l'intérieur de l'instrument. Le cas
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échéant, contactez l'assistance technique.
Flüssigkeiten. Das Gerät nicht in Flüssigkeit eintauchen oder damit
einsprühen und keine tropfnassen Tücher verwenden. Kein Wasser oder
andere Reinigungslösung in das Geräteinnere eindringen lassen. Sollte
dies vorkommen, setzen Sie sich mit dem technischen Kundendienst in
Verbindung.
Liquidi. Non immergere lo strumento, nebulizzarlo con liquidi né usare
un panno che non sia stato strizzato bene. Evitare che acqua o soluzioni
detergenti penetrino all'interno dello strumento. Se si verifica
un'infiltrazione, contattare il supporto tecnico.
Líquidos. No sumerja el instrumento, no lo pulverice con líquidos y no
use un paño mojado que gotee sobre él. No permita que entre agua ni
otra solución de limpieza en el interior del instrumento. Si esto
sucediera, póngase en contacto con el servicio de soporte técnico.
Environmental Conditions. Do not expose the instrument to
temperature extremes. For proper operation, temperature near the
instrument should remain within the range in the Specifications
section of this document. Performance may be adversely affected if
temperatures fluctuate above or below this range.
Omgevingsvoorwaarden. Stel het instrument niet bloot aan extreme
temperaturen. Voor een goede werking moet de temperatuur in de
buurt van het instrument binnen het bereik blijven zoals aangegeven in
het gedeelte Specificaties van dit document. De prestaties kunnen
nadelig worden beïnvloed als de temperatuur boven of onder dit bereik
schommelt.
Conditions environnementales. N'exposez pas l'instrument à des
températures extrêmes. Pour assurer un bon fonctionnement, la
température à proximité de l'instrument doit demeurer dans la plage
indiquée sous la rubrique Spécifications du présent document. La
performance peut être affectée négativement si les températures
fluctuent au-dessus ou au-dessous de cette plage.
Umgebungsbedingungen. Das Gerät darf keinen
Extremtemperaturen ausgesetzt werden. Für den ordnungsgemäßen
Betrieb müssen die Temperaturen in Gerätenähe in den im Abschnitt
Spezifikationen dieses Dokuments angegebenen Grenzen bleiben.
Temperaturschwankungen über diese Grenzwerte hinaus können die
Geräteleistung beeinträchtigen.
Condizioni ambientali. Non esporre lo strumento a temperature
estreme. Per il corretto funzionamento, la temperatura nei pressi dello
strumento deve restare nell'intervallo indicato nella sezione Specifiche
di questo documento. Fluttuazioni delle temperature al di sopra o al di
sotto di questo intervallo possono compromettere le prestazioni dello
strumento.
Condiciones ambientales. No exponga el instrumento a
temperaturas extremas. Para su correcto funcionamiento, la
temperatura que rodee al instrumento deberá estar dentro del rango
indicado en la sección Especificaciones de este documento. Si las
temperaturas fluctúan por encima o por debajo de este rango, el
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rendimiento puede verse afectado negativamente.
Sodium Hypochlorite. Do not expose any part of the instrument to
the recommended diluted sodium hypochlorite solution for more than
20 minutes. Prolonged contact may damage the instrument surfaces.
Be certain to rinse and thoroughly wipe all surfaces.
Natriumhypochloriet. Stel geen enkel deel van het instrument langer
dan 20 minuten bloot aan de aanbevolen verdunde
natriumhypochlorietoplossing. Langdurig contact kan de oppervlakken
van het instrument beschadigen. Zorg ervoor dat alle oppervlakken
goed worden afgespoeld en schoongeveegd.
Hypochlorite de sodium. N'exposez aucune pièce de l'instrument à la
solution d'hypochlorite de sodium diluée comme recommandé pendant
plus de 20 minutes. Un contact prolongé peut endommager les surfaces
de l'instrument. Veillez à rincer et essuyer soigneusement toutes les
surfaces.
Natriumhypochlorit. Kein Teil des Geräts darf der empfohlenen
verdünnten Natriumhypochloritlösung länger als 20 Minuten lang
ausgesetzt werden. Bei längerem Kontakt drohen Beschädigungen an
den Geräteoberflächen. Alle Oberflächen unbedingt abspülen und
gründlich abwischen.
Ipoclorito di sodio. Non esporre nessun componente dello strumento
alla soluzione di ipoclorito di sodio diluita raccomandata per più di 20
minuti. Un contatto prolungato potrebbe danneggiare le superfici dello
strumento. Accertarsi di sciacquare e ripulire accuratamente tutte le
superfici.
Hipoclorito sódico. No exponga ninguna parte del instrumento a la
solución de hipoclorito sódico diluido recomendada durante más de 20
minutos. Un contacto demasiado prolongado puede dañar las
superficies del instrumento. Asegúrese de aclarar y secar
concienzudamente todas las superficies.
DMSO Concentration. Dimethyl sulfoxide (DMSO) vapor can coat
optical surfaces, which can trigger instrument self-test errors. Using
DMSO assay concentrations of 2% or below is recommended. Limit long
exposure in kinetic assays or incubated assays when possible.
DMSO-concentratie. Dimethylsulfoxide- (DMSO-) damp kan optische
oppervlakken bedekken, wat zelftestfouten van het instrument kan
veroorzaken. Het wordt aanbevolen om DMSO-testconcentraties van
2% of minder te gebruiken. Beperk lange blootstelling in kinetische
tests of geïncubeerde tests indien mogelijk.
Concentration de DMSO. La vapeur de diméthylsulfoxyde (DMSO)
peut recouvrir les surfaces optiques, ce qui peut déclencher des erreurs
d'autotest de l'instrument. Il est recommandé d'utiliser des
concentrations de test DMSO de 2 % ou moins. Limitez autant que
possible les expositions prolongées dans les tests cinétiques ou les tests
en incubation.
DMSO-Konzentration. Dimethylsulfoxid(DMSO)-Dampf kann optische
Oberflächen beschichten, was Fehler beim Geräteselbsttest auslösen
kann. Es wird empfohlen, DMSO-Assay-Konzentrationen von 2 % oder
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weniger zu verwenden. Begrenzen Sie wenn möglich die
Langzeitexposition in kinetischen Assays oder inkubierten Assays.
Concentrazione di DMSO. Il vapore di dimetilsolfossido (DMSO) può
rivestire le superfici ottiche, provocando errori di autoverifica dello
strumento. Si raccomanda l'uso di concentrazioni di test di DMSO non
superiori al 2%. Se possibile, limitare l'esposizione prolungata nei test
cinetici o nei test incubati.
Concentración de DMSO.Los vapores del dimetilsulfóxido (DMSO)
pueden recubrir las superficies ópticas, lo cual puede provocar errores
en la autoverificación del instrumento. Se recomienda utilizar
concentraciones de ensayo de DMSO del 2 % o menos. Limite la
exposición prolongada en ensayos cinéticos o ensayos incubados
siempre que sea posible.
Lubricants. Do not apply lubricants to moving parts. Lubricant on
components in the carrier compartment will attract dust and other
particles, which may cause the instrument to produce an error.
Smeermiddelen. Breng geen smeermiddelen aan op bewegende
delen. Smeermiddel op onderdelen in het draagcompartiment zal stof
en andere deeltjes aantrekken, waardoor het instrument een fout kan
produceren.
Lubrifiants. N'appliquez pas de lubrifiants sur les pièces mobiles. La
présence de lubrifiant sur les composants dans le compartiment du
portoir attire la poussière et autres particules, ce qui peut provoquer
une erreur de l'instrument.
Schmierstoffe. Keine Schmierstoffe auf bewegliche Teile auftragen.
Schmierstoffe auf Komponenten im Trägerfach ziehen Staub und
andere Teilchen an, die zu einem Gerätefehler führen können.
Lubrificanti. Non applicare lubrificanti alle parti in movimento. La
presenza di lubrificante sui componenti del vano portapiastra attira
polvere e altre particelle che potrebbero causare errori dello strumento.
Lubricantes. No aplique lubricantes en las piezas móviles. El lubricante
en los componentes del compartimento del portador atraerá polvo y
otras partículas que pueden hacer que el instrumento muestre un error.
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Components

Onderdelen

Composants

Komponenten

Componenti

Componentes

Class 1 Laser Product. “A” models. “V” and “W” models
when the optional Laser Autofocus Cube is installed.
Klasse 1 laserproduct. "A"-modellen. "V"- en "W"-modellen
wanneer de optionele Laser Autofocus Cube is geïnstalleerd.
Produit laser de classe 1. Modèles "A". Modèles « V » et « 
W » lorsque le cube laser autofocus en option est installé.
Laserprodukt der Klasse 1. „A“-Modelle. „V“- und „W“-
Modelle, wenn der optionale Laser Autofokus Cube installiert
ist.
Prodotto laser di classe 1. Modelli “A”. Modelli “V” e “W”
quando è installato il Laser Autofocus Cube opzionale.
Producto láser de clase 1. Modelos “A”. Modelos “V” y “W”
cuando está instalado el cubo de enfoque automático láser
opcional.
Pinch Hazard. Some areas of the instrument and the
dispense module can present pinch hazards when the
instrument is operating. The objective turret and dispense
module are marked with the symbol shown here. Keep
hands/fingers clear of these areas when the instrument is
operating.
Beknellingsgevaar.Sommige delen van het instrument en
de doseermodule kunnen beknellingsgevaar opleveren
wanneer het instrument in werking is. De objectiefkoepel en
de doseermodule zijn gemarkeerd met het hier getoonde
symbool. Houd handen/vingers uit de buurt van deze
gebieden wanneer het instrument in werking is.
Risque de pincement. Certaines zones de l'instrument et du
module de distribution peuvent présenter des risques de
pincement lorsque l'instrument fonctionne. La tourelle
d'objectif et le module de distribution sont marqués du
symbole illustré ici. Gardez vos mains/doigts à l'écart de ces
zones lorsque l'instrument fonctionne.
Quetschgefahr. Einige Bereiche des Instruments und des
Dosiermoduls können beim Betrieb des Instruments
Quetschgefahren darstellen. Der Objektivrevolver und das
Dosiermodul sind mit dem hier abgebildeten Symbol
gekennzeichnet. Halten Sie Hände/Finger von diesen
Bereichen fern, wenn das Instrument in Betrieb ist.
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Rischio di pizzicamento. Alcune aree dello strumento e del
modulo di erogazione possono presentare rischi di
schiacciamento quando lo strumento è in funzione. La torretta
obiettivo e il modulo di erogazione sono contrassegnati dal
simbolo mostrato qui. Tenere le mani/dita lontane da queste
aree quando lo strumento è in funzione.
Peligro de atrapamiento. Algunas áreas del instrumento y
el módulo de dispensación pueden presentar riesgos de
pellizcos cuando el instrumento está en funcionamiento. La
torreta de objetivos y el módulo dispensador están marcados
con el símbolo que se muestra aquí. Mantenga las manos /
dedos alejados de estas áreas cuando el instrumento esté en
funcionamiento.
Two-person lift. The instrument should be lifted by two
people. The instrument with all available modules weighs up to
36.3 kg (45.3 kg with the Peltier Cooling Module installed).
Tillen door twee personen. Het instrument moet door twee
personen worden opgetild. Het instrument met alle
beschikbare modules weegt maximaal 36,3 kg (45,3 kg met
de Peltier-koelmodule geïnstalleerd).
Charge à soulever par deux personnes. L'instrument doit
être soulevé par deux personnes. L'instrument avec tous les
modules disponibles pèse jusqu'à 36,3 kg (45,3 kg avec le
module de refroidissement Peltier installé).
Anheben durch zwei Personen. Das Gerät sollte von zwei
Personen angehoben werden. Das Gerät mit allen verfügbaren
Modulen wiegt bis zu 36,3 kg (45,3 kg mit installiertem Peltier-
Kühlmodul).
Due persone per il sollevamento. Lo strumento deve
essere sollevato da due persone. Lo strumento con tutti i
moduli disponibili pesa fino a 36,3 kg (45,3 kg con il modulo di
raffreddamento Peltier installato).
Levantamiento por dos personas. Es necesario que dos
personas levanten el instrumento. El instrumento con todos
los módulos disponibles puede pesar hasta 36,3 kg (45,3 kg
con el módulo de enfriamiento Peltier instalado).
Accessories. Only accessories that meet the manufacturer's
specifications shall be used with the instrument.
Accessoires. Bij het instrument mogen alleen accessoires
worden gebruikt die voldoen aan de specificaties van de
fabrikant.
Accessoires. L'instrument doit être utilisé exclusivement
avec des accessoires correspondant aux spécifications du
fabricant.
Zubehör. In Verbindung mit dem Gerät dürfen nur
Zubehörkomponenten verwendet werden, die den
Spezifikationen des Herstellers entsprechen.
Accessori. Utilizzare esclusivamente accessori dello
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strumento che rispettano le specifiche del fabbricante.
Accesorios. Solamente aquellos accesorios que cumplan las
especificaciones del fabricante deberán usarse con el
instrumento.
Shipping Hardware. All shipping hardware must be removed
before operating the instrument and reinstalled before
repackaging the instrument for shipment.
Verzendingshardware. Alle verzendingshardware moet
worden verwijderd voordat het instrument wordt gebruikt en
opnieuw worden geïnstalleerd voordat het instrument opnieuw
wordt verpakt voor verzending.
Matériel d'expédition. Tout le matériel d'expédition doit
être retiré avant d'utiliser l'instrument et réinstallé avant de
remballer l'équipement pour expédition.
Festes Versandmaterial. Alle festen Versandmaterialien
müssen vor der Inbetriebnahme des Geräts entfernt und vor
der Wiederverpackung des Geräts zum Versand neu
angebracht werden.
Minuteria di spedizione. Prima di utilizzare lo strumento,
rimuovere tutta la minuteria di spedizione, che dovrà essere
reinstallata prima di reimballare lo strumento per la
spedizione.
Equipo de envío. Antes de utilizar el instrumento es
necesario retirar todo el equipo de envío y, del mismo modo,
habrá que volver a colocárselo cuando el instrumento se vaya
a enviar.
Spare Parts. Only approved spare parts should be used for
maintenance. The use of unapproved spare parts and
accessories may result in a loss of warranty and potentially
impair instrument performance or cause damage to the
instrument.
Reserveonderdelen. Voor onderhoud mogen alleen
goedgekeurde reserveonderdelen worden gebruikt. Het
gebruik van niet-goedgekeurde onderdelen en accessoires kan
tot gevolg hebben dat de garantie vervalt en mogelijk de
prestaties van het instrument nadelig beïnvloeden of het
instrument beschadigen.
Pièces de rechange. Utilisez exclusivement des pièces de
rechange approuvées pour l'entretien. L'utilisation de pièces
de rechange et accessoires non approuvés peut entraîner
l'annulation de la garantie et potentiellement nuire à la
performance de l'instrument ou l'endommager.
Ersatzteile. Für die Wartung sollten nur genehmigte
Ersatzteile verwendet werden. Die Verwendung nicht
genehmigter Ersatzteile und Zubehörkomponenten kann zum
Verlust der Garantie führen und möglicherweise die
Geräteleistung beeinträchtigen oder Schäden am Gerät
verursachen.
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Parti di ricambio. Per la manutenzione, usare
esclusivamente parti di ricambio approvate. L'uso di parti di
ricambio e accessori non approvati potrebbe dare luogo
all'annullamento della garanzia e ripercuotersi negativamente
sulle prestazioni o causare danni allo strumento.
Repuestos. Durante el mantenimiento, solo deben emplearse
repuestos originales. El uso de repuestos y accesorios no
autorizados puede producir la pérdida de la garantía y reducir
el funcionamiento del instrumento o provocar daños en él.
Service. Only qualified technical personnel should perform
service procedures on internal components.
Service. Alleen gekwalificeerd technisch personeel mag
serviceprocedures aan interne onderdelen uitvoeren.
Entretien. L'exécution des procédures d'entretien des
composants internes doit être réservée au personnel
technique qualifié.
Wartung.Wartungsarbeiten an Komponenten im
Geräteinneren sollten nur von qualifizierten Servicetechnikern
durchgeführt werden.
Manutenzione. Le procedure di manutenzione sui
componenti interni devono essere eseguite esclusivamente da
personale tecnico qualificato.
Revisión. Solo puede realizar procedimientos de revisión de
los componentes internos el personal técnico cualificado.
Instrument Configuration.When you install or change
objectives, LED cubes, imaging filter cubes, or fluorescence
filter cubes you must update the instrument configuration
values in Gen5 and download the information to the
instrument.
Configuratie instrument.Wanneer u objectieven, led-
kubussen, filterkubussen voor beeldvorming of
fluorescentiefilterkubussen installeert of vervangt, moet u de
configuratiewaarden van het instrument in Gen5 bijwerken en
de informatie naar het instrument downloaden.
Configuration de l'instrument. Lorsque vous installez ou
modifiez des objectifs, des cubes LED, des cubes de filtres
d'imagerie ou des cubes de filtres à fluorescence, vous devez
mettre à jour les valeurs de configuration de l'instrument dans
Gen5 et télécharger les informations sur l'instrument.
Gerätekonfiguration.Wenn Sie Objektive, LED-Würfel,
Bildfilterwürfel oder Fluoreszenzfilterwürfel installieren oder
wechseln, müssen Sie die Gerätekonfigurationswerte in Gen5
aktualisieren und die Informationen auf das Gerät
herunterladen.
Configurazione dello strumento. Quando si installano o
sostituiscono obiettivi, cubi LED, filtri a cubo per immagini o
filtri a cubo fluorescenti, è necessario aggiornare i valori della
configurazione dello strumento in Gen5 e scaricare le
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informazioni sullo strumento.
Cuando instale o cambie objetivos, cubos de LED, cubos de
filtros de imágenes o cubos de filtros de fluorescencia, debe
actualizar los valores de configuración del instrumento en
Gen5 y descargar la información al instrumento.
LED cubes and filter cubes.Wear gloves when changing
components to avoid contaminating them.
Led-kubussen en filterkubussen. Draag handschoenen bij
het vervangen van onderdelen om te voorkomen dat ze
besmet worden.
Cubes LED et cubes de filtres. Portez des gants lors du
changement de composants pour éviter de les contaminer.
LED-Würfel und Filterwürfel. Tragen Sie beim Austauschen
von Komponenten Handschuhe, um eine Kontamination zu
vermeiden.
Cubi LED e filtri a cubo. Indossare dei guanti quando si
sostituiscono i componenti per evitare di contaminarli.
Cubos de LED y cubos de filtro. Use guantes al cambiar los
componentes para evitar contaminarlos.
Objectives. Do not use these cleaning solvents: Methyl ethyl
ketone (MEK), Dimethyl ketone (acetone).
Objectieven. Gebruik deze schoonmaakmiddelen niet:
Methylethylketon (MEK), dimethylketon (aceton).
Objectifs. N'utilisez pas ces solvants de nettoyage :
méthyléthylcétone (MEK), diméthylcétone (acétone).
Objektive. Verwenden Sie diese Reinigungsmittel nicht:
Methylethylketon (MEK), Dimethylketon (Aceton).
Obiettivi. Non utilizzare i seguenti solventi per la pulizia:
metiletilchetone (MEK) e dimetilchetone (acetone).
Objetivos. No utilice los siguientes disolventes de limpieza:
metiletilcetona (MEK) o dimetilcetona (acetona).
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Intended Product Use

Beoogd productgebruik

Utilisation prévue du produit

Vorgesehene Produktverwendung

Uso previsto del prodotto

Uso previsto del producto

Software Quality Control. The operator must follow the
manufacturer’s assay package insert when modifying software
parameters and establishing reading methods. It is considered good
laboratory practice to run laboratory samples according to instructions
and specific recommendations included in the assay package insert for
the test to be conducted. Failure to conduct quality control checks could
result in erroneous test data.
Softwarekwaliteitscontrole. Bij het wijzigen van de
softwareparameters en het vaststellen van afleesmethoden moet de
operator de bijsluiter van de test van de fabrikant volgen. Het wordt
beschouwd als een goede laboratoriumpraktijk om
laboratoriummonsters te onderzoeken volgens de instructies en
specifieke aanbevelingen die zijn opgenomen in de bijsluiter van de
verpakking van de uit te voeren test. Het niet uitvoeren van
kwaliteitscontroles kan leiden tot foutieve testgegevens.
Contrôle de qualité du logiciel. L'opérateur doit respecter la notice
présente dans l'emballage du test lorsqu'il modifie les paramètres du
logiciel et établit les méthodes de lecture. L'exécution d'échantillons de
laboratoire conformément aux instructions et aux recommandations
spécifiques présentées dans la notice de l'emballage du test à réaliser
est considérée comme une bonne pratique de laboratoire. Ne pas
exécuter les vérifications de contrôle de qualité peut produire des
données de test erronées.

Qualitätskontrolle der Software. Beim Ändern von
Softwareparametern und Festlegen der Leseverfahren muss der
Bediener die Vorschriften des Herstellers auf der Packungsbeilage des
Assays beachten. Es gilt als bewährte Laborpraxis, Messungen an
Laborproben gemäß den Anweisungen und speziellen Empfehlungen
der Packungsbeilage des Assay-Pakets für den beabsichtigten Test
durchzuführen. Das Versäumnis, Qualitätskontrollprüfungen
vorzunehmen, kann zu falschen Messergebnissen führen.
Controllo qualità del software. L'operatore deve attenersi alle
istruzioni del fabbricante contenute nel foglietto della confezione del
test quando modifica i parametri software e stabilisce i metodi di
lettura. È considerata una buona pratica di laboratorio eseguire
campioni di laboratorio in base alle istruzioni e alle raccomandazioni
specifiche incluse nel foglietto della confezione del test relativo al test
da condurre. La mancata esecuzione delle verifiche di controllo qualità
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potrebbe dare luogo a dati di test errati.
Control de calidad del software. El operador tiene que seguir las
instrucciones del folleto del paquete del ensayo cuando modifique
parámetros del software y establezca métodos de lectura. Se considera
una buena práctica de laboratorio efectuar las muestras de laboratorio
siguiendo las instrucciones y las recomendaciones específicas incluidas
en el folleto del paquete del ensayo para cada prueba que se va a
realizar. Si no se realizan las comprobaciones de control de calidad, la
prueba puede arrojar datos erróneos.
Data Reduction. No limits are applied to the raw measurement data.
Data exported via computer control must be analyzed by the operator.
The performance characteristics of the data reduction software have
not been established with any laboratory diagnostic assay. Users must
evaluate this instrument and PC-based software in conjunction with
their specific assay(s). This evaluation must include the confirmation
that performance characteristics for the specific assay(s) are met.
Gegevensreductie. Er worden geen grenzen toegepast op de
onbewerkte meetgegevens. Gegevens die via computerbesturing
worden geëxporteerd, moeten door de operator worden geanalyseerd.
De prestatiekenmerken van de gegevensreductiesoftware zijn voor
geen enkele diagnostische laboratoriumtest vastgesteld. Gebruikers
moeten dit instrument en de pc-gebaseerde software evalueren in
samenhang met hun specifieke test(s). Deze evaluatie moet de
bevestiging omvatten dat aan de prestatiekenmerken voor de
specifieke test(s) is voldaan.
Réduction des données. Aucune limite n'est appliquée aux données
de mesure brutes. Les données exportées par commande informatique
doivent être analysées par l'opérateur. Les caractéristiques de
performance du logiciel de réduction des données n'ont pas été établies
par un test de diagnostic en laboratoire. Les utilisateurs doivent évaluer
l'instrument et le logiciel pour PC conjointement à leur(s) test(s)
spécifique(s). Cette évaluation doit comprendre la confirmation que les
caractéristiques de performance pour le ou les tests spécifiques sont
remplies.
Datenauswertung. Auf die Rohdaten der Messung sind keine
Grenzwerte anzuwenden. Computergesteuert exportierte Daten
müssen vom Bediener analysiert werden. Die Leistungsmerkmale der
Datenauswertungs-Software wurden bei keinem Labordiagnostik-
Assay bestimmt. Die Evaluierung dieses Geräts und der PC-basierten
Software durch den Anwender muss in Verbindung mit dessen
speziellem/speziellen Assay(s) erfolgen. Diese Evaluierung muss die
Bestätigung einschließen, dass die Leistungsmerkmale für den/die
speziellen Assay(s) erfüllt sind.
Riduzione dei dati. Non sono previsti limiti ai dati di misurazione
grezzi. I dati esportati tramite il computer devono essere analizzati
dall'operatore. Le caratteristiche di prestazione del software di
riduzione dei dati non sono state stabilite con alcun test di diagnostica
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di laboratorio. Gli utenti devono valutare questo strumento e il software
basato su PC congiuntamente ai loro test specifici. Tale valutazione
deve comprendere la conferma che siano rispettate le caratteristiche di
prestazione per i test specifici.
Reducción de datos. No se aplican límites a los datos de medición no
procesados. El operador debe analizar los datos exportados a través del
control informático. Las características de rendimiento del software de
reducción de datos no se han establecido con ningún ensayo de
diagnóstico de laboratorio. Los usuarios deberán evaluar este
instrumento y el software basado en PC junto con sus ensayos
específicos. Esta evaluación deberá incluir la confirmación de que se
cumplen las características de rendimiento de los ensayos específicos.
Unspecified Use. Failure to operate equipment according to the
guidelines and safeguards specified in the product user documentation
could result in a hazardous condition.
Ongespecificeerd gebruik. Als de apparatuur niet wordt gebruikt
volgens de richtlijnen en voorzorgsmaatregelen die in de
gebruikersdocumentatie van het product staan vermeld, kan dat leiden
tot een gevaarlijke situatie.
Utilisation non spécifiée. Ne pas utiliser l'équipement conformément
aux recommandations spécifiées dans la documentation utilisateur
relative au produit peut entraîner des situations dangereuses.
Von den Vorschriften abweichende Verwendung. Die
Verwendung des Geräts und der zugehörigen Komponenten in
Abweichung von den Vorschriften und Sicherheitshinweisen in diesem
Dokument für Produktanwender kann gefährliche Situationen
verursachen.
Uso non specificato. Il mancato utilizzo delle apparecchiature in base
alle linee guida e le misure di protezione specificate nella
documentazione per l'utente del prodotto potrebbe causare pericoli.
Uso no especificado. Si no se utiliza el equipo de conformidad con las
directrices y salvaguardias especificadas en la documentación del
producto para el usuario, se puede producir una situación de peligro.
Use of labware other than described in this document can result in
positioning errors during program execution.
Gebruik van labware anders dan beschreven in dit document kan leiden
tot positioneringsfouten tijdens de uitvoering van het programma.
L'utilisation de matériel de laboratoire autre que celui décrit dans ce
document peut entraîner des erreurs de positionnement lors de
l'exécution du programme.
Die Verwendung anderer als in diesem Dokument beschriebener
Laborgeräte kann zu Positionierungsfehlern bei der
Programmausführung führen.
L'uso di vetreria diversa da quella descritta in questo documento può
causare errori di posizionamento durante l'esecuzione del programma.
El uso de material de laboratorio diferente al descrito en este
documento puede dar lugar a errores de posicionamiento durante la
ejecución del programa.

BioTek Instruments, Inc.



“

“W” model limitations 51

A

absorbance
specifications 203

absorbance liquid tests
absorbance liquid test 1

analyzing results 133
materials 132
overview 132
pipetting 133

absorbance liquid test 2
analyzing the results 135
materials 134
overview 134
pipetting 135
preparing dilutions 134

absorbance liquid test 3
analyzing the results 138
materials 137
overview 136
pipetting 137
running 137

absorbance test plate
analyzing results 129
defining the Expected Peak values129
defining the parameters 128
overview 128
running 129
troubleshooting 129

B

Best practice 68
Bottom Elevation 91

C

cleaning
decontamination 108

dispense tubes and injectors 102
exposed surfaces 97
filters 98
models with injectors 98
the priming plate 102

corners test
Gen5 protocol (filter-based) 143
Gen5 protocol (mono-based) 149
results analysis 158
solutions 153

Correction Collar 87

D

decontamination
for readers with dispensers 110
for readers without dispensers 109
overview 108
required materials 108

dispense module
about 56
clean tip priming trough 102
cleaning the priming plate 102
cleaning tubes and injectors 102
controlling with Gen5 58
daily cleaning 94
flushing the fluid path 99
installing 21
liquid tests

Gen5 protocols 189
overview 183
procedure 185
required materials 183
results analysis 186
test solutions 184

purging the fluid path 99
replacing the syringe 113
shipping 45
specifications 202
test injectors 34
unpacking 13

Index



E

DMSO 69

E

error codes
overview 210
table of 211

errors
communication 27

experiments
about 63

F

filter cube
about 54
adding to Library 79
configuring for luminescence 55
default configuration 73
installing 74
Library 79
mirror placement 77
removing 74

Filter Cubes Library
about 79
adding a cube 79

filters
cleaning 98

FL Illumination Correction 210
fluorescence

specifications (filter-based) 206
specifications (mono-based) 205

fluorescence liquid tests
filter set setup 142
Gen5 protocols 143
liquid test kit 152
materials 141
pipette maps 156
procedures 155
results analysis 158
solutions 153
troubleshooting 161
using methylumbelliferone

overview 162
results analysis 163

fluorescence polarization
liquid test solutions 154
liquid test, Gen5 protocol 146
liquid test, materials 152
liquid test, pipette map 157
liquid test, results analysis 159

G

Gen5
about 63
controlling the dispense module 58
dispense module test protocols 189
experiments 63
fluorescence liquid test protocols 143
installing 24
luminescence test protocols 173
protocols 63

Glowell test
Gen5 protocols 173
troubleshooting 177

H

Harta Plate test
Gen5 protocols 173
procedure 170
results analysis 172
troubleshooting 177

I

imager
available models 50
description of 2
detections modes 2
external components of 52
internal components of 53
repacking 37
shipping 37
turning on 26

imaging filter cubes 83
Imaging filter cubes

installing 31
injectors

about 56

237



installation

flushing and purging 99
priming 58
testing 34

installation
filter cube 74
qualification 116

IQOQPQ 36

L

Labware 66
LED cubes and imaging filter cubes

about 83
calibration 31
installing 31

LED filter cube
importing and exporting definitions

of 84
linearity test

Gen5 protocol (filter-based) 143
Gen5 protocol (mono-based) 149
results analysis 159
solutions 153

liquid tests
absorbance liquid test 1

analyzing results 133
materials 132
overview 132
pipetting 133

absorbance liquid test 2
analyzing the results 135
materials 134
overview 134
pipetting 135
preparing dilutions 134

absorbance liquid test 3
analyzing the results 138
materials 137
overview 136
pipetting 137
running 137

fluorescence
filter set setup 142
Gen5 protocols 143
liquid test kit solutions 7

materials 141
pipette maps 156
procedures 155
results analysis 158
solutions 153
troubleshooting 161
using methylumbelliferone 162

results anaylsis163
luminescence

configuring filter cube for 55
specifications 206

luminescence tests
filter set 170
Gen5 protocols 173
Harta Plate results analysis 172
Harta Plate test 170
overview 170
troubleshooting 177

M

maintenance
cleaning exposed surfaces 97
cleaning the dispense module 94
cleaning tip priming trough 102
overview 94

mirrors
placement in filter cubes 77

O

objectives
about 85
importing and exporting definitions

of 85
Objectives

40X and 60X Limitations 89
cleaning 86, 104
correction collar adjustments 87

P

package contents
optional accessories 5
part numbers 4
required components 4

238



Q

Plate Type 91
plug & play 26
priming plate

cleaning 102
product registration ix
protocols

about 63

Q

qualification
installation 116
operational 116
performance 117
schedule 118

qualification and maintenance
package 36

R

registration ix
repacking the instrument 37

S

Sample vessel
Bottom elevation 91

sensivity test
Gen5 protocol (filter-based) 143
Gen5 protocol (mono-based) 149
results analysis 158
solutions 153

service 9
shipping hardware

removing 17
shipping the instrument 37
Slide Holder 66
specifications

absorbance 203
dispense 202
filter-based fluorescence 206
general 200
luminescence 206
mono-based fluorescence 205
reading 202

support 9

syringe replacement 113
system test

overview 119
procedure 120
running 33

T

Technical Support 9
Time-Resolved Fluorescence

liquid test , Gen5 protocol 147
liquid test , results analysis 160
liquid test solutions 154
liquid test, materials 153
liquid test, pipette map 157

tip priming trough
cleaning 102

U

unpack the dispenser 13

W

Wmodels 210
warranty ix

239



In This Book
This document contains installation, operation, maintenance, and qualification information
for all models of the Cytation 5.

Document Revision History

Part Number Revision Date Modifications

1321000N A December 2021 First issue.

Original Language – EN

Manufactured by Agilent Technologies, Inc.
5301 Stevens Creek Blvd.
Santa Clara, CA  95051


	Cytation 5 User Manual
	Preface
	Contents
	Notices
	All Rights Reserved
	Restrictions and Liabilities

	Contact Information
	Worldwide Sales and Support
	Technical Support and Service
	UK Responsible Person (UKRP)
	Intended Use Statement
	Quality Control
	Warranty and Product Registration

	Safety Notices
	Warnings and Precautions
	Electrical Hazards
	Chemical/Environmental
	Components
	Intended Product Use

	Symbols
	Conformance to Standards
	EMC Information and Technical Description
	Ingress Protection Code
	Disposal

	Introduction
	Product Description
	Package Contents
	Optional Accessories
	Technical Support

	Installation
	Important Information
	Unpack and Inspect the Instrument
	Unpack and Inspect the Dispenser
	Unpack and Inspect the Gas Controller
	Select an Appropriate Location
	Installing the Isolation Table

	Remove the Shipping Hardware
	Install the Power Supply
	Install the Gas Controller (if applicable)
	Install the Peltier Cooling Module (if applicable)
	Install the Joystick (if applicable)
	Install the Dispenser (Optional)
	Install the Supplied Controller (Host Computer)
	Install Gen5 and Connect the Cytation 5
	Essential Information
	Installation Procedure

	Turn on the Instrument
	Establish Communications
	Communication Errors

	Install the Imaging Module
	Set Up Gen5 for Imaging
	Install the Objectives
	Install the LED Cubes and Filter Cubes
	Install the Laser Autofocus Cube (optional)
	Run Auto Calibration
	Troubleshooting Auto Calibration

	Run a System Test
	Set Dispenser Calibration Values
	Test the Dispenser
	Operational/Performance Qualification
	Packing and Shipping Instructions
	Prepare the Instrument for Shipment
	Reinstalling the Shipping Hardware
	Pack the Shipping Box

	Preparing the Dispenser for Shipment
	Repacking the Peltier Cooling Module

	Getting Started
	Modular Design
	External Components
	Internal Components
	Filter Cube
	Configuring the System for Luminescence Measurements

	Injector System
	Dispense Module
	Priming the Injector System
	Dispense Module Control
	Prime
	Purge

	Plate Shaking Options
	Plate Shaking Specifications

	Peltier Cooling Module Described
	Gen5 Software
	Protocols and Experiments

	Imaging System
	Using the Slide Holder and Other Labware
	Manual Mode
	Experiment Mode

	Recommendations for Optimum Performance
	General
	Read Direction
	Luminescence Measurements
	Monochromator-Based Fluorescence Systems
	Models with Dispenser (Injectors)
	Using 384-Well Microplates
	Incubation and Partial Plates
	Imaging


	Fluorescence Filter Cubes, and Imaging Cubes & Objectives
	Filters and Mirrors Overview
	Fluorescence Filter Cubes
	Filter Cubes Available from BioTek
	Installing or Removing a Filter Cube
	Defining Fluorescence Filter Cubes in Gen5

	Changing the Filters and Mirrors in a Filter Cube
	To remove a filter, plug, or mirror
	To replace a filter, plug, or mirror

	Fluorescence Filter Cube Library
	Adding a Filter Cube to the Optics Library

	Imaging LED Cubes and Filter Cubes
	Changing LED Cubes and Imaging Filter Cubes
	Installing the LED Cubes and Filter Cubes
	LED Cube and Imaging Filter Cube Library
	Import LED Cube and Filter Cube Definitions

	Imaging Objectives
	Import Objective Definitions
	Changing an Objective
	Adjust the Correction Collar
	40X, 60X, and 100X Objectives: Limitation
	Define your vessel’s Bottom Elevation


	Periodic Maintenance
	Periodic Maintenance Overview
	Daily Cleaning for the Dispense Module

	Recommended Maintenance Schedule
	Warnings and Precautions
	PM-1: Clean Exposed Surfaces
	PM-2: Inspect/Clean Excitation and Emission Filters
	PM-3: Inspect/Clean Mirrors
	PM-4: Flush/Purge the Fluid Path
	PM-5: Run a Dispense Protocol (Optional)
	PM-6: Clean the Tip Priming Trough
	PM-7: Clean the Priming Plate
	PM-8: Clean the Dispense Tubes and Injectors
	PM-9: Clean the Objectives
	PM-10: Clean Peltier Cooling Module Filter

	As-Needed Maintenance
	Decontamination
	Procedure for all instruments: Decon External Surfaces
	Procedure for Models with a Dispenser
	Alternative Decon Procedure for Dispenser Modules

	Dispenser Syringe Replacement

	Instrument Qualification
	Instrument Qualification Overview
	Recommended Qualification Schedule
	System Test
	Imaging Test Procedures
	Carrier Level Test
	Gen5 Imaging Protocol
	Capture an Image Test
	Joystick Performance Verification

	Absorbance Plate Test
	Define Absorbance Test Plate Parameters
	Run the Absorbance Plate Test
	Results and Troubleshooting Tips

	Absorbance Liquid Tests
	Absorbance Liquid Test 1
	Analyze the Results
	Absorbance Liquid Test 2
	Absorbance Liquid Test 3
	Read the Plate

	Fluorescence Testing Overview
	BioTek Fluorescence Plate Tests
	Fluorescence Liquid Tests
	Gen5 Fluorescence Liquid Test Protocols
	Corners-Sensitivity-Linearity Tests Materials
	Fluorescence Polarization (FP) Test Materials
	Time-Resolved Fluorescence (TRF) Test Materials
	Prepare the Fluorescence Test Solutions
	Fluorescence Test Procedure
	Pipette Maps
	Results Analysis
	Troubleshooting Fluorescence Liquid Tests
	Fluorescence Test Procedure (Methylumbelliferone)

	Luminescence Test
	Harta Plate Test
	Results Analysis
	Gen5 Luminescence Test Protocol Parameters
	Luminescence Troubleshooting

	Alpha Detection Test
	Required Materials
	Test Solutions
	Pipette Map
	Procedure
	Results Analysis
	Troubleshooting Alpha Tests
	Gen5 Protocol Reading Parameters

	Dispense Module Qualification Tests
	Using BioTek’s Blue and Yellow Concentrate Dye Solutions:
	Using FD&C Blue and Yellow Dye Powder:
	Procedure for Models with Absorbance Capabilities
	Results Analysis
	Procedure for Models without Absorbance Capabilities
	Gen5 Test Protocols for Models with Absorbance Capabilities
	Gen5 Test Protocols for Models without Absorbance Capabilities


	Dispense Test Worksheets
	Specifications
	General Specifications
	Dispense/Read Specifications
	Absorbance Specifications
	Fluorescence Specifications (Mono-Based)
	Fluorescence Specifications (Filter-Based)
	Luminescence Specifications
	Imaging Specifications

	Error Codes
	Overview
	Error Codes

	Safety Information
	Safety Notices
	Warnings and Precautions
	Electrical Hazards
	Chemical/Environmental
	Components
	Intended Product Use


	In This Book

